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 Keyboard Commands

Digital Orchestrator Plus has many keyboard shortcut keys to make the program easier to use.

Transport Bar Shortcut Keys

The Transport Buttons (Rewind, Stop, Play, Record, Pause, and Fast Forward) have been duplicated on 
the keys F4, F5, F6, F7, F8, F9, in the same order from left to right, allowing you to use them as you 
would a tape transport.

KEY TRANSPORT BUTTON 
FUNCTIONS

F4 Rewind

 F5 Stop

 F6 Play

 F7 Record

 F8 Pause

 F9 Fast Forward

 Shift + F4 Rapid rewind 

 Shift + F9 Rapid fast forward

 Shift + F7 Toggles punch key

 Shift + F6 Plays current range

Other Shortcut Keys
These keys will help you move throughout the program.

KEY FUNCTION

F1 Help

F2 Patch or Port selection

F3 Toggle field or column width (Name, Port, Patch, Volume)

Ctrl + Tab Jumps to any Digital Orchestrator Plus window 

Tab Toggles between the Track pane and the Bar pane

Ctrl + X Cut

Ctrl + C Copy

Ctrl + V Paste

Ctrl + D Delete

Ctrl + A Select All

Ctrl + Z Undo

Ctrl + R Redo

Ctrl + N Go to Next Track in Piano Roll, Event Editor, and Digital 
Audio windows

Ctrl + P Go to Previous Track in Piano Roll, Event Editor, and 



Digital Audio Windows

Ctrl + T Set focus to Tempo

Ctrl + O Open File

Ctrl + S Save File

Alt + F4 Exit the Program

Spacebar Starts/Stops Playing Selection



 Screen Areas and Windows 
Several windows can be run in multiple instances. For example, you can open two copies of the Piano 
Roll window, display a different track in each, and cut and paste easily between them.

If you use more than one MIDI port, you can open a separate mixer window for each. You can run 
multiple copies of the Event Edit, Digital Audio, Track/View, Piano Roll, and Mixer window.

 Transport Control Bar

 Track/View Window

 Piano Roll Window

 Notation Window

 Notepad Window

 Event Editor

 Mixer Window

  Digital Audio Window 

  SysEx Window 

  Conductor Editor Window 

See Also: Spin Buttons 



 Menu Commands 

File Menu

Edit Menu

Transforms Menu

Options Menu

Window Menu

Help Menu



 Procedures 

Basic Procedures

Track/View Window Procedures

Piano Roll Window Procedures

Notation Window Procedures

Event Editor Window Procedures 

Digital Audio Window Procedures 

SysEx Procedures 



Basic Procedures
Using the Transport
Setting Up MIDI Ports
Setting Up Patch Names for a MIDI Port 
Recording a Track 
Overdubbing (Recording More Tracks) 
Loading and Playing a MIDI File Song 
Punch Recording 
Setting the Play Position 
Changing the Tempo 
Setting the Count In 
Adjusting the Metronome Click Settings 
To Merge Files 
To Export A .WAV File 
To Operate Transforms 



Track/View Window Procedures
Composing with Tracks 
Getting Around Track/View 
Moving Tracks 
Merging Tracks 
Deleting Tracks 
Changing Names and Parameters 
Muting and Soloing Tracks 
Assigning a Track to a MIDI Channel 
Assigning a Track to a MIDI Port 
Transpose Pitch 
Adjusting the Track's Pan Setting 
Selecting a Patch 
Setting Track Volume 
Using Drag and Drop to Edit Bars 
Inserting Bars 
Deleting Bars 
Quantizing Notes 
Setting a Track for Record 
Looping 
Change Velocities 



Piano Roll Window Procedures
Auditioning Notes with the Scrub Function 
Auditioning Note Pitches and Drum Sounds 
Changing Tracks in Piano Roll 
Deleting a Note 
Drag and Drop 
Editing Existing Notes 
Editing Numeric Note Parameters 
Inserting a New Note 
Quantizing Notes 
Zooming and Expanding in Piano Roll 



Notation Window Procedures
Printing Notation 
Refining Notation 
To Display Notation... 
Transcribe Musical Notation 
Transcription Settings 



Event Editor Procedures
Changing Event Parameters 
Deleting Events 
Filtering Event Display 
Inserting New Events 
Patch Changes in the Event List 



 Technical Support 

If you’ve tested your installation and hardware connections, have run all the steps in SoundCheck,™ 
have read the information on Troubleshooting and you’re still having problems, you can reach Voyetra’s 
Technical Support by:

Phone
You can reach Voyetra Technologies Software Technical Support by phone. You must be a registered user 
to call Technical Support. Technical support is available between 9:00 A.M. and 5:00 P.M. Eastern Time, 
Monday through Friday. Voyetra Technologies Software Technical Support Phone: (914) 966-0600.

FAX
You can fax questions or comments to Voyetra Technologies Technical Support Fax at: 
(914) 966-1102.

Bulletin Board
If your problem is not urgent, Voyetra’s Bulletin Board is an economical alternative to calling technical 
support.

Set your modem to any speed up to 28,800 baud, 8 bits, 1 stop bit, no parity, ANSI emulation and dial 
(914) 966-1216.

Post your message or question and we’ll answer within a few days. Our bulletin board is also the quickest 
way to get news about upcoming products, drop in from time to time to see what’s new.

CompuServeâ
Voyetra maintains a Forum on CompuServeâ Information Service:

· Type GO VOYETRA at any prompt 

· Or leave an E-Mail message for user ID: 76702, 2037

We’ll do our best to help you get things straightened out.

American Online®
Voyetra also maintains a Folder on American Online®:

· AOL Keyword: Voyetra

· AOL E-mail: Voyetra

Internet
You can contact us via e-mail on the Internet.

· For product information, write us at:
info@voyetra.com

· For technical support, write us at:
support@voyetra.com

· For sales information, write us at:
sales@voyetra.com



World Wide Web
You can also visit our web site at http://www.voyetra.com

Reminders Before Contacting Tech Support
· If possible, call from a phone near your computer.

· Tech support may need information on the hardware installed in your system—the sound card, 
synthesizer, MIDI interface or other devices you are using. Please have this information available.

· Be prepared to explain what you were doing when the problem occurred and any error messages 
you received.



Transport Control Bar and Status Bar

Click on any screen area or control to learn about its function.

Transport Control Bar
The transport control bar is the basic control panel for Digital Orchestrator Plus. It is located at the top of 
all windows and essentially emulates a tape deck transport in most of its functions.

Status Bar
Shows the current status (stopped, play, record, etc.) of Digital Orchestrator Plus. 

Quick View Buttons
The Quick View Buttons were added to give fast easy access to all of the windows available in Digital 
Orchestrator Plus. These buttons are located at the bottom of the screen in all windows. You may also 
use the Ctrl + Tab keys to jump to any active window.

 Other Related Topics...
General Procedures 
Setting the Play Position 
Using the Transport 



Track/View Window 
The Track/View window is broken into two screens called panes: the Track pane, and the Bar pane. The 
vertical border between these two screens can be dragged left or right, giving you the option of re-sizing 
the screens as you like. 

The Track pane provides the master controls for each track and is typically where recording is done from. 
Tracks are recorded and named and parameters such as patch, transpose and volume can be adjusted.

The Bar pane provides a macro view of the bars in each track of a song. Edits on the bar level are 
typically done here. For example, an entire chorus section of a song can be doubled simply by copying 
and pasting the bars that make up the chorus. 

Click on any screen area or control to learn about its function.

Bar Pane 
 

 

 Other Related Topics...
Track/View Window Procedures 
Composing with Tracks 
Getting around Track View 
Drag and Drop 



Piano Roll Window

The Piano Roll window displays the MIDI notes from a track in a graphical form. The vertical axis 
represents pitch and the horizontal axis displays time in bars. The pitches are mapped out by the 
keyboard on the left side and the bars are labeled at the top of the window. 

To open Piano Roll, click the Quick View Button at the bottom of the screen or select Piano Roll from the 
Window menu.

Click on any screen area or control to learn about its function.

Right-clicking in the Piano Roll window brings up the quick menu. Click on a command to learn more 
about it's function.

 Other Related Topics...
Piano Roll Window Procedures 
Drag and Drop 



Notation Window
The Notation window transcribes the MIDI data of a selected track and displays it as standard musical 
notation on a page. You can also title the score and print it out. The red Play Position Pointer also follows 
the notation as the song plays, for reference.

Digital Orchestrator Plus cannot notate or print digital audio data.

Click on any screen area or control to learn about its function.

 Other Related Topics...
Notation Window Procedures 



Notepad Window
The Notepad is a handy place to store such text-based information as a file’s name, author and copyright, 
tempo or other settings, song lyrics or any comments you want to have on hand when you’re working with 
the song.

Using the Notepad 
Use the Notepad to cut, copy and paste text between Digital Orchestrator Plus and other Windows 
applications.

When you save your song as an .ORC or .MID file, anything you’ve typed into the Notepad window will be 
saved along with it. 

The next time you open the file, you can open the Notepad window to review your comments.

Notepad is capable of importing and exporting text using the Windows' System Clipboard.



Event Editor
The Event Editor displays MIDI data from a track in a raw data, sequential list form. In this window, data 
such as notes, controllers, and patches can be inserted, deleted, and modified. The Event Editor displays 
one track at a time and allows you to filter the list to show only the data you are interested in. Key 
Signature, Meter and Tempo information can also be edited in the Event List by selecting the Conductor 
Track. 

To Open the Event Editor, click on the Event List Quick View Button or select #4 Event List from the 
Window menu.

Click on any screen area or control to learn about its function.

 Other Related Topics...
Event Editor Procedures 
Conductor Editor Window 
Filter Events Dialog Box 



Mixer Window

Click on any screen area or control to learn about its function.

The mixer screen offers a simple way to mix levels and try different patches for each channel. And 
because the channel based mixer window hides all of the track data, it makes it easier to organize and re-
map MIDI files. To open the Mixer window, click on the Quick View Buttons at the bottom of the screen. 
Clicking the right mouse button in the right side of the Mixer window displays the MIDI Output Port 
settings.



File Menu
The File menu gives you access to the above commands by pulling down the menu and selecting the 
command you need. The following is a description of each command and how it's used:

New
Select the New command when you want create a New file from scratch.

Open
Use this command to open an existing file for playing or editing.

Save
Use this command to save a file currently loaded under the current name.

Save As...
Use this command to save the current file under a new name or to a different drive. Files can be saved as 
standard MIDI .MID format, RIF or the native .ORC file format. We recommended that you save your files 
in the .ORC format because this will save all of your Track window settings. If you save it as a .MID file, 
certain settings in the Track window, such as transpose, will get embedded in your song. Also tracks that 
were muted will get deleted. 

Note: Digital Audio information will only be saved in the .ORC file format.

See Also: File Formats 

Import/Merge
The Merge command allows you to insert an existing MIDI or digital audio file into the next available track 
of the current MIDI song. 

When you merge two files, one conductor track must always be discarded, because the resulting file can 
have only one conductor track.

 See Also: Conductor Track 

The merge command always retains the conductor track from the currently opened file, and discards the 
conductor track settings from the new (incoming) file.

When you merge a stereo WAV file, the data will be separated into two tracks.

Export WAVE
This feature acts like a digital track mix-down where all the digital tracks are merged and can be saved as 
a single Mono or Stereo WAV file. Current file settings such as Volume, Pan, Mute, and Solo affect the 
exported WAV. Only digital audio is exported —MIDI data is ignored.

Volume will effect the loudness of the exported WAV file.

Pan will effect the left and right channel separation in a stereo WAV only. 

Muted tracks will not be exported.

Solo tracks will be the only tracks exported.

Note: Stereo WAV files are only exported if you have Stereo Playback enabled in the Digital Audio 
Options Menu. 



Exit
This command lets you quit the program.

* File also displays the last four files that were loaded.

Note: Saving SysEx data in MIDI or ORC format:

If possible, it is always preferable to save your files in the ORC format. This way, your song will always 
load back in exactly as you last saved it.

Saving SysEx data in MIDI format has the following limitations - Name and port information are not saved. 
SysEx data may not load into the same Bank as it was previously in. Also, if your SysEx data contains 
multiple statements (F0 .... F7 is taken as a single statement) each statement will be loaded into a 
different bank. Most importantly, if SysEx banks are not either marked as Auto or are not referenced by an 
event in a track they will not be saved at all.

 See Also Basic Procedures 



Edit Menu
The Edit menu gives you commands used in performing edits on MIDI tracks. The following is a 
description of each command and how it is used:

Undo
This command lets you undo the last command you performed. This command is available on all editing 
operations. The number of undo levels is set in the .INI file where the default is set to 12 levels. 

Redo
This command lets you redo an undo so that you can toggle back and forth between edited and unedited 
versions of the track. 

Cut
Use this command to remove a selected area or event and put it into a buffer where it can then be pasted 
to another location. This command leaves no copy behind.

Copy
Copies a selected area or event into a buffer where it can then be pasted to another location. Use this 
command when you want to leave a copy behind unaltered. 

Paste
This command takes whatever is in the buffer ( from a cut or copy) and pastes it to a new location.

Select All
When you want to select all of the tracks in a song, this is the command to use. You will find that Select 
All is faster than highlighting the entire song!

Clear Clipboard Contents
When you cut or copy a selected area or event and place it on the Clipboard, it remains there indefinitely
—until you cut or copy something else to the Clipboard. However, once you have pasted the contents of 
the Clipboard to a new location and no longer require the data, clearing the contents of the Clipboard can 
help speed up processing. 

The Clear Clipboard Contents command serves two functions—it will clear the contents of the Clipboard 
and any Undo information being stored. Remember, Digital Orchestrator Plus holds up to 12 levels of 
Undo (unless you have changed this default setting), so that you can reverse the effect of up to 12 of the 
most recent editing commands. 

Clicking on Clear Clipboard Contents will display a warning box to verify that you do indeed want to 
proceed with this action. Click on OK if you are certain that you will not require the Clipboard Contents 
and the Undo information being retained. 

Insert Bars 
Use this command when you want to insert blank bars into a specified location. You will be prompted for 
the number of bars you want to insert. The location of insertion is determined by the placement of the 
pointer or you can enter it directly into the dialog box.

Delete Bars
This command deletes bars blank or otherwise and shifts the following bars to the left to fill in the new 
empty bars. The dialog box will ask you for the number of bars and the starting location but like the insert 
bars, you can use the pointer to mark the delete start point.



Options Menu
The Options menu provides commands used to set up various configuration options in Digital 
Orchestrator Plus. The following is a description of each command and how it is used:

MIDI Thru
Turns the MIDI Thru on when it is checked, allowing MIDI data to be echoed back to the MIDI output.

Save Settings on Exit
Saves all your screen settings when you quit Digital Orchestrator Plus. When you restart Digital 
Orchestrator Plus your screen configuration will be restored to the way it was when you last quit the 
program.

Metronome Settings
Displays a dialog box for adjusting metronome settings. 

MIDI Port Setup
Displays a dialog box for setting up your MIDI input and output device drivers. Patch names assigned to 
each device are also configured here. See also: Setting Up Patch Names for a MIDI Port 

Sync Settings
This feature enables you to synchronize your Digital Orchestrator Plus files with other devices such as a 
video tape recorder or multitrack tape deck. Synchronization allows you to do things like add complex 
audio overdubs to a video production or use a multitrack tape deck with Digital Orchestrator Plus to 
provide more audio tracks for recording.

Patch Map Setup
Displays a dialog for assigning patch names to ports and channels.

Digital Audio Options
Displays a dialog box which allows to set various digital audio options.

Controllers
Displays a dialog box which allows you to select the MIDI controller to be manipulated by the real time 
control knobs on the Mixer window and the Track/View window. 



Window Menu
This is a stock Window menu for setting up screen parameters and windows. The following is a 
description of the menu items:

Big Time Window
The Big Time Window can only be opened from the Window menu—there is no Quick View button for this 
feature. The Big Time window is a dedicated display which shows either the current SMPTE time or the 
current song time, depending upon the time display setting designated in the Sync Settings dialog box on 
the Options menu. The Big Time Window is resizable. 

New
When you select New from the Window menu a flyout menu appears, allowing you to open a new 
instance of one of Digital Orchestrator Plus' windows. You can open multiple instances of the Piano Roll, 
Digital Audio, Event List and Mixer windows. You can open only single instances of the Conductor Editor, 
Track/View, Notepad and SysEx windows.

Cascade
Cascades or stacks multiple windows.

Tile
Tiles or stacks multiple windows horizontally.

Arrange Icons
Arranges the Icons in Program Manager.

Track/View 
This selects the Track screen.

Piano Roll 
This selects the Piano Roll screen.

Notation 
This selects the Notation view screen.

Event List
This selects the Event list screen.

Notepad
This selects the Notepad screen.

Mixer
This selects the Mixer screen.

Event List - Conductor 
This selects the Conductor editor screen.

SysEx
This selects the System Exclusive screen.

Digital Audio
This selects the Digital Audio screen.

1, 2, 3, 4, (etc.)
This list shows all current windows, including any that are minimized. A check mark shows which is active. 



To bring any window to the foreground, click on its name in this list, or type its number.



Help
The Help menu gives you access to extensive on-line help.

Contents
Opens this Digital Orchestrator Plus help application at the contents page.

One Line Help
Toggles On/Off the one line help. This feature provides a one line definition of screen areas and controls 
as you pass your mouse over them. The text is displayed in the title bar at the top of the application.

Tool Tips
Toggles On/Off the tool tips help. This feature provides an on line name of screen areas and controls as 
you place your mouse over them. The text is displayed in a small yellow window that pops up near your 
mouse.

About Digital Orchestrator Plus...
Provides copyright, date and version information about Digital Orchestrator Plus.



Rewind Button
To rewind in a manner similar to a tape deck transport, click and hold the rewind button. To rewind more 
rapidly, press and hold the shift key while holding the rewind button. 

Shortcut key: F4



Stop Button
The Stop button will halt play of the song and rewind to the point at which playback started. 

Shortcut key: F5 or Spacebar



Play Button 
The Play button will play from the beginning of a song or a location determined by the BAR: BEAT: CLICK 
display.

Shortcut key: F6 or Spacebar



Record Button
The Record button is used to record MIDI tracks. You can select a track to record on by clicking in the "R" 
column of that track.

Shortcut key: F7

 See also...
Recording a Track 



Pause Button
The Pause button is used to temporarily stop playback or recording of a MIDI file at the current play 
position. Click this button once to stop play and again to resume play from the same position.

Shortcut key: F8



Fast Forward Button
This button is used to move the current play position forward in the song. To forward in a manner similar 
to a tape deck transport, click and hold the Fast Forward button. To fast forward more rapidly, press and 
hold the shift key while clicking on the Fast Forward button. Lastly, you can quickly move to the end of the 
song by double-clicking on it.

Shortcut key: F9



Punch In Record Button
Allows a specified range to be recorded as defined by the From and Thru range settings. Select Punch 
and then click the Record button to record the specified range.

Shortcut key: Shift + F7

 See also...
From/Thru range 
Punch Recording 



Play Range Button
Plays the range defined in the From and Thru range settings. You may change these values directly by 
clicking on the From and Thru boxes. If the From = Thru range, nothing will play.

Shortcut key: Shift + F6

 See also...
From/Thru range 



Quick View Buttons
The Quick View Buttons were added to give fast easy access to all of the windows available in Digital 
Orchestrator Plus. These keys are located at the bottom of the screen in all windows. You may also use 
the Ctrl + Tab keys to jump to any active window.

 See also...
Multiple Document Interface 



Current Song Position in Bar: Beat: Click
This numerical display shows the current song position in the format Bar:Beat:Click. 

The timing resolution (clicks) is set at 480 pulses per quarter note by default. You can think of timing 
resolution as being the sampling rate of a MIDI sequencer.

To change the data in this box, use the keyboard or the spin buttons. 

When using the keyboard, click on the box, then enter the desired numbers for Bar:Beat:Click in free-form 
fashion, using the symbols : : , . - as separators. For example:

      4 would be Bar 4
      5-2 would be Bar 5, Beat 2
      2.2.3 would be Bar 2, Beat 2, Click 3

Current Time
This indicator displays the current amount of time elapsed from the beginning of the song. 

The Current Time value for a given position in the song will depend on the song’s tempo. This information 
can come in handy when you’re creating a song for a time-critical application such as a film, video, or 
multimedia presentation.

Generally, the format in the Current Time box will be Hours: Minutes: Seconds: Frames: Hundredths or 
Bits. The format displayed is dependent upon the settings chosen in the Show Hours section of the Sync 
Settings dialog box, accessible from the Options menu. To illustrate,

· If Show Hours is selected in the Sync Settings dialog, Hours will be displayed in this indicator. 

· If Show Hours is deselected in the Sync Settings dialog, Hours will not be shown.

· If Hundredths or Bits has been selected in the SMPTE Sub Frame Display section of the Sync 
Settings dialog, the Current Time will display in Hundredths or Bits.

If you are uncertain of the current settings, rest your mouse pointer on the Current Time box and the Tool 
Tips help will display the format.

As in the Current Song Position Indicator, you can enter data free-form, from the keyboard, using the 
symbols    : : , . - as separators. To do so, click on the box and then enter the desired numbers. 



From/Thru range
Defines the range for the Play Range and Punch record functions. These values can be changed directly 
by clicking on the From and Thru boxes. 

Play From Control 
Use the Play From control to set the starting point of a range within a song or Digital Audio file. Play From 
uses the format Bar:Beat:Click. In conjunction with the Play Thru control, this control sets a precise range 
for auditioning, for looping or for recording a file.

As in the other indicators on the Transport bar, you can enter data free-form, from the keyboard, using the 
symbols : : , . - as separators. To do so, click on the box and then enter the desired numbers. 

The values in the Play From Control also can be changed by using the spin buttons in conjunction with 
the Shift and Ctrl keys. These key combinations follow.

Play Thru Control 
The Play Thru control sets the ending point of a selected range within a song or Digital Audio file in the 
format Bar:Beat:Click. In conjunction with the Play From control, this function sets a precise range for 
auditioning, looping or recording a file.

As in the Play From Control, you can enter data free-form, from the keyboard, using the symbols    : : , . - 
as separators. To do so, click on the box and then enter the desired numbers. 



Transport Status
Shows the current status (stopped, play, record, etc.) of Digital Orchestrator Plus. 



Current Tempo
Displays the current tempo in beats per minute. You can change this value by clicking and holding the left 
mouse on the display and dragging the mouse up to increase, or down to decrease.

 See also...
Changing the Tempo 



Tempo Offset
Shows the current tempo offset of the presently loaded song in beats per minute. This function is useful if 
you have a tempo map in the file and you wish to change the tempo on a macro level. The tempo offset 
will effect all of the tempo values by the same amount. The tempo offset value can be a positive or 
negative number. When you save a .MID file with a tempo offset, the offset will be added to or subtracted 
from the tempo or tempo map value(s). If you save is file as a .ORC file, the tempo offset will appear in 
the Tempo Offset box when you reload the file rather than being rolled into the Tempo.

 See also...
Changing the Tempo 



Track Pane

The Track Pane allows you to look at and change the parameters for all 1000+ tracks. By clicking in the 
upper title boxes such as volume you may expand the view of that parameter out thus giving you a clear 
view of that parameter name, value or slider. For example, clicking on volume expands the column, 
replacing the numbers with small sliders for each tracks volume parameter. You may also expand patch, 
name and port in the same way.

Use the tab key to toggle the cursor between the Track pane and the Bar pane.



Composing with Tracks 
As with many modern sequencers, Digital Orchestrator Plus works much like a multitrack tape recorder. 
By using this analogy, it may be used for creating and organizing all of the parts that make up a musical 
composition. In other words, you might lay down a piano melody on track 1 and a bass part on track 2 
and continue this until you have built a sequence of musical events happening at the same time and 
running along side each other -- much like the multitrack tape format. 



Getting around Track/View Window
You may use any of several ways of navigating in the Track/View. The arrow keys may be used to move 
up, down, left or right as well as the page up and down keys. Working with the mouse is probably the 
quickest way to edit, at least at first. After a time you may wish to use some of the short cut keys. 



Setting a Track for Record
To record a track in Digital Orchestrator Plus, you must have the desired track's  in the record column 
on or you will get an error message.

 See also...
Record Select Column 



Moving Tracks
To move a track or shuffle tracks in the Track pane, click on the far left track number. You will see a 
double vertical arrow. Click and hold the left mouse button drag and drop the track in the desired location. 
If you want to drop a track at the beginning of a continuous list of tracks, just drop the track on the first 
one in the list and all the tracks will be moved down by one.



Deleting Tracks
The easiest way to remove a track in the Track window is to click and hold the mouse on the track 
number and press the delete key on the computer keyboard. To undo the delete operation, select undo 
from the Edit menu.



Changing Names and Parameters
When changing the values of numbers which have spin buttons, you can use the spin buttons alone or in 
conjunction with the Shift and Ctrl keys.

· Using the mouse, click on the up or down spin button to change the value in either of these boxes. 

· Pressing the Shift key while clicking the up spin button will increase the value by a larger amount. 
Pressing the Shift key while clicking the down spin button will decrease the value by a larger 
amount.

· Pressing the Shift key while pressing the multiply (*) key on the numeric keypad will increase the 
value by a larger amount. Pressing the Shift key while pressing the divide (/) key on the numeric 
keypad will decrease the value by a larger amount.

· Pressing the Ctrl key while clicking the up spin button will set the value to the maximum. Pressing 
the Ctrl key while clicking the down spin button will set the value to the minimum.

· Pressing the Ctrl key while pressing the Plus (+) key on the numeric keypad will set the value to the 
maximum. Pressing the Ctrl key while pressing the minus (-) key on the numeric keypad will set the 
value to the minimum. 



Naming a Track
To name a Track: 

1. Click with the mouse on the name column of the desired track or move to the name box and press F2 
to edit existing text.. 

2. Type or edit the name of the track directly in the name box. 



Muting and Soloing Tracks
To mute or solo a Track: 

1. Click the Mute column of the track such that an  appears.

2. Click on the Solo column of the track such that an  appears.

3. Click again to remove the  and un-mute the track, or click again on the 
 to un-solo the track. 

The mute parameter allows you to silence one or more tracks by toggling the M box on or off. The solo 
parameter works in the same way except the track or tracks are singled out so that only they are heard. 
This can be used for many purposes including isolating timing or voice stealing problems as well as for 
saving alternate takes of parts. The solo parameter always overrides the mute.

Note: To save the mute, solo and transpose functions in a file, that file must be saved as an .ORC file 
otherwise, the muted and non-soloed tracks will be deleted.



Assigning a Track to a MIDI channel
The channel parameter allows you to set or direct a track to a specific channel even if that track was 
originally recorded on a different channel. Note that when you save that MIDI file, the channel you have 
selected in the channel box will be the one that is displayed and used when you restore that file at a later 
date.



Assigning a Track to a MIDI Port
The port parameter designates a MIDI output port for the selected track. The port setting corresponds to a 
MIDI output device that must be set up in the MIDI port section in the Options menu. 



# $ K + Pitch Transposition
This column contains the track’s transposition setting in the format Octaves:Semitones, with an arrow 
indicating whether the track is being transposed up or down. You can transpose a track up or down by as 
much as 10:7, ten octaves and a fifth. 

To Transpose down, use negative numbers; to Transpose up, use positive numbers. So, for example:

-2 transposes down two octaves
1,1 transposes up one octave and one semitone

Pressing the + or - keys on the numeric keypad will increase or decrease the Transpose parameter by 
one semitone, respectively. For example, 1:0^ is one octave up, 0:7^ is up a perfect fifth, etc. Or you can 
use the spin buttons for changing these settings.

To save a file with the transpose function displayed, you must save the file as an .ORC file, otherwise, the 
data is rolled into the .MID file.



Adjusting the Track's Pan Setting
The pan  parameter lets you change the instruments pan or balance for the selected track. This is 
accomplished by sending MIDI controller 10 (pan) messages to the synthesizer. The sound card or synth 
module must have this capability in order to respond to it. Check the owner’s manual for your MIDI 
instrument to see if it does respond to MIDI controller 10. 

Note that for pan, you must have a channel assignment for that track. To change this parameter, use the 
mouse by clicking and dragging or you may use the + and - keys. The values are between -64 and + 63 
and there are left and right arrow indicators that let you know which way you are panning. To set center 
pan, adjust to 0. 



Selecting a Patch
 The patch parameter lets you choose a starting patch or instrument for a track and can be done in two 
ways. The first way is to simply expand the column so you can see the full name of the patch and simply 
scroll through the available patches or you may click the right mouse button or press F2, which opens a 
window listing all of the patches for that device. 

You can use the arrows keys to scroll through the list of patches. The plus and minus keys on the numeric 
keyboard will open and close folders. The enter key selects the current patch. You can also select the 
patch by using the mouse.

Be aware that you can insert patch change events in the Event list giving you the option of changing the 
same track's patch many times during a MIDI sequence. The starting patch will always be the one 
selected in the Track window's patch column unless left blank, but can be immediately changed by 
inserting a Patch change event in the Event list. 

 See also...
Mixer Patch Change Control 
Patch Changes in the Event List 



Setting Track Volume
The volume parameter adjusts the volume on your synthesizer by transmitting a MIDI controller 7 
message when you start playback. You can insert event's for this through out a MIDI song file or it can be 
set once in the volume setting at the beginning of the file. By clicking on the top of the volume column you 
will see sliders pop up. These are for adjusting the volume with the mouse anytime during playback and 
will be active whenever you click on the slider. For the sliders to work on a new track, you must assign 
that track to a channel.

 See also...
Mixer Volume Control 
Inserting New Events 



Bar Pane
The Bar pane is really best for large scale edits where you wish to copy or move a large number of bars. 
It is also suited for marking your from/thru markers for punch in or drag and drop editing.

Each box in the Bar pane contains one measure of MIDI data. The density of the data or events is related 
to the shading of the boxes. The darker the box, the more data (events) the bar contains. A white box 
indicates 
no MIDI data is present. 

You may scroll the bar pane using the scroll bars or by using the page up and down keys. You may click 
with the mouse pointer anywhere in the Bar pane and start play from here or highlight an area by 
dragging the mouse across the area. To jump to the Piano Roll window, double-click the left mouse button 
on the measure you want to edit.

To highlight areas in the Bar pane:

1. Click and hold the left mouse button while you drag over the desired Bars.

2. Release the button when you have highlighted the desired bars.

Use the tab key to toggle the cursor between the Track pane and the Bar pane.



Drag and Drop
Using the mouse, you can drag a selected area and move or copy it to a new position.

Highlight an area by selecting it with the mouse, then move the pointer over the area until the cursor 
changes to a four way arrow. Now grab the area and drag it to the desired location and drop it. If you want 
to copy rather than move the bars, then press the Ctrl key before dragging.

TIP: Remember, if you make a mistake, just select the Undo from the Edit menu and you're back where 
you started. If you decide you don't want to do a drag while you are doing it, just press escape to cancel 
the operation.



Inserting Bars
The Insert Bars command in the Edit menu allows you to insert empty bars in a track or a group of tracks. 
A dialog box will appear verifying the location and number of bars you wish to insert. You may also 
change the time signature of the bars to be inserted. Once you have verified the location, number of bars, 
and time signature, click on OK and the new bar(s) will be inserted. 

 See also...
Insert Bars Dialog Box 



Deleting Bars
To delete bars, highlight the range of bars to delete and select Delete Bars from the Edit menu. A dialog 
box will appear verifying the location and number of bars you wish to delete. Note, you may also change 
these values directly or by selecting the bars with the mouse. You may select all tracks or you may select 
a specific track with the track parameter. Once you have verified the location, number of bars and the 
tracks, click on OK and the bar(s) will be deleted.

 See also...
Delete Bars Dialog Box 



Quantizing Notes
To quantize notes, select the desired area in the desired window. Then go to the Transforms menu and 
choose which quantizing transform you want from either the Note Duration or Start Time category.

 See Also: Quantize Note Duration 
Quantize Note Start Time 



Selecting a Punch Range
The Punch feature allows you to record a selected range in a track and requires that you select a range to 
record. The range is set by adjusting the From and Thru settings. When the Punch function is enabled 
and a track is selected to record on, only the selected range will be recorded. 



Multiple Document Interface
Digital Orchestrator Plus uses the standard Windows Multiple Document Interface to display different 
windows of the same MIDI song file. To jump from one window to another quickly use the Quick View 
Buttons located in the status bar at the bottom of the screen. Or, press and hold the Ctrl key and press 
the Tab key to jump to the different active screens.

 See also...
Transport Control Bar And Status Bar 



Changing Tracks in the Piano Roll Window 
To change tracks in Piano Roll, just click on the down arrow to the right of the track box to access the pull 
down menu. You can then scroll through the list of tracks and select the one you want.

 See also...
Piano Roll Window 



Zooming and Expanding in Piano Roll
The Piano Roll window allows you to zoom in close on a MIDI note or zoom way out to see many bars of 

note data. The zoom button  pops down a menu which allows you to select from the following zoom 
options.

Range - Allows you to zoom in on a selected range, allowing you to zoom in as close as one note or on a 
larger group of notes. Simply highlight the range you wish to zoom in on and select Range from the zoom 
menu.

User - Sets the Piano Roll window to the current user setting. The User setting is defined with the Save 
User command. 

Default - Sets the Piano Roll window to the default setting.

Max Out - Zooms the Piano Roll screen out to display the maximum amount of data the screen can 
support.

Save User - Saves the current window as the User setting. To save a setting; highlight a range and select 
Save User. From that point on, to recall this setting select User from the zoom menu.



Piano Roll Cursor Modes
There are three Piano Roll window cursor modes available for performing different tasks. You can change 
the mode by selecting the appropriate button or by right-clicking in the Piano Roll screen. This will display 
a menu of Piano Roll options which allow you to change modes.

Arrow 
The arrow mode is the default and is primarily used for editing. This mode allows you to highlight notes by 
clicking and dragging over a range. You can also drag the selected range of notes in any direction. Lastly, 
double-clicking in arrow mode inserts a note at the current location.

Pencil 
The pencil mode is used to insert notes. The length of the notes inserted is determined by the insert note 
duration buttons and the Articulation percentage. When you click insert a note, you will see that note's 
length displayed in the Length display. You can also draw the notes duration as you would with a pencil by 
clicking and dragging to the right. 

The inserted notes key-on and key-off velocity can be set to adjust the loudness of the inserted note. 

Lastly, the Grid function affects the start time of the inserted note by snapping it to the nearest grid value.

Eraser 
When in eraser mode, notes are easily deleted by clicking or dragging over them.



Snap to Grid 

The Snap to Grid function  is used to do a type of quantization where notes are either inserted or 
edited with an imaginary grid. This function pulls notes in to the nearest timing or duration value selected 
in the Grid value box

. This allows you to draw in notes that will snap to the nearest quarter note for example, or let you edit 
an existing note and have it snapped to the nearest note resolution set in the Grid box. 

When drawing in notes using the Pencil, you must select a note duration button. This will select the note 
value or length and give you the same value each time you click.

 See also...
Piano Roll Window 



Articulation
The Articulation feature allows you to vary the Duration of the Insert Note between 10% and 110%. Use a 
lower articulation setting in situations where a shorter (staccato) playing style is needed; use a higher 
articulation setting where a smooth, connected (legato) style is desirable. An articulation value greater 
than 100% will cause adjacent notes to overlap. 

Although most MIDI devices respond correctly to overlapping notes some do not, so check your 
documentation if you encounter problems at high Articulation settings.



Tuplets
When the Tuplet button is engaged, this function modifies the current insert note duration for inserting 
tuplets. (triplets, quintuplets, etc.) The articulation ratio control is used to set the ratio of "notes to beat". 
For example, the ratio setting of 3/1 means that the note duration will be set to "one third of the beat" 
allowing you to create a triplet figure.

The articulation ratio control allows you to set the desired amount of notes in the space of a normal 
duration. To clarify, it sets how many notes you wish to squeeze into a set space of time. Normally there 
are two eighth notes per quarter note. If you desire three notes inside of one beat the tuplet button will 
place them there. For example, the setting of 3/2 will allow you to place three notes where two normally 
reside.



Editing Existing Notes 
There are three ways to modify the characteristics of existing notes in a track. 

1. Dragging a Note in the Piano Roll Window - When you simply wish to change the pitch, start time or 
duration of a note, it is easiest to do this by dragging the note.

This can be accomplished with the mouse by moving the cursor over one of three "zones" in the note and 
dragging it to the desired value. The cursor arrows will change as you move over each "third" of the note 
displaying how the note can be modified.

Start time 
The left most part of the note. When you pass over this zone, the pointer will change to an right/left arrow 
and allow you to drag the notes start time without effecting the pitch or duration.

Pitch 
The center part of the note. When you pass over this zone, the pointer will change to a up/down arrow 
and allow you to drag the note up and down changing its pitch without effecting the start time or duration.

Duration 
The right most part of the note. When you pass over this zone, the pointer will change to a right arrow and 
let you change the length or duration of the note without effecting the pitch or start time.

2. Making Precise Adjustments in the Note Parameters Dialog Box - Double-clicking on a note in the 
Piano Roll window will display the Event Lists note parameters dialog. This will allow you to precisely 
adjust the various parameters of that note including key on and key off velocity.

3. Pressing the "Change" Button in the Event Editor - The Event Editor lists the notes in a track along 
with other MIDI data. The parameters that make up a note can be changed by highlighting the note and 
pressing the "Change" button. This will display the Event Edit dialog box which displays and allows you to 
modify the notes parameters.

 See also...
Piano Roll Window 
Inserting a New Note 
Editing Numeric Note Parameters 
 



Inserting a New Note
Besides recording notes from MIDI instruments, notes can be inserted manually in a track from both the 
Piano Roll window and the Event Edit window. 

Inserting Notes in the Piano Roll Window...

When in pencil mode  notes are inserted by clicking at the desired pitch and start time coordinates in 
the Piano Roll window. When in arrow mode 

 notes are inserted by double-clicking. Once you have inserted a note, it can be easily edited by 
dragging it or double-clicking on it. 

When a note is inserted, it is also auditioned. You will also hear the notes pitch played when you drag it to 
a new pitch location.

The characteristics of an inserted note are set with the Note Length Buttons, the Articulation function, and 
the Key On and Key Off Velocity settings. The Grid function also affects the inserted note and allows you 
to insert the note at a precise start time.

Lastly, if you want to make a copy of an existing note you can do so by holding the Ctrl key down while 
clicking on the note you wish to copy. This will produce a duplicate note which you can drag to a new 
location.

Inserting Notes in the Event Edit Window...

Notes are inserted in the Event Edit window just as you would any other event. Although it is not as 
intuitive and graphical as the Piano Roll window, it does provide a precise way of editing the note data.

To insert a note, you should first select a track to insert the note into. Then press the Insert Button. This 
will display the Event Edit dialog box which will allow you to select the Event Type and the parameters for 
that event. In this case you should select the note icon in the Type box and set the parameters for the 
note. When you press the OK button the note will be inserted at the start time that you set.

 See also...
Inserting New Events 
Editing Existing Notes 
Piano Roll Window 
Event Editor 



Deleting a Note
Notes can be deleted a number of ways...

Deleting Notes in the Piano Roll Window...

From the Piano Roll window, notes are deleted by selecting the eraser  cursor mode and clicking on 
the notes to be deleted. In arrow mode 

 you can click and hold the note while pressing the delete key to remove the note. And, of course, 
you can highlight the note and select Cut from the Edit menu.

Deleting Notes in the Event Editor...

Deleting notes in the Event List is as easy as selecting the "note event" and pressing the Delete button.

 See also...
Editing Existing Notes 
Piano Roll Window 
Event Editor 



Editing Numeric Note Parameters
Double-click on any note you wish to edit in the Piano Roll and a dialog box will pop up that contains all 
the notes parameters including the ones not readily available on the Piano Roll screen. 

 See also...
Editing Existing Notes 
Piano Roll Window 
Event Editor



Types of Events
Every horizontal line you see in the Event Editor is a separate MIDI event and each type of event has its 
own purpose. The first type of event is the note event. All events contain the following:

Variable parameters

Type Parameters

Note pitch, velocity, start, duration

Control controller number, value

Patch 
Change

patch number, name

Wheel pitch bend

Channel 
Aftertouch 

mono pressure amount

Key 
Aftertouch

key pressure amount



Patch Changes in the Event List
Instrument patches can be changed in the middle of a track by inserting a patch change event. 

To change a patch in the middle of a song, click on the insert button. This will display the Event Edit 
dialog. Select the Patch Change icon from the Type: box and then select the patch to change to in the 
Parameters area. Lastly, set the Position where you want the patch change to happen.

Note: The patch setting in the Track window will always be in effect when you start sequence playback 
from anywhere in the song until it encounters another patch change in the Event list. The Event list will 
then override the Track window patch until you stop and start or pause and un-pause.

 See also...
Inserting New Events 
Event Editor
Filtering Event Display 



Changing Event Parameters
To change event parameters, select the track and the event you wish to edit. Now click the change button 
and a dialog box will open up with the parameters for that event. Note, that you cannot change the Event 
Type. To do this you must delete the event and insert a new one with the new Type. 

 See also...
Inserting New Events 
Event Editor
Filtering Event Display 



Inserting New Events
To insert a new Event: 

1. Highlight the location in the event list where you want the new event. 

2. Now click on the insert button and a pop up window will give you a choice of six icons. Choose the 
appropriate event type by selecting the icon in the Type list 

3. Set the event Parameters to the desired settings and set the Position where you want the event to be 
inserted in the track.

4. Press OK to insert the event.

 See also...
Event Editor
Deleting Events 
Moving Events 
Filtering Event Display 



Deleting Events
In the Event List, highlight the event you want to delete and click on the Delete button. If you want to 
delete a continuous group of events, just highlight them all by holding the left mouse button and dragging 
over the events, then click the Delete button. 

 See also...
Event Editor
Moving Events 
Inserting New Events 
Filtering Event Display 



Moving Events
To move events, highlight the event, select Cut from the Edit menu. Click on the new location and select 
Paste from the Edit menu to paste them to their new location. 

 See also...
Event Editor
Deleting Events 
Inserting New Events 
Filtering Event Display 



Filtering Event Display
When using the Event list, you have the option of displaying or looking at only the events you want to see. 
By using the Filter option, you can turn on or off any type of event, giving you a clearer screen to work 
with if you just want to edit note events or controller events. 

Take care to check the filter box and button every time you change something in it, because hearing 
something you don't see in the event list can be confusing. The Filter button will always show depressed 
(grayed out) as long as any Events are being filtered.

The following events can be filtered out of the Event list display:

Note events
Controller events
Patch change events
Key aftertouch
Channel aftertouch
Pitch bend
Tempo
Meter
Key signature

To open the Filter box, click on the Filter button. Turn the event type on or off by clicking the button for that 
event on of off. Note that turning a type of event off in the Filter box does not get rid of the event it is still 
there, it is just not displayed in the Event list.



The Conductor Track
The Conductor track is Digital Orchestrator Plus' way of organizing Tempo, Meter, and Key signature. In 
the Event list, you select the Conductor Track by clicking on the Track box until you see Conductor. You 
treat these events as you would any other events. This is also where you would create a tempo map by 
inserting tempo events with the desired tempo values at the desired locations.

Tempo Events
Tempo can be inserted as an event anywhere in the event list. Open the Insert dialog box and choose 
tempo. Insert the tempo changes as needed with values in beats per minute. 

Meter Events
Meter, or time signature allows you to select the number of beats 
per measure.

Key Signature Events
Key signature allows you to select the key in which the song file is displayed in the Notation view. Multiple 
key changes are possible.

 See also...
Event Editor
Inserting New Events 
Filtering Event Display 



Channel Info
Click this box to open and change track and channel parameters.

Tracks on Channel
Lists the names of all the tracks contained in the channel module, and lets you select for naming or 
transposing.

To name or transpose one the tracks, highlight its name in the Tracks Channel box. When the track name 
appears in selected track box, type a new name for that track. You can then transpose the track.

Selected Track
Displays currently selected track. The selected track is also displayed at the bottom of the channel 
module of the mixer screen.

Transpose
Allows you to transpose (change key) of selected track by semitones 
(1) or octaves (12).

Patch
Allows you to select a patch for that channel.



Viewing Patch Names in the Mixer Window
To view patch names, place the mouse pointer over the boxes at the bottom of the volume slider and the 
name will pop up as you pass over the box. The patch can be changed by clicking the channel number 
and opening the dialog box at the top of the Mixer window. 

By clicking the right mouse button on the patch box at the bottom of the mixer, the port device presently 
selected may be viewed. The LED meters at the top of the mixer show the density of the MIDI data by 
illuminating more lights as the MIDI data becomes more dense.



To Display Notation...(Transcribe a Track)

Click on the notation Quick View Buttons at the bottom of the screen or select it from the Window menu. 
You must next click on the transcribe button to initiate transcription of that track. In the Transcribe window, 
you may select the Track, Title, Zoom and other parameters. 

You may also view notation in the Piano Roll window by clicking the notation button at the top right of that 
screen. Notation will be displayed at the bottom of the Piano Roll and the windows can be re-sized by 
dragging the borders to the desired position. 

Clicking with the right mouse button in the Notation window pane will pull up the Transcribe box. This 
contains the real-time transcription settings for the Notation window pane.

 See also...
Printing Notation 
Transcription Settings 



Printing Notation

Printing notation with Digital Orchestrator Plus is simple:

1. From the Notation window, select the track you wish to print, click the Transcribe button. 

2. When you are satisfied with the score, click on the Print button and a standard Windows print menu will 
come up. 

3. Click setup if you need to make adjustments for your printer, then select either ALL for all of the song or 
select only the pages you want to print. Click on OK.

Make sure the SPW font included on the Digital Orchestrator Plus disc is installed. If the font is not 
installed you can install it from the Windows Control Panel. 

 See also...
To Display Notation... 
Transcription Settings 



Transcription Settings
The following are descriptions of the settings that are available in the transcribe dialog box:

Tracks
Use this box to select the tracks you want transcribed into notation. This is a multi-select box which lets 
you select up to ten tracks to be transcribed. 

Note: Only ten staves will fit on a page. If you select ten tracks to be transcribed and one of them requires 
a grand staff (such as a piano part), you will be notified that you must un-select a track to meet the ten 
stave maximum.

Title
Use this box to Title your work. Title will appear at the top of the score.

Author 
This box allows you to add your name, or the authors name, at the top right of the score. 

Copyright
This box allows you to enter copyright information. This text gets displayed at the bottom of the first page. 
To use the Copyright character "©" press Alt + 0169 on the number keypad.

Bar numbering button
To display each bar number at the beginning of each measure, click this radio button on.

Split point
(Grand Staff only) Pitches equal to or higher than the split point are printed on the upper staff; lower notes 
appear on the lower staff. You can change the split point from its default setting of C5 (middle C).

Clef
Selects the available Clef choices:
Treble Clef uses only the treble clef.
Bass Clef uses only the bass clef.
Grand Staff displays both treble and bass clef.
Auto automatically selects the clef depending upon the contents of the file. This is the default and is highly 
recommended for multitrack transcription.

# of Voices
To score two separate voices on the same staff, click on the # of Voices box. The number 1 changes to a 
2 to indicate that voice separation is active. Notes in the established time signature are transcribed with 
their stems up. Notes played in a differing rhythm (counterpoint) are shown with stems down. To turn 
voice separation off, click on the box to restore the number of voices to 1.

Triplets
Click on this box to activate triplet transcription. Digital Orchestrator Plus can transcribe eighth note 
triplets (only), provided they are played with reasonable accuracy within the tempo of the piece. A small 
triplet bar with a numeral 3 indicates that this feature is active.

Transpose
To transpose a track's notation, enter a transposition value in the format of octaves:semitones. This 
affects only the notation of the track; the underlying MIDI data is not changed.

Suppress rests
Selects the available options below:

Off turns off the rest suppression feature.
Normal allows some rests to be visible, this is a compromise between no rest suppression and full (fill) 
rest suppression.



Fill hides rests by filling notes out to the next downbeat. -- this is full rest suppression mode.

Quantize
Quantize displays the notes in the nearest quantize value. This does not effect the source MIDI file.



Refining Notation
If you are printing your scores, and the results are somewhat difficult to read or the score contains too 
many rests and the timing of the notes is not what you thought you played, some tweaking of a few 
parameters may be needed.

Try the following to see if the notation comes up looking more like what you thought you played:

Try quantizing to a larger quantization step for example, if you used 16th note quantization on the first 
time around, try 8th notes instead. The larger step should pull in some of the stray notes and make it look 
tighter.

Note: Quantizing in the Transcribe box will not effect your source MIDI file. Only the displayed or 
printed notation is quantized.

Next, try using rest suppression fill when you click on the Transcribe button again and see if that removes 
some of the extraneous rests that tend to get thrown in when the computer tries to quantify an inexact 
human performance.

 See also...
To Display Notation... 
Transcription Settings 



Expand Parameters Menu Button
Displays a menu which allows you to quickly shrink or expand the view on all of the track parameters. 

Expand All - Expands all of the Track parameters and shifts the Bar pane to the right.

Shrink All - Shrinks all of the Track parameters and shifts the Bar pane to the left to expose more bars.

Bar View - Does not effect the Track parameters; however it moves the pane divider to the left to expose 
the maximum number of bars. 



Track Name
Allows you to title each track. The name column can be shrunk or expanded by clicking on the Name title 
at the top of the column.



Track Patch
Displays the patch—the sound that you want the track to use—as either a patch number (reduced width) 
or a patch name (expanded width). Patches are numbered from 0 to 127.

The Patch parameter setting causes the specified patch to be sent out to that channel every time you 
start playback.

Click with the right mouse button to bring up the Patch Selection dialog box which shows all the available 
patch names and numbers.

 See also...
Selecting a Patch 



Output Port
The Port parameter allows you to choose the desired port for a track. The Port column can be shrunk 
down or expanded by clicking on the Port title area at the top of the column. 

Right-clicking on the port column displays a list of available ports.

Shortcut key: F3

 See also...
Setting Up MIDI Ports 



Output Channel
This shows the MIDI channel (1-16) to which the MIDI events in a track will be routed. Each different 
instrumental patch (voice) you use in your music needs to be set to a different channel. You can change 
the channel assignment for a track by clicking this column and typing in a new value or by using the spin 
buttons to cycle through the channels available. 

For each output port you have defined in your port setup you will have 16 channels to choose from. This 
makes it possible to have very complexly orchestrated arrangements with more than 16 channels.



Track Volume
The Volume parameter sets the volume for the tracks on a given channel. This control can be viewed as a 
numerical or a slider by clicking in the Volume title area. Volume changes can be made from the mixer 
window. If you want to change the volume of a track in the middle of the song, volume change events can 
be inserted in a track from the Event Editor.



Pan
The Pan settings affect the relative left and right volume settings for stereo playback. 

This column contains the track’s left/right pan positioning as a numerical value with an arrow indicating 
left or right panning. Negative numbers are interpreted as pan left; positive numbers are interpreted as 
pan right.

Pan values are defined as: 

<<64 = full left
<<0>> = center
63>> = full right

The Pan setting will transmit a MIDI Pan message on the specified channel whenever you start playback 
or change its value.

 See also...
Adjusting the Track's Pan setting 



Record On/Off

The Record Select parameter allows you to select the track to record on . You must select a track to 
record any MIDI data. To record multiple tracks, hold down the CTRL key while selecting which tracks you 
wish to record.

 See also...
Recording a Track 
Multitrack Recording 



Mute

This displays the track’s Mute status. When a track is muted (as indicated by an icon in the Mute box), it 
will not trigger any notes or transmit any other type of MIDI data.

Click a track’s Mute box to toggle Mute on or off. Using Ctrl-click, you can Mute multiple tracks in the 
same way as you Solo them.



Solo 
This displays the track’s Solo status. When a tracks is soloed, as indicated by an icon in the Solo box, all 
other tracks will be muted. 

You click a track’s Solo box to toggle Solo on or off. If you hold down the Ctrl key and click, you can solo 
more than one track at a time.



Transpose Track
This column contains the track’s transposition setting in the format Octaves:Semitones, with an arrow 
indicating whether the track is being transposed up or down. You can transpose a track up or down by as 
much as 10:7, ten octaves and a fifth. 

To Transpose down, use negative numbers; to Transpose up, use positive numbers. So, for example:

-2 transposes down two octaves
1,1 transposes up one octave and one semitone

Pressing the + or - keys on the numeric keypad will increase or decrease the Transpose parameter by 
one semitone, respectively. For example, 1:0^ is one octave up, 0:7^ is up a perfect fifth, etc. Or you can 
use the spin buttons for changing these settings.



Track Select Button
Pressing any of the track number buttons selects that track and allows you to drag it to a new location. 
You can delete the track by pressing the delete key while the track is still selected. And, you can also 
make a copy of a track by holding down the control key and dragging the track to a new location. Holding 
the control key will leave a copy behind as you drag the duplicate to a new track location.



Play Position Pointer 
Displays the current play position location. The play position can be changed with the transport buttons, 
by adjusting the Bar:Beat:Click parameters or by right-clicking in the bar label area. You can also right-
click and drag the Play Position Pointer in the Piano Roll window to "scrub," or hear the notes in the track 
as you move the cursor past them.



Bar Data Area
Displays the recorded MIDI data. The different shades of gray in the bars indicates the amount of data in 
the bar. The more data, the darker the bar.

MIDI data can be edited in this area by highlighting a range of bars and choosing a command from the 
Edit menu. The bar data area also supports drag and drop functions.

Tracks that contain digital audio data display a waveform in the right pane of the Track/View window.

Tip: Double-clicking on a bar will display the Piano Roll window set to that track at the location of the bar 
that was clicked on. Double-clicking on and Digital Audio will display the Digital Audio window set to that 
track and location.



Dotted On/Off
Selects the note duration value of the note to be inserted. This is also affected by the Tuplet and the 
Articulation functions.



Grid
The Grid function creates an invisible vertical grid in each bar to help align notes to a precise location 

when editing. When the Grid button  is engaged, all edit functions and inserted notes will snap to the 
nearest grid value. The note value 

 represents the division of time in one bar. Click on the note value button to change it to the desired 
value. For example, if the note value is a quarter note, then all inserted notes will snap to the nearest beat 
in a 4/4 bar.



Track Selector
Selects the track to be displayed in the editor.



Insert Point
Displays the current position of the cursor in the editing area or the Start Time of the note being edited in 
the format Bars:Beats:Clicks and Minutes: Seconds: Frames: Hundredths



Insert Pitch
Displays the current position of the cursor in the editing area, or the pitch of the note being edited, as a 
note name and octave number.



Insert Length
Displays the duration value of the note to be inserted. Or, when editing the duration of a note with the 
mouse, the Length parameter displays the duration of that note as you are editing it.

The note duration value is determined by the Insert Note Duration buttons, the Tuplet setting and the 
Articulation function. As you modify these settings you will notice the Length display will change to show 
the aggregate value of the insert notes length settings in a precise Bar:Beat:Click format.



Insert Note Velocity Settings
Displays and allows you to adjust the current insert note velocity settings. On Vel Refers to the Key On 
velocity of the note to be inserted. Off Vel refers to the Key Off velocity of the note to be inserted.



Zoom Button
Displays a menu for zooming in or out. 



Notation Button
When engaged, the current track is automatically transcribed into musical notation and displayed in a 
pane at the bottom of the Piano Roll window. This window can be made bigger or smaller by dragging the 
border between the Piano Roll pane and the notation pane.

The Piano Roll and notation windows are aligned at the left side only. This is to allow the user to view 
more bars in the Piano Roll window while still displaying notation with accurate bar spacing.

Because the transcription is done automatically, in real time, any changes that are made in the Piano Roll 
display are automatically reflected in the notation. Although this feature is very helpful in adjusting the 
MIDI data to display accurate notation, it does increase the work load on your PC. It is suggested, when it 
is not necessary to view the notation, that you close the notation pane to increase your performance.

Various transcription settings can be set by right-clicking on the notation pane. This will display the 
transcription settings dialog box.



Notes/All Button
Clicking the Notes/All button toggles edit mode between All MIDI data and Notes only. When in Notes 
mode, only notes will be affected when editing. When in All mode, all MIDI data will be affected—including 
MIDI controllers, benders, modulation, etc. 

· Should you wish to cut a note at the same point where a MIDI program change is embedded, if you 
want to keep the program change, Notes mode should be selected. 

· If you want to delete the program change and any other MIDI data at that point in the bar, then the 
All button should be selected.



Transcribe Button
Displays the Transcription dialog which allows you to select a track to transcribe, and adjust the 
transcription settings.



Refresh Transcription
After transcribing a track and then editing the MIDI data it will occasionally be necessary to update the 
transcription to reflect the edited MIDI data. Pressing the Refresh button quickly updates the transcription 
using the current transcription settings. When the Refresh button is grayed out the current transcription is 
up to date.



Page Selector
Display the current page and lets you quickly move through multiple pages of the currently transcribed 
track.



Print Transcription
Displays the Print dialog box for printing the current notation.

See Also: Printing Notation 



Insert Button
Displays a dialog box which allows you to select the type of MIDI event and the parameter settings for the 
event to be inserted. The event will be inserted at the current cursor location in the Event window.



Delete Button
Deletes the selected MIDI event(s).



Change Button
Displays the Event dialog, which shows the settings for the currently selected event, and allows you to 
edit it. The Type setting is grayed out however the parameter settings can be modified.



Filter Button
Displays a dialog box for selecting which types of MIDI data to be viewed in the Event window display. 
This feature works by allowing you to filter out the data that you don't need to see. For example, if you 
only want to see patch changes, deselect all data types except for Patch Change. This will filter out all of 
the other events in the display, allowing you to only see the patch changes embedded in that track.

 See also...
Filter Events Dialog Box 



MIDI Density Meters
The MIDI Density Meters display the relative amount of MIDI data that is being transmitted in each 
channel. When there is no MIDI port assigned in the MIDI Mapper for a given channel, the density meter 
for that channel is grayed out. 



Mixer Patch Selector
The Patch Selector allows you to select or change the sound that is being played by that channel. 

To select or change the patch:
Click on the top half of the Patch Selector control to increase the value, click on the bottom half of the 
numerical to decrease the value. Or, click on the Patch Selector control and drag up or down to increase 
or decrease the values. You can also select patches from the Channel Info dialog box. 



Mixer Volume Control
The Volume Sliders let you increase or decrease the playback volume of each channel.



Mixer Track Name Display
Displays the track name in a condensed form for that channel. To see the full name, move the mouse 
over the name. In the case of a song that has multiple tracks for one channel, the mixer screen displays 
the first track on that channel. This can be changed in the Info box by choosing a new Selected Track.



Using the Transport
Digital Orchestrator Plus uses a familiar tape deck style transport for playing, recording and moving 
around in the song. The transport buttons are rewind, stop, play, record, pause and fast forward.

Besides the transport there are other ways to move the playback position in the song. These include the 
keyboard function keys, the spacebar, adjusting the bar:beat:click settings, and setting the Play Position 
Pointer manually. 



Setting Up MIDI Ports

In order for Digital Orchestrator Plus to communicate with your MIDI hardware, you must tell it what port 
to use. A port is a way of identifying the device driver for your computers MIDI hardware. Digital 
Orchestrator Plus can use multiple ports at one time and assign any track to any port. 

For example, if you have a sound card with an FM synthesizer and a MIDI interface hooked up to an 
external keyboard, you should have a separate port driver for the FM synth and the MIDI interface. When 
you want the information from a track to be played on the FM synthesizer, you would select the FM synth 
in port column of that track. For more on MIDI ports and drivers, see your Microsoft Windows Users 
Guide.

Very often the installation of your sound hardware will assign the port(s) to the Windows MIDI Mapper. In 
this case you should choose the MIDI Mapper as your output port.

To Setup a MIDI Port:

1. Be sure that your MIDI hardware and the Windows driver has been installed properly. 

2. Select MIDI Port Setup from the Options Menu. The MIDI Port dialog is displayed.

3. Choose a MIDI port for both the Input and the Output.

4. Press OK to accept the port settings.

5. Digital Orchestrator Plus sets up all tracks to the first port by default. If you wish to change a port click 
in the port column in the Track/View screen.



Setting Up Patch Names for a MIDI Port

Digital Orchestrator Plus allows you to assign a set of patch names for each channel in a MIDI port. 
These patch names are displayed in the Track/View screen when the patch column is in the expanded 
mode or when you right-click in the patch column. 

To Setup Patch Names for a Port:

1. Select the Patch Map item from the Options Menu.

2. Select the device driver you wish to assign patch names to.

3. Select the Patch Map for each channel.

If the patch names are the same for all channels, enable the Same button. This will automatically fill in all 
remaining channels once you have selected a patch map.

4. To setup a patch map for another port, select a new device driver.



Recording a MIDI Track

Recording a track in Digital Orchestrator Plus is quite simple:

1. Select New from the File menu.

2. Select the track to record on by clicking in the "R" column of a track. 

3. Set the Port and Channel you wish to record on.

4. Press the Record button on the transport. The metronome will click off four beats for a count in, then 
begin recording. Once Digital Orchestrator Plus is recording, (record light is illuminated.) play your MIDI 
keyboard. 

5. When you are done recording, press the Stop button. You should see a number of boxes in the bar 
area of the track you recorded. 

6. Press the Play button or press the spacebar to play your recording.

 See Also: Multitrack Recording 



Overdubbing (Recording More Tracks)

Overdubbing is the process of adding or layering additional recorded tracks over previous recordings. To 
do this you simply select another track for recording and follow the normal steps for recording a track. 
While you are recording the new track you will be able to here the previously recorded track for reference. 
For example, if you recorded a drum part first, you will be able to hear the drum track as you are 
recording the second part, such as a bass line or melody.

When recording another track and you want to use a different sound, it is necessary to set the new track 
to a different channel. This will allow you to set the track to a different patch.



Playing a MIDI File 
To play a MIDI file:

1. Load a file by selecting Open from the Files menu.

2. From the File Open dialog box, select a .MID or .ORC file and press OK.

3. Press the play button or the spacebar to start the song.



Punch Recording

Punch recording automatically puts Digital Orchestrator Plus into record mode for a specified range in a 
track. This is very helpful for fixing a small part in a track or for recording a track a section at a time. 

To punch record:

1. Enable the Punch button.

2. Select the From and Thru range.. This is where you will automatically start and stop recording.

3. Enable the track you want to record on by clicking in the R column for that track on the Track/View 
screen.

4. Press the Record button. The song will begin playing for the number of count in bars that have been 
set (usually 1) and the LED on the Record button will blink. When the song position reaches the From 
point the Digital Orchestrator Plus will begin recording and the LED will be lit solid. When the song 
reaches the Thru point the sequencer will stop recording.



Setting the Play Position
Where playback starts in a song is determined by the play position. Once you have set a play position 
Digital Orchestrator Plus will always play from that point until you set a new position. There are a number 

of ways to set the Play Position  in a song. 

1. Transport - The transport will move the play position by pressing the rewind and fast forward buttons. 
You can also move more quickly by holding down the Shift key while pressing the rewind or fast forward 
buttons.

2. Bar:Beat:Click Display - By clicking on the Bar:Beat:Click Display you can manually set the play 
position by adjusting the bar beat and click values.

3. Function Keys - Function keys F4 and F9 duplicate the functions of the rewind and fast forward 
buttons on the transport. To move more quickly, hold down the shift key while pressing F4 or F9. For a 
complete table of these functions click on Keyboard Commands.

4. Mouse Right-click- When you right-click in the bar label area of the Piano Roll screen or the Bar Pane 
in the Track/View screen the song position cursor will snap to the position of the mouse. 



Changing the Tempo
The initial tempo for a song can be set by adjusting the Current Tempo control at the bottom right of the 
Status Bar. You can also set the tempo in the conductor track. This provides the ability to set different 
tempos at various points in a song.

The tempo offset control is used when you want to adjust the tempo in a song that has many tempo 
commands throughout the song. This allows you to keep the relative tempo settings and still adjust the 
overall tempo of the song.



Setting the Count In
The Count In sets a number of bars to "count in" before the song plays or records. This provide a 
reference of tempo and to allow enough time to get ready to play when recording. It also sets the number 
of lead in bars before recording in Punch mode.

To set the count in:

1. Select Metronome Settings... from the Options Menu. This will display the Metronome Setup dialog 
box.

2. At the right hand side of the dialog are the Count In settings. Here you can choose to have a count in 
before recording, playing or both. You can also set the number of bars to count in.

3. The Count In uses the a click to provide a beat reference. You should set the click settings so that you 
can hear it through the PCs speaker or send a MIDI note to your drum machine to play a percussive 
sound for reference. You also can set the click to sound on playback, record, or both. 



Adjusting the Metronome Click Settings
The metronome's click can be set to play through the PC speaker or to play a MIDI note through a 
synthesizer such as a drum machine. You can also set it to sound on playback, record, or both.

To adjust the metronome click settings:

1. Select Metronome Settings... from the Options menu. This will display the Metronome Setup dialog 
box.

2. Choose the desired options.

3. Press OK to accept changes.



Info
Clicking on an Info button brings up the Channel Info dialog box for that channel.
  
The Channel Info dialog box shows the MIDI tracks that are assigned to that channel. A Transpose 
function lets you transpose the pitch of the selected track by octaves and/or semitones. Lastly, the Patch 
combo box provides an alternate way of selecting a patch for that channel.



Bar Label Area 
The bar label area marks the vertical time in bars. Left clicking with the mouse in the bar label area marks 
the insert point for pasting. Left click and dragging the mouse in the bar label area highlights all data in 
that bar or range of bars. Right-clicking in the bar label area sets the play position at the point where you 
clicked.



Conductor Track
The conductor track in the Event Edit window allows you to insert Tempo, Key Signature and Time 
Signature events throughout a song.
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MIDI Controller:
A type of MIDI event which provides control over various parameters on a synthesizer. These include; 
Volume Level, Pan Setting, Modulation, Pitch Bend and more. Each control has a number value to 
identify it, for example, Volume is controller #7 and Pan is controller #10.

Note: Not all synthesizers and sound card support all of these features. You should check the 
synthesizers documentation for a list of MIDI controllers it supports.



MIDI:
Musical Instrument Digital Interface. MIDI is a serial interface and protocol which allows musical 
instruments and computers to communicate.



FM Synthesis:
A form of electronic synthesis which generates complex wave forms through the use of Frequency 
Modulation. 



Quantization:
Quantization refers to a transform that is performed on a note or group of notes where the start time of 
the note(s) is modified. When a note is quantized its start time is pulled onto the closest predetermined 
division of the bar or beat. This process is typically used to "clean up" the rhythm part of a recorded track 
by pulling the notes to the exact beat. This function also tends to make rhythms sound mechanical.



Wavetable Synthesis:
An alternative to FM and analog synthesis whereby waveforms which make up the sound consist of 
recorded samples of real instruments. Wavetable synthesis is also known as sample playback synthesis.



Score:
Relating to music, a timeline notation of musical events, sometimes on paper, but can also be on a 
computer or other medium. Music notation.



Velocity:
In terms of MIDI, the force with which a note is struck (Key On) -- or released (Key Off). Velocity is given a 
value between 0-127. Usually effects the volume and the brightness of the sound being played.



Multitimbral:
Multitimbral refers to the capability of a synthesizer to play multiple parts or instruments at the same time. 



Patch:
Defines an instrument or sound in a synthesizer and in the case of General MIDI has a name and number 
assigned to each of 128 patches. 



Port:
 A port defines a designated output to a piece of MIDI hardware such as a MIDI interface or sound card. 



Channel:
For each port MIDI has 16 discrete paths called channels for communicating MIDI data. These channels 
allow MIDI data from different sources or tracks to be kept independent. When a multitimbral synthesizer 
receives this data, it can play the independent channels of MIDI data using different instrument sounds. 
Similarly, many synthesizers can be daisy chained together and assigned to "listen" to different channels. 
This allows you to send MIDI data from a track to the desired synthesizer in the chain.

Many tracks can be assigned to one MIDI channel.



Tracks:
Track is a term for "a recording" or a place to store a recording. Like professional analog tape recorders, 
Digital Orchestrator Plus can store multiple recordings, thus making it a "multitrack recorder". A powerful 
feature of multitrack recording is the ability to record a track, then go back and record an additional track 
while listening to the previous track. This process, often called "overdubbing," allows one musician to 
build up a song, one track at a time, until an entire production has been created. 

In Digital Orchestrator Plus tracks can be recorded, re-recorded, controlled, and edited. Tracks are 
typically assigned a port and a channel which routes the tracks data to the synthesizer(s) and allows 
discrete tracks to play different instrument sounds. 



Event:
An Event or a MIDI Event refers to a piece of MIDI data such as a note, pitch bend, program change or 
any other MIDI controller message. An event usually includes various parameter values which make up 
the characteristics of that event. For example, a note event's parameters would include the pitch, length, 
start time and key on and off velocity values. 



Notation:
Notation is a standard form for graphically representing music. 



Duration:
In MIDI, the length of a note is often referred to as its duration.



Sequencer:
Digital Orchestrator Plus is a MIDI sequencer. It records a "sequence" of notes and other MIDI events 
and plays them back in the same sequence through a MIDI synthesizer. A sequencer typically allows 
you to edit a sequence and save it as a sequence file. The sequence file can be loaded again at a later 
time an played back.



Key Signature:
In standard music notation, the key signature denotes the key of the song and displays the number of 
sharps or flats in the key. A key signature can be inserted and saved as part of a MIDI file and is done in 
Digital Orchestrator Plus by editing the Conductor Track in the Event Edit window. 



Time Signature: (Meter)
In standard music notation, the time signature (or Meter) denotes the number of beats and the value of 
the beat in a piece of music. For example, a 4/4 time signature means that there are four beats in a bar 
and the quarter note gets the beat. A time signature can be inserted and saved as part of a MIDI file and 
determines the number of beat divisions in each bar. The meter can be set in Digital Orchestrator Plus 
by editing the Conductor Track in the Event Edit window. 



Metronome:
The metronome serves as a reference of time when recording a track by playing a steady audible 
"click". In Digital Orchestrator Plus the metronome can be set to play a "beep" from the PC speaker or 
send a MIDI note through a synthesizer or drum machine. The metronome can also be adjusted to play 
during the count in, playback or recording. These options are set in the Metronome Settings dialog.



Transport:
The Transport in Digital Orchestrator Plus is the top row of buttons which control the playback and the 
song position cursor in the song. These buttons include rewind, stop, play, pause, record and fast 
forward. For more on the transport see the Transport Control Bar and Status Bar section.



Transpose:
Transpose refers to changing the relative pitch or the key of a song or track. This procedure done in 
Digital Orchestrator Plus from the Track/View window by adjusting the Trans setting for each track.



MIDI Output Device:
MIDI output device refers to the device driver that controls the MIDI hardware in your PC. Device drivers 
are typically installed in Microsoft Windows during the hardware installation. For more information on 
device drivers see your MIDI hardware documentation or your Windows Users Guide.



MIDI data:
The information that gets recorded and edited in Digital Orchestrator Plus. This includes note information, 
controllers, pitch bend, etc. 



Pan:
In MIDI, pan is a controller message (number 10) which determines the left/right placement of a sound 
in the stereo spectrum. Digital Orchestrator Plus has a pan control on each track of the Track/View 
window and in the Mixer window. Pan is a channel independent MIDI controller message, thus all tracks 
assigned to the same channel will have the same pan setting.



MIDI Mapper:
The MIDI Mapper is a application that comes with Windows. This application allows you to route the 
MIDI output of a MIDI application (such as Digital Orchestrator Plus) to the MIDI device drivers in you 
system. For more information on the MIDI Mapper, see your Microsoft Windows Users Guide.



Tempo:
The speed or pace of a song.



Auditioning with the Scrub Function
Digital Orchestrator Plus provides the ability to audition notes from the Piano Roll window in non-real 
time. This feature is called scrubbing. This is very useful when manually entering notes in the Piano Roll 
screen and you need to hear what you have inserted. In this manner you can audition chords and/or fast 
musical passages in non-real time, without hearing all the other tracks in the song. 

Single notes are auditioned when you drag or click on them. 

To Scrub a Section in the Piano Roll Window:

1. Right-click in the measure counter area to cause the vertical play cursor to snap to the position of the 
mouse cursor. 
2. While holding the right mouse button drag the cursor from left to right and you will hear the notes as the 
play cursor passes over them. 



Auditioning Note Pitches and Drum Sounds
Note pitches and drum sounds can be located before inserting a note in the Piano Roll window by clicking 
in the vertical piano display on the left side of the window. This will audition the pitches or drum sounds.



MIDI In/Out LED Indicators
These indicators let you know that Digital Orchestrator Plus is receiving and transmitting MIDI data. This 
feature is very valuable when troubleshooting your MIDI system. The indicators will blink green when 
there is normal data being transmitted. The indicators will illuminate red when there is bad MIDI data 
detected. The top light is MIDI in and the bottom is MIDI out.



Merging Tracks
Although Digital Orchestrator Plus gives you 1000+ tracks to work with, sometimes it is desirable to 
merge tracks together to keep things organized. For example, very often drum parts are recorded on 
separate tracks, but they are all assigned to the same MIDI channel. In this case it may be practical to 
merge them to create a more organized working environment

Note: You should only merge tracks that are assigned to the same MIDI channel. Digital Orchestrator Plus 
does not support multiple channels in a track.

To merge two tracks:
1. Highlight the track you wish to merge.
2. Drag it over the location of the track you wish to merge it with and let go. The tracks are now merged. If 
you don't like the results, select Undo from the Edit menu.



Reverb & Chorus (MIDI Controller Controls)
Digital Orchestrator Plus provides two assignable controls for adjusting parameters assigned as MIDI 
controllers. These controls are located in the Track/View window and the Mixer window. The default 
settings are for Reverb and Chorus, however these can be changed by selecting Controller Settings in 
the Options menu.



Metronome Settings Dialog Box
The metronome settings box provides control over the sound that is played by the metronome. The 
metronome's click can be set to play through the PC speaker or to play a MIDI note through a synthesizer 
such as a drum machine. You can also set it to sound on playback, record, or both.

Click Output:
Selects MIDI, Speaker or both to play the metronome click.

Click During:
Selects when the click is heard. This can be set to play during the Count In, Playback, while Recording or 
any combination of the three. Very often you will only want to hear the metronome during the count in and 
while recording.

Count In:
This control lets you select when to hear a Count In and also allows you to select the number of bars to 
count in.

Click Note Settings:
Allows you to select the Port, Channel and Note parameters that the click will play when MIDI is selected 
as a click output. You should set the Port and Channel to correspond to the synthesizer you are using to 
create drum sounds. The Accented and Unaccented Click is typically set to trigger a percussion sound 
such as a cowbell or hi-hat. 

The duration setting also controls the PC Speaker click duration. The other parameters do not control the 
PC Speaker.



MIDI Port Setup
In order for Digital Orchestrator Plus to communicate with your MIDI hardware, you must tell it what port 
to use. A port is a way of identifying the device driver for your computers MIDI hardware. Digital 
Orchestrator Plus can use multiple ports at one time and assign any track to any port. 

For example, if you have a sound card with an FM synthesizer and a MIDI interface hooked up to an 
external keyboard, you should have a separate port driver for the FM synth and the MIDI interface. When 
you want the information from a track to be played on the FM synthesizer, you would select the FM synth 
in port column of that track. For more on MIDI ports and drivers, see your Microsoft Windows Users 
Guide.

When you install your MIDI hardware, there usually is a software setup program that comes with it. When 
installed, it sets up the drivers to allow it to work with Windows programs. These drivers can be seen by 
clicking on the Drivers icon in the Control Panel applet. When Digital Orchestrator Plus boots up, it looks 
to see what drivers are installed and offers them for selection in the MIDI Port Setup box. Very often the 
installation of your sound hardware will assign the port(s) to the Windows MIDI Mapper. In this case you 
should choose the MIDI Mapper as your output port.

To Setup a MIDI Port:

1. Be sure that your MIDI hardware and the Windows driver has been installed properly. 

2. Select MIDI Port Setup from the Options Menu. The MIDI Port dialog is displayed.

3. Choose a MIDI port for both the Input and the Output. 

4. Press OK to accept the port settings.

5. Digital Orchestrator Plus sets up all tracks to the first port by default. If you wish to change a port click 
in the port column in the Track/View screen.



Patch Map Dialog Box
Patch map setup functions as a custom patch naming tool. If you are not using the general MIDI patch 
mapping (pianos here, organs there) and wish to input your own patch names for particular patch 
numbers of sounds you have created on your keyboard, or if you have a keyboard which predates the 
general MIDI spec, you would use our patch mapper to do so.

The Patch Map Dialog Box provides a way to select a set of patch names for each channel of a selected 
device driver.    These patch names simply serve as a convenient way to identify patches on your 
synthesizer(s) and are displayed in the Patch column of the Track/View window and in the Mixer window 
Info box. There can be a separate set of patch maps for each device driver if you are using multiple ports.

Typically a device driver or port is setup for one synthesizer. In this case you may choose to setup the 
Patch Map to list the same patches for all 16 channels. The "Same" button provides an easy way to do 
this. When the Same button is enabled and you select a patch map for any channel, the rest of the 
channels fill in with the same patch map. 

Note: Digital Orchestrator Plus comes with patch maps for many popular instruments. If you don't find 
your instrument listed you can either select to view numbers (0-127 or 1-128) or you can create your own 
patch map by editing the VSEQPTCH.INI file. This file is located in your Windows directory and lists all of 
the patch maps and their patches. You can edit this file with a standard text editor such as Windows 
Notepad and type in the patch names for your instrument. For more information about the 
VSEQPTCH.INI file, read the VSEQPTCH.WRI file.



Insert Bars Dialog Box
The Insert Bars Dialog Box provides you with the necessary parameters for inserting blank bars or 
measures into a track or the entire song. 

Before Bar:
Sets the location where the bars will be inserted in the track.

Number of Bars:
Sets the number of bars to be inserted at the Before Bar location.

Track:
Sets the track to insert bars into. The "All" setting inserts the bars in all tracks.

Time Signature:
Determines the time signature of the bars to be inserted.

Numerator:
The number of beats per bar.

Denominator:
The value of the beat. (e.g. 4 = quarter note, 8 = eighth note)

Beats Per Bar:
The number of metronome clicks for each bar. This is usually the same value as the Numerator. However, 
in the case of 12/8 time, you may want to hear four metronome clicks per bar or for "cut time" (2/2) you 
would want two beats per bar.



Delete Bars Dialog Box
The Delete Bars Dialog Box provides you with the necessary parameters for deleting bars or measures 
into a track or the entire song. 

Before Bar:
Sets the starting location where the bars will be deleted in the track.

Number of Bars:
Sets the number of bars to be deleted, starting at the Before Bar location.

Track:
Sets the track to delete bars from. The "All" setting deletes the bars in all tracks.



Piano Roll Window Transcription Settings Dialog Box

The Transcription Settings dialog provides parameter settings for the "on the fly" transcription in the 
Piano Roll window. 

Bar numbering button
To display each bar number at the beginning of each measure, click this radio button on.

Split point
This value determines the split point for the bass and treble clef note placement. Notes above this value 
will be placed in the treble clef, while notes below this note will be placed in the bass clef.

Zoom percent
The zoom percent reduces the magnification by the amount entered in to this box. Can be any value from 
1% to 100% of full display. This can also be selected from the zoom pop up menu.

Clef
Selects the available Clef choices:
Treble Clef uses only the treble clef.
Bass Clef uses only the bass clef.
Grand Staff displays both treble and bass clef.
Auto automatically selects the clef depending upon the contents of the file. This is the default and is highly 
recommended for multitrack transcription.

Suppress rests
Selects the available options below:

Off turns off the rest suppression feature.
Normal allows some rests to be visible, this is a compromise between no rest suppression and full (fill) 
rest suppression.
Fill hides rests by filling notes out to the next downbeat. -- this is full rest suppression mode.

Quantize
Quantize displays the notes in the nearest quantize value. This does not effect the source MIDI file.

Triplet
Triplets On/Off- When On, displays triplets in the Piano Roll's Notation pane.



Event Edit Dialog Box
The Event Edit box displays the various MIDI data types to be edited or inserted in a track. For each data 
type, the start time, channel and parameter controls can be set or modified. When the Conductor track is 
selected in the Event Editor window, the Event Edit box displays controls for editing tempo, time 
signature, and key signature information.

 See also...
Changing Event Parameters 
Deleting Events 
Filtering Event Display 
Inserting New Events 
Patch Changes in the Event List 



Filter Events Dialog Box
The Filter Events Dialog provides a way to filter out the MIDI data to be viewed in the Event Editor. MIDI 
data types such as; Notes, Pitch Bend, and Patch Changes, can be filtered out by un-selecting them. This 
will allow you to view only the data that you wish to work with.

Note: Time Signature, Key Signature and Tempo data can only be viewed in the Conductor track.



Controllers Dialog Box
Controllers are a continuous data type such as pitch bend and modulation, as well as effects such as 
echo, reverb, etc. In Digital Orchestrator Plus you may choose any two controllers and apply them in any 
amount, together or separately, on a track by track basis. These will only work if your hardware (keyboard 
or sound card) will in fact respond to these commands. If you choose an undefined data type and apply it 
to a track, it will only work if you set up your keyboard to respond in a particular way to that controller 
number. Note that these are not real time commands and you may not record a performance of changes 
in these fields.



File Save As... Dialog Box
The File Save As... Dialog allows you to save your work to disk. There are a number of file formats that 
you can save your work in. Choose the file format from the file Type: drop down combo box before you 
save the file.

The following are the three formats available:

.MID - This is the Standard MIDI format. It's a very generic format which can be used to easily swap files 
between different programs and machines. Note however that Track/View settings such as Transpose, 
Mute, Solo etc. will not be saved in their original state. Muted tracks will be deleted. If a track is Soloed, 
all other tracks will be deleted. Any transposed tracks will be permanently modified to the new key when 
the file is saved. Lastly, tempo offset settings will be added to the actual tempos.

If you want to save your main screen settings, as is, use the ORC file format.

.ORC - This is the native format for Digital Orchestrator Plus. This format saves all the Track window 
settings exactly as it is. This format is not compatible with any other application.

.RMI - This is another, less used, standard multimedia file format. It is very similar to the standard MIDI 
format only it adds header information. 



File Open/Merge Dialog Box
The File Open Dialog Box allows you to choose a MIDI song file to load into Digital Orchestrator Plus. 

The following file formats are supported:

.ORC - Digital Orchestrator Plus native format.

.MID - Standard MIDI file.
 
.SNG - Voyetra's Sequencer Plus DOS sequencer file format.

.RMI - Riff multimedia format.

.JAM - Voyetra’s Jammin’ Keys file format.

.STR - This file format is produced by Reveal’s Music Star system. 
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Notation Zoom Menu
Displays a menu for zooming in or out on the current transcription. You can zoom in by any of the preset 
values or select X% to zoom in or out anywhere from 10% to 200%.



Piano Roll Right-click Options Menu
This menu provides options and quick access to cursor controls in the Piano Roll window.

Arrow - Selects the arrow cursor mode for selecting ranges and editing.

Pencil - Selects the pencil cursor mode for inserting notes.

Eraser - Selects the eraser cursor mode for erasing notes.

Chase Notes - When enabled, the chase notes function checks for notes that may be held over from a 
previous bar and displays them. Although this is a desirable feature, it also slows down the screen re-
draw performance.

Draw Rounded Notes - This options allows you to choose between viewing notes that are square or 
rounded at the ends. Rounded notes allow you to see when notes are overlapping on the screen, 
however, square notes slightly increase screen re-draw performance.

Next Track - Selects the next track down in the track listed Track/View window to view in the Piano Roll 
window.

Previous Track - Selects the next track up in the Track/View window to view in the Piano Roll window.



MIDI Options
The MIDI Port Options dialog offers the following settings:

Close Driver While Printing
When enabled this setting will close the MIDI device drivers when printing from the notation window. 
Enable this function when using a Voyetra VP-11 MIDI interface or other MIDI interfaces that use the 
parallel port.

Keep MIDI Drivers Open While Inactive
This feature allows MIDI thru to remain open when you change focus from Digital Orchestrator Plus to 
another application. For example, if you were running a word processor along with Digital Orchestrator 
Plus to type in lyrics to a song, and you still wanted to hear your keyboards when you were using the 
word processor.

Close MIDI In While Using WAV
Some sound boards do not allow simultaneous MIDI input and WAV output. When enabled, this feature 
temporarily disables the MIDI input while playing back your MIDI/WAV recordings.

Send Reset Controllers on Stop
This function sends a reset message to all controllers when the sequencer is stopped. 

Clock Rate
This function allows you to lower the clock rate to adjust the timing resolution. 

High Setting - More accurate note timing.
Low Setting - Provides better interface performance on slower machines.

Set the clock rate to Low when running in the Windows NT or OS/2 operating systems. You should also 
lower the clock rate if your PC is having trouble keeping up with the program.



Transforms Menu
Transform functions allow you to select a portion of your song file and, in a single operation, change the 
selected data in various ways. In general, you use a transform when you want to make a permanent 
change to your file. However, the undo feature allows you to reverse any changes you've made and try 
other settings. 

There are two types of transforms available: MIDI and Digital Audio. Most transforms require that you 
specify the particular part of the file you want to change. A few transforms by their nature can operate only 
on an entire file or track.

1, 2, 3, 4
Digital Orchestrator Plus remembers the four most recently used Transforms, including the parameters 
you have selected for each. This provides a convenient way to make the same change to several musical 
passages. Select a section of a song and choose a transform from the list.

Transforms:
Pitch
On Velocity
Off Velocity
Note Duration
Time 
MIDI 
Tempo
Digital Audio
Convert Sample Rate
Mixdown Audio 

 See also To Operate Transforms 



Set Velocity
This function sets the On Velocity for all selected notes to the same value. You can use the slider or the 
Set value box to enter the desired value, from 1 to 127.



Offset Velocity
This function allows you to increase or decrease the existing On Velocity of the notes in the range, by the 
Offset value that you choose. This can help to preserve the dynamics with which the music was originally 
played.



Quantize Duration
This function sets the duration of notes to the nearest even multiple of a selected interval. If, for example, 
you choose a quarter note as the interval, each note will be converted to a quarter note, half note, a 
whole note, etc.—whatever value is nearest to its original duration.

The Quantization Value can be an interval from a 64th note to a quarter-note in length. You can also 
select dotted notes.

Tuplet Numerator and Denominator displays the Tuplets ratio. The Tuplets ratio is defined as x notes in 
the space of y notes. For example, if you wanted to insert a quarter note triplet, you would select a 
quarter note, enable tuplets and set the Tuplets ratio to 3:2. This allows you to insert three quarter notes 
(a triplet) in the space normally taken by two quarter notes. To insert evenly spaced tuplets, set the grid to 
the same value as the tuplet you are inserting. 

You can control the Intensity of the quantization effect. For example, if you set the intensity to 75%, each 
note's duration will move only three-quarters of the way to its target.



Quantize Note Start Time
This function adjusts the start times of the selected notes so they begin only at certain points in the 
measure. For example, if you played a series of notes off the beat, you can quantize their start times, so 
they begin precisely on the beat. A variety of options permits detailed control over which notes are 
affected and the quality of the results:

Quantize Value: This is a timing interval, expressed as a musical note from a 64th note to a quarter note 
in length. It may help to imagine a grid superimposed on the measure. Notes are moved toward lines of 
the grid. The quantize value establishes the interval between grid lines.
If, for example, you select an eighth note as the interval, the beginning of each selected note will move to 
the nearest eighth note division within the measure.

Dotted: This control adjusts the start times of notes to the nearest dotted note value. This option is most 
suitable for time signatures with numerators that are divisible by three, e.g., 3/4 or 6/8. When measures 
cannot be divided evenly into dotted note intervals, the grid is re-aligned at the beginning of each 
measure.

Tuplet: Tuplet Numerator and Denominator displays the Tuplets ratio. The Tuplets ratio is defined as x 
notes in the space of y notes. For example, if you wanted to insert a quarter note triplet, you would select 
a quarter note, enable tuplets and set the Tuplets ratio to 3:2. This allows you to insert three quarter notes 
(a triplet) in the space normally taken by two quarter notes. To insert evenly spaced tuplets, set the grid to 
the same value as the tuplet you are inserting. 

Intensity: Intensity controls the degree of quantization. This guards against making your music overly 
precise and mechanical. If you set the intensity to 75%, each note will move only three-quarters of the 
way to the nearest grid point.

Swing: This can create a swing feel by moving every other grid point to an earlier or later position. 
Percentages greater than 50% move every other grid point to a later position. Less than 50% moves 
every other grid point to an earlier position. 50% yields no change. Try a setting between 55% and 66% 
as a starting point. 66% generates a jazz swing.

Sensitivity: This control allows you to quantize notes that already lie near a grid point, while leaving other 
notes unchanged. This feature could be useful, for example, if you want to clean up a passage without 
disturbing tuplets. The sensitivity zone is expressed as a percentage of the grid interval; if you set a low 
value like 2%, only notes that lie very close to a grid line will be quantized.

This feature is helpful when quantizing a track containing triplets that you wish to preserve while 
modifying the remaining notes.

Offset: The Offset control moves the entire grid forward (later) in time, allowing you to quantize notes to 
points between beat divisions. When music is played consistently before or after the beat, this can be 
very helpful. Moving the grid helps to keep a quantized track in sync with a non-quantized track.

Inside Range: When activated, this function quantizes notes that lie within the Sensitivity tolerance. In 
the example above, notes lying within 2% of a grid line would be quantized. When turned off, only notes 
lying outside the Sensitivity range are quantized, that is, the notes lying in the other 98% of the interval.

Preserve Duration: When selected, this function moves both the start and end points of the note by the 
same amount, thus preserving the note's total duration. When turned off, it moves only the start time of 
the note, which lengthens or shortens its duration.



Loop
You can loop a selected portion of your file. When a file or part of a file is looped, it plays repeatedly until 
you click on the Stop button. You can select a range of measures and loop all of the tracks in that range.

 See also: Looping 



Looping
You can loop a selected portion of your file. When a file or part of a file is looped, it plays repeatedly until 
you click on the Stop button. You can select a range of measures and loop all of the tracks in that range.

To loop a selected portion of the file:

1. In any window, select the portion of the file that you wish to loop.

2. Control-click on the From and Thru indicators. The start time and end time of the range you selected 
will be entered automatically.

3. Click the Loop Range button. The selected range will play repeatedly until you click the stop button.

You can also loop individual tracks, allowing the other tracks to play in the normal fashion. 

To loop individual tracks:

1. Click in the L column for any tracks that you wish to loop. A letter L appears to indicate that the track is 
selected for looping.

2. Click on the play button. Tracks selected for looping will play repeatedly until you press the Stop button. 
All other tracks will play in the normal fashion, i.e., they will play once, then stop.



Temp Space Indicator
Tells you how many bytes are available for digital audio recording. Only the space available to the Temp 
directory (specified in the Digital Audio Options window) is shown. Capacity that may be available to other 
drives or directories is not reflected in this display.



Track Type
Allows you to assign a track to MIDI or Digital Audio. An icon appears in the box to indicate which type of 
data the track is using. With repeated clicks, the icon cycles through, MIDI, digital audio, and blank 
(none).



Controller A Column
Real Time MIDI controller. This can be changed in the Option Menu.

 See Also:Controllers 



Controller B Column
Real Time MIDI controller. This can be changed in the Option Menu.

 See Also:Controllers 



Loop Column
You can loop a selected portion of your file. When a file or part of a file is looped, it plays repeatedly until 
you click on the Stop button.

Note: Only an entire track can be looped this way. If you want to loop just a portion of a track you have to 
use the loop range feature.

 See also Looping 



Transpose Mode
When you transpose a MIDI track, you now have the option to do so diatonically, which preserves the 
original key signature.

To enable diatonic transposition:

Click the D column for any track you wish to transpose diatonically.

Use the transpose box in the normal fashion to offset the pitches of notes by octave: semitone.



Track Off Velocity
This field enables you to increase or decrease the Note-On Velocities of all notes in the track. The 
resulting velocity values cannot go above 127 or below 1, but keep in mind that very low velocities can 
make a note inaudible.

The effect of velocity offset is temporary unless you save the file. If you save a file in .ORC format, the 
original note velocities are preserved, and any velocity offsets are saved independently. If you save your 
file in Standard MIDI (.MID) format, the original velocities and their offsets are combined, and the resulting 
velocities are saved.

 See also: Change Velocities 



High Bank Select Column
The MIDI standard supports up to 16384 "banks" of 128 patches (sounds) each. Some (not all) keyboards 
and sound cards will respond to "bank select" messages which allow you to access different sets of 
patches stored in their memory. If your keyboard or sound card supports this feature, the main screen of 
Digital Orchestrator Plus has two fields labeled MSB (most significant bit) and LSB (least significant bit) 
which allow you to send your device such messages. See your keyboard or sound card manual to find out 
which numbers to put in the MSB/LSB columns in order to access the bank of patches you want. If there 
is a patch map for available for your MIDI device, you can simply setup the proper patch map and use the 
Patch Select Dialog to automatically set the proper patch and bank simultaneously. You can also create 
your own patch maps. (See the    VSeqIni icon in your Digital Orchestrator Plus group.)



Low Bank Select Column
The MIDI standard supports up to 16384 "banks" of 128 patches (sounds) each. Some (not all) keyboards 
and sound cards will respond to "bank select" messages which allow you to access different sets of 
patches stored in their memory. If your keyboard or sound card supports this feature, the main screen of 
Digital Orchestrator Plus has two fields labeled BKMSB (most significant bit) and BKLSB (least significant 
bit) which allow you to send your device such messages. See your keyboard or sound card manual to find 
out which numbers to put in the BKMSB/BKLSB columns in order to access the bank of patches you 
want. If there is a patch map for available for your MIDI device, you can simply setup the proper patch 
map and use the Patch Select Dialog to automatically set the proper patch and bank simultaneously. You 
can also create your own patch maps. (See VSeqIni icon in your Digital Orchestrator Plus group.)



Change Velocities
The effect of velocity offset is temporary unless you save the file. If you save a file in .ORC format, the 
original note velocities are preserved, and any velocity offsets are saved independently. If you save your 
file in Standard MIDI (.MID) format, the original velocities and their offsets are combined, and the resulting 
velocities are saved.

To temporarily change velocities:

1. To increase velocities, click on the upper half of the Velocity offset box.

2. To decrease velocities, click on the lower half of the Velocity offset box.

3. You can adjust velocities freely as the file is playing.



Multitrack Recording
Multitrack Recording

You can record more than one MIDI channel and direct each channel of incoming data onto a separate 
track. This is useful for synthesizers with splittable keyboards and for guitar synths that output to multiple 
channels.

To record several MIDI channels simultaneously:

1. Click in the Record column for the first track you wish to record. A letter R will appear, to indicating that 
track is selected for recording.

2. Hold the control key as you click in the record columns of any additional tracks that you wish to record.

3. Select the channel, patch number and other parameters as desired for each track. If you do not know 
which channels your synth is using, leave the channel assignment blank and MIDI Digital Orchestrator 
Plus will automatically assign a channel for you.

4. Record in the normal fashion.



Transcribe Musical Notation
To transcribe musical notation:

1. If you plan to print your score, use the Windows Control panel to verify that your printer is connected 
and that the page size and paper orientation are set properly. See your Windows user guide if you need 
help with this.

2. In the Notation Window, click on the Transcribe button.

3. Click in the Transcribe Select column of each track you wish to transcribe. Red check marks indicate 
which tracks will be transcribed. You must select at least one track containing MIDI note data.

4. Set the transcription settings as desired:

5. After you have chosen the options you wish, click on the OK button. After a brief pause, a score should 
appear on in the Notation Window.

6. Check the score on the screen. You may want to make adjustments or corrections before printing:

To change any of the transcription settings, click on the Transcribe… button and adjust the settings as 
described above.

You can also edit the MIDI data. After you have completed your editing, return to the Notation screen and 
click the Refresh button to see the updated score.

7. When you are satisfied with the score, click the Print button.

 See Also: Transcription Settings 



Current Track
Display the number of the current track.



Zoom Percentage
Displays a menu for zooming in and out.

 See Also: Zooming And Expanding In Digital Audio 



Zooming And Expanding In Digital Audio
The digital audio window allows you to zoom in close or zoom way out.

The zoom button  pops down a menu which allows you to select from the following zoom options.

Range - Allows you to zoom in on a selected range, allowing you to zoom in as close as one note or on a 
larger group of notes. Simply highlight the range you wish to zoom in on and select Range from the zoom 
menu.

User - Sets the digital audio window to the current user setting. The User setting is defined with the Save 
User command. 

Default - Sets the digital audio window to the default setting.

Max Out - Zooms the digital audio screen out to display the maximum amount of data the screen can 
support.

Save User - Saves the current window as the User setting. To save a setting; highlight a range and select 
Save User. From that point on, to recall this setting select User from the zoom menu.



Snap On/Off
The Grid button, turns the cursor snap feature on and off. During drag and drop editing, with the Grid set 
to “On,” the cursor will snap to the nearest grid value when you select a range. This is particularly useful 
for making precise rhythm edits.

The resolution of the editing grid is determined by the type of note chosen in the control to the right of the 
Grid button. By clicking on the control, you can choose quarter-notes, eighth notes and so on.



Snap Value
The Grid resolution is determined by the type of note chosen in this button. By clicking on this button, you 
can choose quarter-notes, eighth notes and so on. 

If, for example, quarter-notes are chosen, and the time signature is set to 4/4, then the grid will divide 
each measure into four sections.

If the time signature is set to 3/4 time then the grid will divide each measure into three sections.



Cursor Position In Bar: Beat: Click
This displays the current cursor position in bars, beats and clicks.



Cursor Position In Minutes: Seconds: Frames: Hundredths
This displays the current cursor position in Minutes: Seconds: Frames: Hundredths



Digital Audio Window
The digital audio window provides a close-up view of a digital audio waveform, to allow precise editing.

To open a digital audio window:

Place your mouse cursor anywhere in the track you wish to display.

Click the waveform Quick View Button at the bottom of the screen. 

Shortcut: Double-click any waveform. The digital audio window will appear, displaying the track you 
selected.

Click on any screen area or control to learn about its function.

 See also: Digital Audio Window Procedures 



Digital Audio Window Procedures
Recording Digital Audio 
Editing Digital Audio 
Merging Digital Audio Tracks 
To_Convert_A_Sample_Rate 
The Recording Process: Tips & Techniques 



Digital Audio Data
This waveform of the digital audio is displayed here.



SysEx Window
Most modern synthesizers are capable of generating and transmitting a special class of MIDI messages 
called system exclusive, or SysEx, messages. Among other things, these messages contain information 
about patch settings, MIDI configuration parameters and special effects settings like reverb or delay. 
Digital Orchestrator Plus allows you to upload these messages from your synthesizer, save the data as 
files and, finally, send the messages back to your synthesizer so that they will be available to the synth 
the next time your song plays. In this way, your MIDI output device can recreate all the settings you 
originally created for the piece.

Although most users will never need to access the SysEx window's messaging functions, they can be 
extremely useful when:

Composers who know how to edit the patches in their synthesizers want to create custom sounds for a 
particular song. If these patches are saved in system exclusive messages along with the song, they will 
be available the next time the song is played. 

Synthesizers use configuration data that can only be changed through SysEx messaging. For example, 
the effects section of some synthesizers is programmable only with system exclusive data.

Older synthesizers send real time control information as system exclusive messages. Some older 
synthesizers also use system exclusive messages to switch banks of programs.

Note that not all synthesizers use SysEx, so be sure to consult your hardware documentation before 
accessing these functions.

 See Also: SysEx Procedures 



SysEx Edit
Opens a dialog box in which you can edit SysEx data directly. To do this you must know Hex notation and 
the specific commands for your synthesizer. A maximum of 10k of data can be edited in the Edit SysEx 
Data dialog box.

 See Also: Editing SysEx Data 



SysEx Save
Opens the Save dialog box which allows you to name and save SysEx data to a file.

 See Also: Saving SysEx Data To Disk 



SysEx Send
Sends the data in the SysEx window to your synthesizer.

 See Also: Sending SysEx Data From The Middle Of A Song 



SysEx Receive
Brings SysEx data transmitted by your synthesizer into the SysEx window.

 See Also: Receiving SysEx Data 



SysEx Delete
Removes the selected SysEx Data file from the window. This does not delete the file from your hard drive.



Length 
Length is the number of bytes stored in the bank. This field is for reference only and cannot be edited.



Automatically Send Bank
If the auto box is checked, the bank will be sent automatically when the file is read in



To Merge Files
1. Open the file containing the conductor track settings you wish to keep.

2. From the File menu, select Merge.

3. In the Merge Dialog box, select the MIDI, Digital Audio or .ORC file that you wish to insert into the 
current file, and click OK. The file you select will merge into the existing file, beginning with the first 
available unused track.

Tip: If you want to append the new file to the end of the current file, simply select and drag the new data 
to the end of the current song.



To Export A .WAV File
1. Please note that several settings such as mute, solo, pan and volume will effect the resulting wave file.

2. Play the file and correct settings if necessary. The digital audio sound you hear will be the basis for the 
new file you are about to create.

3. From the File menu, select Export WAVE.

4. In the Save As dialog box, choose a directory and filename for your new file, then click OK.

Tip: If you would like to include MIDI files in the exported mixdown, first record them as digital tracks in 
Digital Orchestrator Plus. To accomplish this, set your synth so that you can record MIDI tracks using the 
line in on your sound board.

When you merge the exported .WAV file into a different .ORC file, it may seem that the size of the .WAV 
file has changed. In fact, the .WAV file has remained constant, the .ORC file is longer or shorter because 
it has different tempo and/or time signature settings. To restore the .WAV file to its former apparent length, 
adjust the tempo and time signature to match those of the .ORC file from which the .WAV file was 
exported.



Pitch
Transpose
Transpose allows you to move all the selected notes up or down in pitch. Enter the desired pitch change 
in the form of octaves:semitones. To lower pitches, activate the Transpose by Negative Value button.

Diatonically Transpose
Diatonic Transpose is a special type of pitch transposition which transposes the pitch of the notes but 
maintains the key during the change.

Invert
The Invert function moves the selected notes to the same relative position on the opposite side of the Axis 
note. For example, if the axis note is C5 (Middle C), F5 (which is 5 semitones above C5) would move to a 
position five semitones below C5, to G4.

Diatonically Invert
This function has the same effect as Invert, but maintains the key during the change.

Randomize
The Randomize function scatters the pitches of notes on a random basis. The higher the amount you 
specify, the more widely the pitches scatter.



On Velocity
On Velocity is a measure of how abruptly a key was struck when the note was played. Values can range 
from 1 (a very gentle touch) to the maximum of 127 (a very quick, staccato hit). At playback, the On 
Velocity usually controls the loudness of a note. Depending on your synthesizer, it may also affect 
brightness or other musical qualities.

Some synthesizers cannot record velocity, and simply assign the same velocity value to every note. Also, 
a synthesizer may or may not respond to velocity messages during playback. Refer to your synthesizer's 
documentation to find out how it implements velocity messages.

If the on velocity is zero, the note won't play at all. For this reason, all of the transforms limit the resulting 
on velocities to a range from 1 to 127. At very low velocities, notes may be nearly or completely inaudible.

Set Velocity
Sets the on velocities of all selected notes to the same value. You can use the slider or the Set value box 
to enter the desired value, from 1 to 127.

Offset Velocity
Allows you to increase or decrease the existing on velocities of the notes in the range by the Offset value 
that you choose. This can help to preserve the dynamics with which the music was originally played.

Scale
Increases or decreases existing on velocities by a percentage that you provide.

Humanize
Makes random adjustments to the on velocities of the selected notes, making the passage more natural-
sounding. Higher values in the Amount box allow a wider range of change.

All of the Humanize transforms favor smaller changes over larger ones. Most of the MIDI notes will 
receive small changes, while relatively few get large changes.

Crescendo
Sets the velocity of the first note in the range to the Start value that you enter, sets the last note to the 
End value, and successively increases or decreases the velocities of the notes in between.



Off Velocity
Off Velocity is similar to On Velocity, except it measures how abruptly the key was released. Values can 
range from 0 to 127.

Set
Sets the off velocities of all selected notes to the same value.

Offset
Allows you to increase or decrease the existing off velocities of the notes in the range by the Offset value 
that you provide.

Scale
Increases or decreases existing off velocities by a percentage that you provide.

Humanize
Humanize makes random adjustments to the Off velocities of the selected notes. Higher values in the 
Amount box allow a wider range of change.



Note Duration
The duration of any note is expressed in bars, beats and clicks. A click is a fraction of a quarter note; the 
default is 1/480th. The actual time interval of a note will depend on the song's current meter and the 
tempo.

Set: This function sets the duration of all selected notes to the same value. To quickly choose a value, 
select a note, then use the parameter boxes to make more precise adjustments if you wish. Select the 
Dotted button to choose a value one and a half times the value of the note displayed.

You can also activate the Tuplets button, which creates non-standard note durations. For example, if you 
choose Tuplets and set the spin boxes to 3 and 2, three notes will be forced into the time normally 
occupied by two to calculate the duration.

Offset: Spin buttons allow you to increase or decrease the duration of selected notes by an Offset value 
that you provide.

Scale: This increases or decreases the existing duration of a note by a selected percentage factor.

Humanize: This feature makes random adjustments to the duration of selected notes. Higher values in 
the Amount box allow a wider range of change.

Quantize Note Duration: This function sets the duration of notes to the nearest even multiple of a 
selected interval. If, for example, you choose a quarter note as the interval, each note will be converted to 
a quarter note, half note, a whole note, etc., —whatever value is nearest to its original duration.

The Quantization Value can be an interval from a 64th note to a quarter-note in length. You can also 
select dotted notes.

The Tuplets button calculates non-standard note durations. For example, if you set the spin boxes to 3 
and 2, three notes will be forced into the time normally occupied by two to calculate the duration.

You can control the Intensity of the quantization effect. For example, if you set the intensity to 75%, each 
note's duration will move only three-quarters of the way to its target.



Start Time
Start Time transforms affect the rhythm of a song by changing the start times of notes. The start time of a 
MIDI note is the moment when it commences, in bars:beats:clicks. Decreasing the start time value of a 
note makes it occur earlier in the song; increasing the start time makes it occur later. 

The Start Time transforms can help you clean up rough musical passages or create clean, consistent 
drum tracks. You can also use them to intentionally make your music less precise and more natural 
sounding.

Offset Start Time: Shifts the start times of all notes backward or forward in time. This transform lets you 
selectively change non-note MIDI data as well.

When the Offset Start time dialog box appears, click on the buttons to choose which types of events you 
want to change: Pitch Bend, Channel Aftertouch, Key Aftertouch, Patch Changes, Notes and any data set 
by the Controllers. You can choose a single controller or all controller messages at once from the drop-
down list. Choose Earlier or Later, and select an interval in bars:beats:clicks.

By default, all of the event types are selected when you first run Digital Orchestrator Plus. Once you 
deselect an event type, your changes will be retained until you change them again.

Humanize Note Start Time: This adds a series of random time offsets to the selected notes, making the 
passage more natural-sounding. Higher settings in the Amount box permit larger shifts in time. This is a 
great transform to use when you want to make MIDI sounds you've entered note by note in Piano Roll 
sound more natural.

Quantize Note Start Time: This function adjusts the start times of the selected notes so they begin only 
at certain points in the measure. For example, if you played a series of notes off the beat, you can 
quantize their start times, so they begin precisely on the beat. A variety of options permits detailed control 
over which notes are affected and the quality of the results.

Quantize Value: This is a timing interval, expressed as a musical note from a 64th note to a quarter note 
in length. It may help to imagine a grid superimposed on the measure. Notes are moved toward lines of 
the grid. The quantize value establishes the interval between grid lines.
If, for example, you select an eighth note as the interval, the beginning of each selected note will move to 
the nearest eighth note division within the measure.

Dotted: This control adjusts the start times of notes to the nearest dotted note value. This option is most 
suitable for time signatures with numerators that are divisible by three, e.g., 3/4 or 6/8. When measures 
cannot be divided evenly into dotted note intervals, the grid is re-aligned at the beginning of each 
measure.

Tuplet: Tuplet Numerator and Denominator displays the Tuplets ratio. The Tuplets ratio is defined as x 
notes in the space of y notes. For example, if you wanted to insert a quarter note triplet, you would select 
a quarter note, enable tuplets and set the Tuplets ratio to 3:2. This allows you to insert three quarter notes 
(a triplet) in the space normally taken by two quarter notes. To insert evenly spaced tuplets, set the grid to 
the same value as the tuplet you are inserting. 

Intensity: Intensity controls the degree of quantization. This guards against making your music overly 
precise and mechanical. If you set the intensity to 75%, each note will move only three-quarters of the 
way to the nearest grid point.

Swing: This can create a swing feel by moving every other grid point to an earlier or later position. 
Percentages greater than 50% move every other grid point to a later position. Less than 50% moves 
every other grid point to an earlier position. 50% yields no change. Try a setting between 55% and 66% 
as a starting point. 66% generates a jazz swing.



Sensitivity: This control allows you to quantize notes that already lie near a grid point, while leaving other 
notes unchanged. This feature could be useful, for example, if you want to clean up a passage without 
disturbing tuplets. The sensitivity zone is expressed as a percentage of the grid interval; if you set a low 
value like 2%, only notes that lie very close to a grid line will be quantized.

This feature is helpful when quantizing a track containing triplets that you wish to preserve while 
modifying the remaining notes.

Offset: The Offset control moves the entire grid forward (later) in time, allowing you to quantize notes to 
points between beat divisions. When music is played consistently before or after the beat, this can be 
very helpful. Moving the grid helps to keep a quantized track in sync with a non-quantized track.

Inside Range: When activated, this function quantizes notes that lie within the Sensitivity tolerance. In 
the example above, notes lying within 2% of a grid line would be quantized. When turned off, only notes 
lying outside the Sensitivity range are quantized, that is, the notes lying in the other 98% of the interval.

Preserve Duration: When selected, this function moves both the start and end points of the note by the 
same amount, thus preserving the note's total duration. When turned off, it moves only the start time of 
the note, which lengthens or shortens its duration.



MIDI Transforms
MIDI transforms act upon non-note MIDI events such as patch changes or pitch bends. Using MIDI 
transforms requires an extra step. You must select a range of data as before. Then, within that range, you 
must filter the events —you must specify which kinds of MIDI messages you wish to change, and which to 
leave unchanged. Dialog boxes appear when necessary to help you make these choices.

Offset: MIDI offset changes the values of selected MIDI events by the interval you select. You can set the 
values independently for each type of event.

Scale: MIDI scale changes the values of the selected non-note MIDI events by a factor that you select. 
You can increase or decrease values independently for each type of event. Use the Event Edit window to 
select a range, then apply this transform. 

Although non-note events do not appear in Piano Roll view, you can edit them by clicking the Notes/All 
button at the upper left corner of the Piano Roll editing screen. With the word “All” displayed, the non-note 
editing choices shown in the Scale dialog box become active. 

Invert: This transform inverts MIDI values, using the midpoint of the allowed range as an axis. Most MIDI 
messages assign a value from 0 to 127; the midpoint of that range lies midway between 63 and 64. The 
invert transform moves the value to the opposite side of the midpoint. For example, the value 127 would 
become 0, 0 would become 127. 64 becomes 63; 84 becomes 43.

Humanize: Humanize adjusts the values of selected non-note MIDI events on a random basis, making 
the passage more natural-sounding. You can control the degree of allowable change independently for 
each type of event.

Eliminate Dupes: In a series of MIDI events of the same type, with the same value, only the first in the 
series will actually have any effect. This transform finds and eliminates redundant MIDI events of the type 
you select.

Thin: This function reduces the density of the selected classes of MIDI events. Some editing operations 
can generate dozens or even hundreds of MIDI events, each creating a change too small to detect. You 
can often achieve the same musical result with fewer, larger changes. Thinning unnecessary messages 
results in a smaller file, and reduces the burden on the synthesizer.

There are two ways to control the degree of thinning. You may use either one alone, or use both together:

Within Click: Eliminates all messages of the same type that lie within a certain proximity to one another. 
The maximum value allowed is 480 clicks, one full quarter note.

For example, if a pitch bend message occurs at 5:2:270, and you've set the Within Click value to 20, all 
pitch bend messages within the next 20 clicks are removed. The next pitch bend message would occur at 
least 20 clicks away, at 5:2:290 or beyond.

To explain it another way, if you set the Within Click value to 240, you would limit the density of the 
messages to two per quarter note since a quarter note is typically 480 clicks.

Within Value: Eliminates messages that trigger only relatively small changes. Consider a Within Value 
setting of 10 as an example: If a particular key aftertouch message sets a value of 27, the next key 
aftertouch message must increase that value by at least 10 —to 37 or more, or reduce it to 17 or less. 
Any change smaller than 10 is eliminated.

Fill: This transform will fill in, or add, controller, channel aftertouch, key aftertouch, and pitch bend MIDI 
events. (Your hardware may or may not support these controller events. Refer to your hardware manual 
for further information.) 



Input parameters are starting and ending values, curvature, and minimum clicks between. Curvature may 
range from -10 to +10. 

Curvature describes the type of change. A value of zero is linear change, which means you get a steady 
rate of change. Positive ten yields more change more quickly, the later in the range you are. This value is 
the most commonly used for all events except pitch. A negative value yields more change in the 
beginning and less change the later in the range you are. This value is particularly effective on pitch 
change data.



Digital Audio Transforms
Once you have selected a segment of digital audio data for editing in the Track/View or Digital Audio 
window, you can access the Digital Audio transform functions from the Transforms menu. These 
transforms allow you to fine-tune changes to the amplitude of a waveform and to introduce and control 
various delay effects. 

To apply any of these transforms, first select a portion of the waveform with the mouse. Then select the 
desired transform from the Digital Audio flyout in the Transforms menu. The following transforms are 
available:

Scale: Digital Audio scaling increases or decreases amplitude by adding or removing a percentage of the 
original amplitude. Scale is very useful for balancing volumes when cutting and pasting between different 
files.

You can add a maximum of 500% to the original amplitude, that is, you can increase it six times. If you 
select a percentage of minus 100%, you subtract all of the original amplitude, resulting in silence.

Suggest: When you click Suggest, Digital Orchestrator Plus calculates and applies a “normalized” value 
for scaling the amplitude of your file. The effect is the same as selecting the Normalize transform 
explained below.

Normalize: Normalize increases the amplitude of a selected segment of a digital audio file to the 
maximum possible level without chopping off, or “clipping” the peaks of the signal.

Crescendo: This transform increases or decreases amplitudes gradually over the selected range. Using 
this transform always produces amplitudes less than or equal to the original values. This is useful for 
creating fade-ins and fade-outs.

Reverse: This function causes the selected range to play backwards. Useful primarily as a special effect. 

Gate/Compress
This transform affects the volume or dynamics of a digital recording and operates in three distinct modes: 
Gate, Limiter and Compressor. In each of these modes the same controls will have different effects on the 
sound.

Delay 
This transform implements an effect that is usually created with a outboard effects signal processor called 
a digital delay. By adjusting the parameters correctly, a wide variety of effects are obtainable. Some of 
these effects have names like echo, chorus, slapback, doubling, reverb, resonance.

DC Offset
Moves the range up or down by an amount you select. There is no audible effect. You can use DC Offset 
to: correct off-centered Digital Audio.



Convert Sample Rate

Changes the current sample rate of digital audio. This is particularly useful if you are performing Multitrack 
recording and your computer seems to be bogging down or you encounter otherwise inexplicable errors 
in recording and playback.

File size and hard disk space is another consideration in choosing a sample rate. For a fuller 
discussion of performance and hard drive storage issues, see Tuning Digital Audio Performance.

Another use for the Converting Sample Rate function is simply to produce files compatible with sound 
cards that cannot support the higher sample rates. This may be necessary if you want to play files on 
lower end sound cards.

Note that converting sample rates can result in some loss of fidelity, particularly when you change from a 
lower to a higher rate.



SysEx Load
Opens the standard Windows File Open dialog box which allows you to bring one or more data files into 
the SysEx window.



Recording Digital Audio 

Before you begin: 
Your sound card must be set up correctly to record and play digital audio before you begin. To insure that 
everything is working correctly, it's important to make a test recording using the software that came with 
your sound card, or the Windows Sound Recorder. 

Most sound cards come with a mixer application that allows you to set the volumes for MIDI and .WAV 
playback and recording. Setting mixer levels correctly is critical in creating recordings on the PC because 
the overall volume of the sound card, as well as the recording input levels, is set in this mixer application, 
not in Digital Orchestrator Plus. 

 See Also: Making A Test Recording

Note: All digital audio is recorded at 16 bit mono.

To prepare for digital audio recording:

1. From the Options menu, select Digital Audio Options.

2. Confirm that the settings are appropriate for your sound card. If in doubt:

Disable Stereo Playback 

Disable Device Can Play and Record Simultaneously

Choose a value from the Default Sample Rate list.

3. Confirm that the Temp Directory shown is a valid one with enough storage space available. (20 
megabytes is a reasonable minimum.)

4. Connect a microphone or other audio source to the appropriate input on the sound card. If you plan to 
record from a CD-ROM drive, CD Player, or tape deck, cue up the material as needed.

5. Open the mixer application provided with the sound card and select an input source. (It's usually 
labeled “Line” or “Mic.”

Making a recording
To make digital recordings you must switch to the Track/View window and choose a track to record digital 
audio. MIDI parameters such as Patch, Channel, Transpose, Pan, reverb, Chorus and Velocity Offset, etc. 
are grayed out for any tracks assigned to digital audio.

Tip: Certain editing operations destroy the synchronization between MIDI and digital audio. For example, 
MIDI data can respond to tempo changes or transposition, but digital audio data cannot. Whenever 
possible, arrange the MIDI data to your satisfaction before you record digital audio
.
We suggest that you begin with a test recording or two to check the volume level.

To record digital audio:

1. Switch to the Track/View Window.



2. Select an empty track, place the mouse pointer in that track's Type column (far left) and click. Each 
successive click, changes the icon. Click until the digital audio icon is displayed. 

3. Click in the R column. A letter R will appear to indicate that recording is enabled for that track.

4. In the Transport Controls, click the Record button. The red indicator blinks to indicate that Digital 
Orchestrator Plus is in record standby mode.

5. To begin recording, click on the Play button. Speak into the microphone or play the material you 
prepared earlier. If this is your first recording, we suggest that you just make a brief test.

6. When you have completed the recording, click the Stop button.

Digital Orchestrator Plus will draw a waveform of the sounds you have recorded. Click on the play button 
to hear the result. You may wish to adjust the volume before you proceed.

To record from a stereo source:
In the Track/View window, choose two tracks for recording and click in the Type column to set each to 
Digital Audio. A waveform icon appears in the box.

Click in the R column to enable recording for one of the tracks. Hold down Ctrl and click the R column for 
the second track. Now both tracks are ready to record digital audio.

Connect a stereo source to the line input of your sound card. If you have a stereo microphone input, 
connect the stereo microphone. Check your sound card's documentation to determine if a stereo 
microphone or line input is provided.

Record your selection or “miked” input as in the procedure above.

To adjust the recording volume.
Remember that Digital Orchestrator Plus' level controls only affect playback. All recording levels must be 
set in the mixer. Use the digital audio volume control from the mixer supplied with your sound card to set 
the recording levels. If you are uncertain about this, consult the instructions provided with your sound card 
or mixer application.

To record additional material on a track:
1. Position the cursor at the end of the waveform or at any position within it

2. Begin recording. The new material will be added, beginning at the insertion point, overwriting previously 
recorded material.

To remove the new recording, choose Undo from the Edit menu.

 See Also: Digital Audio Performance
  The Recording Process: Tips & Techniques 



Editing Digital Audio
Digital Orchestrator Plus offers several ways to edit your digital audio tracks. For example, you can cut, 
copy and paste digital audio data in much the same way you edit text. 

When you paste data, Digital Orchestrator Plus places a reference to the data rather than the data itself 
into the file. If you're repeating a single selection like a drum part throughout your piece, this will keep file 
size to a minimum and boost performance. Whenever possible, use the Copy and Paste commands 
rather than transforming or merging a section.

Selecting Data for Editing
All digital editing operations begin the same way; you must select the section or range of the track that 
you wish to edit. If you've ever used a word processor, this concept will be familiar to you. The selected 
range appears in reverse video.

To select digital audio data for editing: 
1. In the Track/View window, click and drag the mouse across the portion of the wave you wish to edit. 

2. For a more detailed view of the selected range, double-click on the waveform or click the Digital Audio 
Quick View Button at the bottom of the screen The Digital Audio editing window will appear, and the 
selected range will fill the display.

You may want to listen to the range that you've selected before you continue editing: 

To audition the selected range:
1. Select a range with the mouse.

2. Hold down the Control key as you click on the From and Thru indicators (located on either side of the 
Play Range button). The indicators will be updated to display the start time and end time of the selected 
range.

3. Click on the Play Range button.

The quickest way to move the data is simply to drag it with the mouse:

To move digital data with the mouse:
1. Select a range with the mouse.

2. Place the cursor anywhere in the range. The cursor icon will change into a digital waveform with a 
double arrow.

3. Drag the data to the new location.

4. An interval of silence replaces the data that you drag. If you wish to leave a copy of the data behind, 
hold the control key down as you drag.

5. Release the mouse button. The data is pasted into the new location, beginning at the cursor position, 
and merging with any existing data.

If, instead of merging data, you wish to overwrite the existing data, you must place some data in the 
Clipboard, then Paste it in the new location. The necessary commands —Cut, Copy and Paste—are in 
the Edit menu.

To place digital audio data in the Clipboard:
1. Select the range of the file that you wish to remove.



2. Choose Cut from the Edit menu. The selected range is deleted from the file and copied to the 
clipboard. An interval of silence of equal duration replaces the deleted data.

3. If you wish to leave the original data undisturbed, choose Copy instead of Cut.

Pasting Data in a New Location

To paste the contents of the Clipboard into a file:
1. Use the Cut or Copy command to place the desired data in the Clipboard.

2. Select a range beginning at the point where you wish to place the contents of the Clipboard. The Paste 
command always inserts the Clipboard data at the Start point of the range you select. (The rest of the 
selected range will be ignored.)

3. Choose Paste from the Edit menu. The contents of the Clipboard will replace any existing data, 
beginning at the cursor position.

 Note: Some sound cards cause DC offset after cutting and pasting. This can be easily fixed by running 
the DC offset transform.



Quick View Button - Track/View
This button jumps to the track/view window.



Quick View Button - Notation
This button jumps to the notation window.



Quick View Button - Piano Roll
This button jumps to the Piano Roll window.



Quick View Button - Mixer
This button jumps to the mixer window



Quick View Button - Notepad
This button jumps to the Notepad window.



Quick View Button - Event Editor
This button jumps to the Event Editor window.



Quick View Button - Conductor
This button jumps to the conductor editor window.



Quick View Button - SysEx
This button jumps to the SysEx window.



Quick View Button - Digital Audio
This button jumps to the digital audio window.



Conductor Editor Window
The conductor editor window allows quick editing of the conductor track. This window looks and operates 
just like the event editor window.

The Conductor track is Digital Orchestrator Plus' way of organizing Tempo, Meter, and Key signature. You 
treat these events as you would any other events. This is also where you would create a tempo map by 
inserting tempo events with the desired tempo values at the desired locations.

Tempo Events
Tempo can be inserted as an event anywhere in the event list. Open the Insert dialog box and choose 
tempo. Insert the tempo changes as needed with values in beats per minute. 

Meter Events
Meter, or Time Signature allows you to select the number of beats 
per measure.

Key Signature Events
Key Signature allows you to select the key in which the song file is displayed in the Notation view. Multiple 
key changes are possible.

 See also...
Event Editor
Inserting New Events 
Filtering Event Display 



Parameters
Displays the current settings.



Position
Displays the position of the event.



Scale Velocity
The Scale function increases or decreases existing on velocities by a percentage that you provide.



Humanize Velocity
The Humanize function makes random adjustments to the On Velocity of the selected notes, making the 
passage more natural-sounding. Higher values in the Amount box allow a wider range of change.



On Velocity Crescendo 
Crescendo sets the velocity of the first note in the range to the Start value that you enter, sets the last 
note to the End value, and successively increases or decreases the velocities of the notes in between. 
The Keep relative option preserves the dynamics during a crescendo transform.



Set Note Off Velocity
The value you assign in Set Note Off Velocity sets the Off Velocity of all selected notes.



Offset Note Off Velocity
The Offset function allows you to increase or decrease the existing Off velocities of the notes in the range 
by the Offset value that you provide.



# $ K + Scale Note Off Velocity
This dialog box lets you increase or decrease existing Off Velocity by a percentage of the current note-off 
velocity.



Humanize Note Off Velocity
This function makes random adjustments to the Off Velocity of the selected notes. Higher values in the 
Amount box allow a wider range of change.



Transpose Pitch
The Transpose feature allows you to move all the selected notes up or down in pitch. Choose Up or Down 
in the Transpose Pitch dialog box to raise or lower the pitch, then enter the desired change in 
octaves:semitones.



Diatonically Transpose Pitch
Diatonic Transpose is a special type of pitch transposition that transposes the pitch of the notes but 
maintains the current key during the change.



Invert Pitch
Invert Pitch allows you to move selected notes to the same relative position on the opposite side of an 
Axis note. For example, if the axis note is C5 (Middle C), F5 (which is five semitones above C5) would 
move to a position five semitones below C5, to G4. You can set the value of the Axis note using the spin 
buttons or the computer keyboard.



Randomize Pitch
Randomize Pitch scatters the pitches of notes on a random basis. The higher the amount you specify in 
the dialog, the more widely the pitches scatter. Using the slider, you can quickly make large changes in 
the number.



Set Note Duration
This function sets the duration of all selected notes to the same value. To quickly choose a value, select a 
note, then use the parameter boxes to make more precise adjustments if you wish. Select the Dotted 
button to choose a value one and a half times the value of the note displayed.

You can also activate the Tuplets button, which creates non-standard note durations. For example, if you 
choose Tuplets and set the spin boxes to 3 and 2, three notes will be forced into the time normally 
occupied by two to calculate the duration.



Offset Note Duration
The duration of any note is expressed in Bar:Beat:Click. A click is a fraction of a quarter note; the default 
is 1/480th. The actual time interval of a note will depend on the song’s current meter and the tempo.

Transforming the duration of a group of notes can be used to simulate different types of musical 
articulation, drawing out a violin sound, for example, to produce a legato effect. Note duration transforms 
can also be used to tighten up a recording where notes hang too long or are cut off too quickly.

Offset Note Duration’s spin buttons allow you to increase or decrease the duration of selected notes by 
an Offset value that you provide.



Scale Note Duration
The duration of any note is expressed in Bar:Beat:Click. A click is a fraction of a quarter note; the default 
is 1/480th. The actual time interval of a note will depend on the song’s current meter and the tempo.

Transforming the duration of a group of notes can be used to simulate different types of musical 
articulation, drawing out a violin sound, for example, to produce a legato effect. Note duration transforms 
can also be used to tighten up a recording where notes hang too long or are cut off too quickly.

Scale Note Duration lets you increase or decrease the existing duration of a note by a percentage factor 
you select.



Humanize Note Duration
The duration of any note is expressed in Bar:Beat:Click. A click is a fraction of a quarter note; the default 
is 1/480th. The actual time interval of a note will depend on the song’s current meter and the tempo.

Transforming the duration of a group of notes can be used to simulate different types of musical 
articulation, drawing out a violin sound, for example, to produce a legato effect. Note duration transforms 
can also be used to tighten up a recording where notes hang too long or are cut off too quickly.

Humanize Note Duration allows you to make random adjustments to the duration of selected notes. 
Higher values in the Amount box allow a wider range of change.



# $ K + OffSet Time
Shifts the start times of all notes backward or forward in time. This transform lets you selectively change 
non-note MIDI data as well.

When the Offset Start time dialog box appears, click on the buttons to choose which types of events you 
want to change: Pitch Bend, Channel Aftertouch, Key Aftertouch, Patch Changes, Notes and any data set 
by the Controllers. You can choose a single controller or all controller messages at once from the drop-
down list. Choose Earlier or Later, and select an interval in bars:beats:clicks.

By default, all of the event types are selected when you first run Digital Orchestrator Plus. Once you 
deselect an event type, your changes will be retained until you change them again.



HumanizeTime
This adds a series of random time offsets to the selected notes, making the passage more natural-
sounding. Higher settings in the Amount box permit larger shifts in time. This is a great transform to use 
when you want to make MIDI sounds you've entered note by note in Piano Roll sound more natural.



Off Set MIDI Value
MIDI offset changes the values of selected MIDI events by the interval you select. You can set the values 
independently for each type of event.



Scale MIDI Value
MIDI scale changes the values of the selected non-note MIDI events by a factor that you select. You can 
increase or decrease values independently for each type of event. Use the Event Edit window to select a 
range, then apply this transform. 

Although non-note events do not appear in Piano Roll view, you can edit them by clicking the Notes/All 
button at the upper left corner of the Piano Roll editing screen. With the word “All” displayed, the non-note 
editing choices shown in the Scale dialog box become active. 



Invert MIDI Value
This transform inverts MIDI values, using the midpoint of the allowed range as an axis. Most MIDI 
messages assign a value from 0 to 127; the midpoint of that range lies midway between 63 and 64. The 
invert transform moves the value to the opposite side of the midpoint. For example, the value 127 would 
become 0, 0 would become 127. 64 becomes 63; 84 becomes 43.



Humanize MIDI Values
Humanize adjusts the values of selected non-note MIDI events on a random basis, making the passage 
more natural-sounding. You can control the degree of allowable change independently for each type of 
event.



Eliminate Dupes
In a series of MIDI events of the same type, with the same value, only the first in the series will actually 
have any effect. This transform finds and eliminates redundant MIDI events of the type you select.



Thin MIDI
This function reduces the density of the selected classes of MIDI events.

Some editing operations can generate dozens or even hundreds of MIDI events, each creating a change 
too small to detect. You can often achieve the same musical result with fewer, larger changes. Thinning 
unnecessary messages results in a smaller file, and reduces the burden on the synthesizer.

There are two ways to control the degree of thinning. You may use either one alone, or use both together:

Within Click: Eliminates all messages of the same type that lie within a certain proximity to one another. 
The maximum value allowed is 480 clicks, one full quarter note.

For example, if a pitch bend message occurs at 5:2:270, and you've set the Within Click value to 20, all 
pitch bend messages within the next 20 click are removed. The next pitch bend message would occur at 
least 20 clicks away, at 5:2:290 or beyond.

To explain it another way, if you set the Within Click value to 240, you would limit the density of the 
messages to two per quarter note since a quarter note is typically 480 clicks.

Within Value: Eliminates messages that trigger only relatively small changes. Consider a Within Value 
setting of 10 as an example: If a particular key aftertouch message sets a value of 27, the next key 
aftertouch message must increase that value by at least 10 — to 37 or more — or reduce it to 17 or less. 
Any change smaller than 10 is eliminated.



Digital Audio Options

Stereo Playback
Activate this option if you have a stereo sound card and want to hear playback in stereo. Note that this 
will affect the performance of Digital Audio playback. If your system slows down noticeably or the sound 
breaks up, you should probably turn this feature off, reduce the number of tracks or lower the sample rate.

If Stereo Playback is deselected, setting playback to Mono, the Pan control for digital tracks in Track/View 
window will have no effect. 

Device Can Play and Record Simultaneously
Some sound cards can play and record Digital Audio files simultaneously. If your sound card has this 
feature, known as full duplex, you may want to activate it. Note that simultaneous record/playback can 
place heavy demands on your computer system. If you receive an error message saying the “wave 
device is busy” or telling you to expect “poor performance” while recording and playing simultaneously, 
you should turn off full duplex.

Enable Wave Sync
Enabling Wave Sync causes Digital Orchestrator Plus to use the sound card’s Digital Audio driver as a 
clock source, rather than the computer’s internal clock. 

Since sound card drivers take longer to do their job than it takes to process MIDI, by using the sound 
card’s driver as a clock source, MIDI and Digital Audio will stay in sync much better and far longer. 

See Also: Wave Sync 

NOTE:
Not all sound cards support the Enable Wave Sync feature. 
If you Enable Wave Sync and your MIDI drifts out of sync from your Digital Audio, your sound card 
probably does not support this feature. Should this occur, turn Wave Sync off.

Play Buffer
When you play Digital Audio, Digital Orchestrator Plus sets aside a buffer, a portion of your system’s 
RAM, to momentarily hold data and prevent bottlenecks. 

If you experience difficulties on playback, increasing the size of the Play Buffer may help to solve the 
problem.

Record Buffer
The Record Buffer works in the same manner as the Play Buffer. 

If you’re encountering trouble in recording, you can try increasing the size of this buffer.

Default Sample Rate
This is the sample rate at which new recordings will be made by Digital Orchestrator Plus. Recording at 
higher sample rates generally results in better sound fidelity, but also consumes more memory and disk 
space. See the “Quick Reference Chart for Disk Space Consumption” for a useful chart showing how 
much disk space is used in recording at different sample rates. 

If file size is a consideration, Digital Orchestrator Plus allows you to change the sample rate of a recorded 
piece. See the section entitled “Convert Sample Rate.”

Temp Directory
The Temp Directory is where Digital Audio data is initially recorded and where information may be stored 
during certain operations. Make sure the directory listed here is a valid one and that there is at least 
enough disk space available for the largest file you are likely to record. See the “Quick Reference Chart 
for Disk Space Consumption” for a method of determining in advance how large a recorded digital file will 



be.

Controllers
This option lets you assign two MIDI Controllers of your choice to the knobs in the Mixer window and to 
the corresponding boxes in the Track window. Clicking this item displays a dialog box from which you can 
choose the Controllers you prefer. 

The available Controllers are listed in the “General MIDI Controller Types.” Check the documentation for 
your MIDI device to see if it will respond to the Controller you wish to use.

The default Controllers are 091 (Reverb) and 093 (Chorus).



Scale Digital Audio
Digital Audio scaling increases or decreases amplitude by adding or removing a percentage of the original 
amplitude. Scale is very useful for balancing volumes when cutting and pasting between different files.

You can add a maximum of 500% to the original amplitude, that is, you can increase it six times. If you 
select a percentage of minus 100%, you subtract all of the original amplitude, resulting in silence.

Suggest: When you click Suggest, Digital Orchestrator Plus calculates and applies a “normalized” value 
for scaling the amplitude of your file. The effect is the same as selecting the Normalize transform. 



Audio Crescendo
Audio Crescendo increases or decreases amplitudes gradually over the selected range, creating fade-ins 
and fade-outs. Using this transform always produces amplitudes less than or equal to the original values.



Reverse
This function causes the selected range to play backwards and is useful primarily as a special effect. 
Useful primarily as a special effect.

Since no user-defined values need to be input to perform this transform, a dialog box is not presented. 



Compressor / Noise Gate

Overview:

This transform affects the volume or dynamics of a digital recording and operates in three distinct modes: 
Gate, Limiter and Compressor. In each of these modes the same controls will have different effects on the 
sound.

Gate
The Gate function lowers the volume of quiet sounds. It is often used to completely cut off sound when 
recording levels drop. For example, a track of guitar music might have parts where the guitarist isn’t 
playing at all. During these parts, hum and hiss can become audible. The Gate transform will remove the 
signal during these quiet sections, leaving the rest of the recording unaltered.

Tips for Using the Gate

Limiter
The Limiter is used to lower the volume of loud sounds. In narrative recordings, volume levels can jump 
rapidly, particularly on hard consonants. The Limiter will bring down the volume of these occasional 
speech bursts, making the recording smoother and more professional-sounding.

Tips for Using the Limiter

Compressor
The Compressor is very similar to the Limiter, but instead it raises the level of quiet sounds. This can be 
useful when you’re recording an acoustic instrument and want the notes to ring out longer. Instead of 
allowing notes to decay (fade out) normally, the compressor will “pump up the volume” and hold the notes 
longer. 

Note that the Compressor works in essentially the same way as the Limiter except that the Compressor’s 
overall output volume can be increased to compensate for loss of volume brought about by the Limiter. 
You can use the Compressor to bring up volume globally after the Limiter has trimmed the peaks on 
louder sounds. This technique can create a more balanced recording.

Tips for Using the Compressor

Special Technical Note: the compressor algorithm works exactly the same as the limiter. The one 
difference is that the compressors overall output volume is brought up afterwards to compensate for the 
inevitable loss of volume brought in by the limiter. Thus, the louder signals are reduced and the lower 
signals are increased in volume.

Controls:

 Audition Effect
This is the topmost of the three buttons located directly to the left of the OK and Cancel buttons. When 
you click this button, a small amount of the selected sound data is played back. This allows you to 
audition the setting before you commit to transforming all the data selected. Select a portion of the data in 
which sound changes will be readily audible since, even at the maximum duration, only a short interval 
will be auditioned.

 Audition Dry 
Located beneath the Audition Effect button, this control auditions the same selected segment of the audio 



file without effects. Switching back and forth between the Audition Effect and Audition Dry buttons allows 
you to easily compare the sound both with and without the effect you are considering.

 Audition Duration
The bottom button in the group, this control opens the Audition Duration dialog. This dialog box enables 
you to adjust the length of the audition in seconds. The maximum audition length is 10 seconds. Note that 
an audition duration that approaches this maximum can take a long time to process, particularly at higher 
sample rates.

 Note: Keep in mind that both audition dry and effect only auditions a portion of your track. If you have the 
entire track selected and have silence at the beginning, Digital Orchestrator Plus will audition the silence. 
Depending on your Audition settings and how much silence you have you may not hear anything.

 Threshold 
The Threshold control, which is located at the extreme left of the Compressor/Noise Gate dialog box, sets 
the volume level at which an effect will become active. 

With the Gate effect, signals below the Threshold are made quieter, signals above it are unaffected. With 
the Limiter mode selected, signals above the Threshold are made quieter. With the Compressor mode 
selected, all signals are made louder. Signals below the Threshold are boosted but retain their original 
dynamics, while signals above the Threshold are boosted and their dynamic range reduced.

 Amount 
The Amount control determines how strong an effect will be. At 0, the effect does nothing; at 100, the 
effect is at its most pronounced. 

With the Gate effect selected, Amount determines how much quieter the signals below the Threshold are 
made. With the Limiter or Compressor selected, Amount determines to what degree the signals above the 
Threshold are quieted. When Gate is selected, you normally will want to set the Amount to 100%.

 Output Gain
The Output Gain control sets the final volume of the effect. A setting of 0% yields no boost in output level. 
A setting of 100% produces the maximum possible Output Gain.

 Attack 
The Attack control, located to the right of the Threshold controls, determines how fast an effect responds 
to an increase in volume. For example, when you are using this transform in Limiter mode, the Attack 
control determines how quickly the Limiter brings down the volume when the signal level goes above the 
Threshold.

 Release
The Decay control, to the right of the Attack control, determines how fast an effect responds to a decrease 
in volume. For example, in Gate mode, the Decay control determines how quickly the Gate brings down 
the volume when the signal level goes below the Threshold.



Digital Delay

This transform implements an effect that is usually created with an outboard effects signal processor 
called a digital delay. By adjusting the parameters correctly, a wide variety of effects are obtainable. Some 
of these effects are echo, chorus, slapback, doubling, reverb and resonance, and are achieved through 
signal delay. By changing the amount of the delay and feeding some of the signal back to the input, where 
it can be delayed again, you can build complex effects.

Delay functions are accessed by choosing Delay from the Digital Audio fly-out menu. This opens 
the Digital Delay dialog box containing a complete set of controls for delay effects, as described 
below: 

Presets Section

 Preset 
This displays a list of preset effects. When you select a preset, all of the necessary delay parameters are 
automatically entered. Use the default effect settings as they are, or as a starting point to create your own 
effects.

 Add Preset 
This adds the current delay dialog settings to the preset list. You can save any custom effect under a new 
name and add it to the list of presets.

If you change settings for any of Digital Orchestrator Plus' standard delays like Reverb, Chorus or Slap 
Back, then save the preset under its original name, Digital Orchestrator Plus temporarily overwrites the 
original preset's values. The saved changes remain in effect until you delete the preset. The preset and its 
default values will be restored the next time you open the Digital Delay dialog box.. 

 Delete Preset 
This control deletes the currently selected preset from the presets list. The preset effects provided with 
Digital Orchestrator Plus will be restored to their default settings the next time you open the digital delay 
dialog box.

 Audition Effect
Audition Effect processes a small amount of the selected data with the current effect settings and plays it 
back, allowing you to audition the setting before you transform all of the selected data.

 Audition Dry 
This control allows you to audition the selected segment of a file without the effect. Switching back and 
forth between Audition Effect and Audition Dry provides a quick way of comparing sounds with and 
without effects added..

 Audition Duration



This control displays the Audition Settings dialog box. You can adjust the length of the auditioned 
segment to a maximum of 10 seconds. Note that, as you approach this maximum, the amount of time 
necessary to process the segment can become quite long.

 Note Keep in mind that both audition dry and effect only auditions a portion of your track. If you have the 
entire track selected and have silence at the beginning, Digital Orchestrator Plus will audition the silence. 
Depending on your Audition settings and how much silence you have you may not hear anything.

Delay Section

 Delay Time
The delay time control sets the amount of time between echoes. Fairly long delays, 200 ms. to a second 
or more, create a distinct echo. Very short delays act more like a filter: certain frequencies will be boosted, 
and others cut.

 Delay Depth 
Delay depth controls how much of the delayed signal you will hear mixed with the un-delayed signal. At 0, 
you will only hear the original signal; at 100% only the delayed signal.

When you are creating an echo effect with a long delay time, you would normally use a depth somewhat 
below 50% so that the initial sound is louder than the echo. To add layering, depth and shifting intensity to 
the sound, creating effects called “flange” or “resonance,” use 50% to achieve maximum filtration. For 
even more unusual effects, you might set Delay Depth to 100% so that you don't use any of the original 
sound.

 Delay Feedback 
: The delay feedback control determines how much of the output of the delay is fed back into the input. If 
the delay is long, the feedback control will determine how many echoes you hear. At 0%, you will hear a 
single echo. At 100%, the echo effect will last for several seconds. In between are a wide range of echo 
effects.

Modulation Section
The modulation section allows you to vary the delay time. When a short delay time is set up in the delay 
section, the modulation will cause the filtration effect to sweep up and down in frequency. This is the basis 
of the flanging effect. When the delay time is fairly moderate to long, modulation will have the effect of 
shifting the pitch, to create a vibrato effect.

 Modulation Rate 
The time between each delay echo can be varied, or “modulated”. At higher settings, the time between 
echoes will sweep up and down in frequency, producing the kind of shifting resonance effect called 
“flanging”. Lower settings typically produce effects more closely resembling “vibrato”.

 Modulation Depth 
The modulation depth controls how much modulation is used. When it is 0, you get no modulation; when 
it is 100, you get the maximum amount.

Global Controls



 Invert Samples 
The Invert Samples control inverts the phase of the delay unit's output before it is fed back. This subtle 
effect is most useful when you are doing flange and resonant effects.

 Frequency Rolloff
The frequency control can be used to cut some of the high frequencies from the delay. This is useful for 
simulating a natural echo where each echo is a bit duller than the previous one. 

 Input/Output Gain 

Input Gain: The input gain increases the amplitude, or volume, of the digital data transformed by the delay 
effect. In general, you will want to keep the input gain control as high as possible while avoiding clipping.

Output Gain: Output gain increases the total amplitude of the segment of sound affected by the delay 
transform. If you are experiencing clipping using Digital Orchestrator Plus' delay effects, you can adjust 
the output gain for the desired volume. Actually it is possible for the echo to clip in several places, so 
adjusting both input and output gain controls may be necessary to get a distortion-free effect.

Common Effect Settings:

Echo 
Flange 
Slapback 
Vibrato 
Resonant Filter 
Chorus

 See Also Creating A Digital Delay Effect 



DC Offset
Some sound cards do not correctly align the sound to the digital zero point when recording. This can 
create an annoying popping sound which is usually audible at the beginning or end of a recording. Digital 
Orchestrator Plus' DC Offset feature can correct this problem by:

Centering the display for an audio file that was recorded with a DC offset.

Matching offsets of audio files after cutting and pasting material from different files.

Default Value: Use the slider to set the degree of offset. A positive number shifts the range up, a negative 
number moves it down.

Suggest: Analyzes the selected data and enters an offset value that will center the data vertically.

Use DC Offset after you have finished recording an entire track and apply it to all of the data at once. 
Otherwise, offset will be uneven in different sections of a piece.



Loop Range Button

Loops the range defined in the From and Thru range settings. You may change these values directly by 
clicking on the From and Thru boxes.



Meter/Time Signature Change
There may be one or more Meter changes in a song. By default there is a 4/4 meter event inserted at the 
first bar of a new song. This default event may be changed to a different Meter. Additional Meter change 
events may be placed in any bar throughout the song. Changes and insertions of new Meter events are 
done in the Conductor Track Editor.

To change the Meter or Time Signature in Digital Orchestrator. 

1. Press the Conductor Window Quick View Button to display the Event Editor, set to the Conductor track. 
Or, select the Event Editor from the Window menu then select the Conductor track in the Track field.

2. Highlight the Meter event.
3. Press the Change button. This will display the Event Edit dialog.
4. Modify the time signature and press OK.

Meter Settings:

Numerator: Number of beats per bar.

Denominator: The note value of the beat.

Beats per bar: This parameter sets the metronome to sound a different number of beats per bar than is 
listed in the Numerator field. This is helpful when working in meters such as 12/8, where you would only 
like to listen to 4 “clicks” per bar vs. 12.

To change the Meter within a song:

1. Click on the Insert button to display the Event Edit dialog.
2. Click on the Meter icon in the Type box.
3. Modify the Meter.
4. Set the Start Time, which determines where the Meter change will take place.
5. Press OK to insert the new Meter event at the current Start Time.

To Delete a Meter event:
1. Click on the event to delete.
2. Press the Delete button.

 See Also Key Signature Change 



Key Signature Change
There may be one or more Key Signature changes in a song. By default there is a Key of C Maj. event 
inserted at the first bar of a new song. This default event may be changed to a different key. Additional 
Key Signature change events may be placed in any bar throughout the song. Changes and insertions of 
new Key Signature events are done in the Conductor Track of the Event Editor.

To change the Key Signature in Digital Orchestrator Plus: 
1. Press the Conductor Window Quick View Button to display the Event Editor, set to the Conductor track. 

Or, select the Event Editor from the Window menu then select the Conductor track in the Track field.
2. Highlight the Key Sig event.
3. Press the Change button. This will display the Event Edit dialog.
4. Modify the key signature and press OK.

To change the Key Signature within a song:
1. Click on the Insert button to display the Event Edit dialog.
2. Click on the Key Signature icon in the Type box.
3. Modify the Key Signature.
4. Set the Start Time, which determines where the Key Signature change will take place.
5. Press OK to insert the new Key Signature event at the current Start Time.

To Delete a Key Signature event:
1. Click on the event to delete.
2. Press the Delete button.



Echo
Echo: The common repeating effect.

Delay time: Fairly long, 100 ms. and up. The longer the delay time, the more time between echoes.
Delay depth: Less than 50% for most normal effects. 
Feedback: 0 to 99%. The higher the feedback, the more times the echoes will repeat
Modulation depth: 0, unless out of tune echoes are desired (see vibrato).
Modulation rate: N/A since depth will be zero.
Notes: The frequency control can be used to make echoes sound “softer” and more natural. Also note 
that at very high feedback settings it is easy to get distortion, so you may need to back off on the input 
gain in these cases.



Flange
Flange: Flanging is a sort of slow sweeping sound applied to a source sound. The effect got it's name 
from the fact that the effect was originally achieved by pressing your thumb on the flange of a tape deck 
to slow down the tape while another machine ran at the right speed.

Delay time: Short, 1 ms. to 40 ms. The shorter the delay, the higher the frequency of the filtration.

Delay depth: 50% for maximum effect.

Feedback: Anywhere from 0 to 90 is OK. More feedback means more pronounced and resonant filter. 
Low feedback makes smother more liquid sound.

Modulation depth: A setting of 75% is a good start. Different mod. depth settings produce different flange 
effects.

Modulation rate: Rate adjust speed of flange. Try 50 X 10 to start.

Notes: Invert samples will have a big effect on the harmonic structure, making “wah” sounds at some 
settings.



Slapback
Slapback: Slapback is a very short echo. This makes it sound like a musician is in a very small room. 
The sound is very familiar from 1950's era Rockabilly bands. This effect became popular because it was 
easy to create in 1950's recording studios; a very short echo could be created between the record and 
play heads of a typical tape recorder. At the time there was no easy way to generate a long echo.

Delay time: medium, 35 ms. to 100 ms.
Delay depth: 50% or a bit less.
Feedback: 0 or very low
Modulation depth: none
Modulation rate:N/A
Notes: Sound travels at about 1100 feet per second. That means that the echo from a wall 11 feet away 
from you comes back after 10 ms. that is why short echoes sound like you are in a small room. 
Unfortunately, your ear only believes this for a restricted range of times; I ms. does not sound like you are 
in a 1 foot room!



Vibrato
Vibrato: Vibrato is a periodic variation in pitch. Modulating the delay time will modulate the instantaneous 
phase of a signal, and hence it's frequency. Note that the small amount of undesired delay added by 
synthesizing vibrato can be corrected by dragging the music back onto the beat from the audio editing 
window.

This effect is most useful in creating audio paradoxes, for example a piano with vibrato (which is 
impossible without trickery). In small amounts, it can be useful as part of a chorus effect.

Delay time: moderate. Make it as short as possible to get enough effect 2 to 10 ms. is typical. If 
modulation depth is 100%, the delay time will determine the amount of vibrato.
Delay depth: 100%.
Feedback: 0, unless you want more unusual effect.
Modulation depth: Adjust this only if the coarseness of the delay time control makes it so you can't get the 
effect you want.
Modulation rate: Anything normal. Will determine rate of vibrato.



Resonant Filter
Resonant filter: This is a very familiar “robot talk” effect. It can sound like a cheap vocoder. It is very 
similar to a flange setting, but no modulation is used, and the feedback is set much higher than a normal 
flange. Note that the apparent frequency is set by the delay time. Since the filter can be fairly sharp, small 
changes in filter tuning (or input signal frequency) can make a huge difference. When the filter is tuned to 
a harmonic of the input signal, the effect is very dramatic.

Delay time: 4 to 40 ms. is the most useful range.
Delay depth: 50-100%
Feedback: adjust to taste. Most obvious settings will be from 70 to 90 %
Modulation depth: 0
Modulation rate: N/A
Notes: Invert samples is often useful will this effect. Also note that with low feedback settings, the delay 
depth should be 50% or you won't hear much. In general, the controls behave like they do for the flanger.



Chorus
Chorus: Chorusing is used to describe a wide range of effect. In most cases, chorusing is an attempt to 
make a single instrument or singer sound like a larger group. Chorusing is typically achieved with several 
delays with slightly different settings. A passable facsimile can be made by programming a short echo 
with a slight vibrato.

Delay time: 40
Delay depth: 50
Feedback: 35
Modulation depth: 55
Modulation rate: 7
Notes: Examples of this effect are found on Billy Joel's Rhodes piano in the tune “Just the Way You Are” 
or in the song by the Pretenders -- “Brass in Pocket”.



Tips For Using The Gate
When using Gate, the following considerations are important:

· Be sure to set the Threshold correctly. If the Threshold is too high, you will end up cutting out sound 
that you want. If you set it too low, you won’t eliminate the noise you are trying to get rid of. Try out 
a number of different settings to determine the correct Threshold level.

· You will almost always want to use Gate with the Amount set to 100%. After all, the point of a noise 
gate is not to subtly shape the sound, it’s to remove noise altogether. If there is so much noise that 
no clear threshold separates the signal from the noise, then a setting of 50% might work. Rather 
than chopping out everything below the Threshold, this will just make it quieter. Some of the signal 
may get attenuated along with the noise, but it won’t be completely lost.

· It is very important to set the Attack as fast as possible with a Gate. Otherwise, when a new signal 
comes along, the Gate will stay closed and you won’t hear the new note. It can be worthwhile to 
experiment with attacks shorter than you would normally use (3 to 10 millisecond range). You will 
also want the Release to be relatively fast so that the Gate will chop off the noise quickly.

· Don’t set the Attack to 0. If you do, the gain will change infinitely fast, causing a loud pop. The 
Attack and Release should always be at least a few milliseconds long. 



Tips For Using The Limiter
When using the Limiter, keep the following in mind:

· Look at the waveform in the audio editing window and see where the peaks are that you want to get 
rid of. Use this information to set the Threshold so the peaks will get flattened.

· The Attack and Release settings aren’t as critical as with the Gate transform. If the Attack is a little 
too long, the initial part of the peak will get through, but it will get silenced quickly enough.

· If you set the Amount to 100%, any signals above the Threshold will be reduced to the Threshold 
level. Lower Amount settings reduce peaks without completely flattening them. For a more natural 
sound, try a setting between 50% and 75%.



Tips For Using The Compressor

When using the Compressor, keep the following in mind:

· A wide variety of effects is available, depending on the settings of Threshold and Amount. In 
general, the higher the Amount and the lower the Threshold, the more effect you will get. For 
example, with the Amount set to 100 and Threshold set to 10, for example, all signals will be 
amplified to maximum volume. This will intensify and bring forward the sound of percussive 
instruments like piano, guitar and drums. 

· When amplitudes go above the range in which sound can be played, part of the signal is lost or 
“clipped.” Along with signal loss, clipping produces a distortion of the sound at the highest 
amplitudes that are actually heard. When you combine high Amount and low Threshold settings, 
you can easily get clipping. To avoid this, either set the Output Gain to a negative value, or the 
Attack to very fast, or both.

· The Output Gain works as post-amplification on the Gate, Limiter and Compressor. Each transform 
will perform its function and then the Output Gain will add amplification to it. Concerning the 
Compressor, this is especially important. 

· The Compressor, after limiting the waveform, then maximizes it to 100%. So, if you leave the 
Output Gain at 0%, the waveform will be at maximum. If the Output Gain is raised to anything 
above 0%, it will increase the volume of the waveform even higher. 

For example, with the Output Gain set to 20%, you would, in effect, be raising the waveform to 
120%. This could produce clipping and unpleasant distortion.

To prevent this distortion, the Output Gain can be set to negative numbers. For example, setting the 
Output Gain to -10% would bring the overall volume to 90%. This number is arrived at by the 
combination of the Compressor’s maximizing of the waveform and the reduction in amplification by 
setting the Output Gain to a negative number.



Receiving SysEx Data

To Receive SysEx Data

Click on a row in the SysEx window to put the cursor on the bank you wish to load into.

Press the receive button. The Receive SysEx Data dialog box will appear:

For manual loading, select the “You start dump on instrument” setting in the Macro selection box. For 
automatic loading, choose one of the macros in the list. You will not need to change the Input and Output 
port selections in this dialog box unless you have a very complicated MIDI setup. If so, please refer to 
your MIDI hardware manuals for the correct settings.

Press OK. If you are using the manual load setting, the Receiving Data dialog box will appear, otherwise 
the macro will execute and your MIDI device will automatically upload the data to Digital Orchestrator 
Plus. Macros for all MIDI devices could not be included so you may have to use manual loading or write 
your own. Unfortunately, constructing these macros is beyond the scope of this help file.

If you are using manual mode, you can now begin SysEx transfer from the front panel of your MIDI 
device. The procedure for doing this will vary widely with different devices, so refer to the appropriate 
hardware manual for information.

As data is received, the count of bytes received will increase. The Receiving Data dialog box. updates the 
number of bytes received as the transfer progresses. When the transfer is complete, the number display 
will stop increasing, and your MIDI device will probably give you a visual indication that it has finished 
transmitting as well.

Click on the done button in the dialog box to accept the received data.



Sending SysEx Data
Sending SysEx Data

Click on the row in the SysEx window for the bank of SysEx data you want to send.

Press the “Send” button. The Send SysEx Data dialog box appears. To send a bank of data automatically, 
click on the “auto” column for the bank you want to send. A check mark will appear. Whenever you play 
the song, the bank will be sent out first.

If you do not select the “auto” option, you will need to open the send dialog box and send the selected 
data each time you play the song. 



Saving SysEx Data To Disk
Saving a SysEx File to Disk

In the SysEx window, click on the row for the bank you want to save to disk. 

Click the Save button. This will open a standard Windows File Save dialog box.

Follow normal Windows procedures to name, rename or save the file.



Loading SysEx Data From Disk
Loading a SysEx File from Disk

In the SysEx window, click on the row for the bank where you want the data to appear. If there is already 
SysEx data in this bank, the new data will be appended to it.

Click the Load button. This will open the standard Windows File Open dialog box. 

Follow normal Windows procedures to select and load the file



Editing SysEx Data

In general, most MIDI users will not want to modify SysEx messages since these messages are written in 
Hex, do not follow any fixed format and are usually specific to a particular synthesizer for which you must 
know codes and commands. Nevertheless, for the advanced user, an editing function is included.

Click on the bank you want to edit. It may be an empty bank, in which case you can enter your own data. 

Press the “edit” button. A box will pop up showing the SysEx data in hex format and this data can be 
edited directly in the box.

Remember: editing system exclusive data is not for the faint of heart! Furthermore, a thorough 
explanation is well beyond the scope of this help file.

When you press “OK,” the data you entered will be scanned for obvious errors. Remember that SysEx 
data must begin with a particular identifying number and the synthesizer will respond only 
to SysEx data that bears the correct identification.

Note that as long as the beginning and ending numbers are correct, Digital Orchestrator Plus will pass the 
raw data in the dialog box directly to your synth without parsing or otherwise verifying it.



Sending SysEx Data From The Middle Of A Song

Sending SysEx Data from the Middle of a Song

First, make sure that the data you want to send is loaded into one of the banks in the SysEx window.

Change to the Event Editor window, using one of the speed buttons at the bottom of the screen. 

In the Event Editor window, select the track you wish to insert the SysEx data into.

Press the “insert” key to call up the Event Edit dialog.

Scroll down the Type box in the Event Edit dialog until SysEx is the selected type. Set the Start time to the 
location where you want to insert the data. In the Parameters section, pick the SysEx bank you wish to 
insert.

Press OK to insert the event.

Note that you are inserting a reference only to the SysEx bank, not to the data itself. If you edit the bank 
later, then insert the data in the middle of a song, the changed data will be sent to your synthesizer.



SysEx Procedures

Receiving SysEx Data 
Sending SysEx Data 
Saving SysEx Data To Disk 
Loading SysEx Data From Disk 
Editing SysEx Data 
Sending SysEx Data From The Middle Of A Song 



 Tuning Digital Audio Performance

What you Need to Know about Hard Disk Recording

It's important to remember that MIDI and digital audio are two very different ways of creating and 
recording sound.

When you record MIDI, you are actually recording a series of commands—the keystrokes that you made, 
the instruments you selected and so on. Each time you play back the file, your sound card or MIDI synth 
re-creates the music by replaying these commands. You change a song by changing its commands.

Digital audio is more like recording with a tape deck. You record actual sounds, not commands, and store 
them on your computer's hard disk (instead of on audio tape). The advantage of digital audio is that you 
aren't limited to the sounds that your sound card or synthesizer can create. You can record anything that 
a microphone can pick up, from your voice to an electric guitar.

Digital Audio Performance Issues

By default, Digital Orchestrator Plus makes 16-bit, mono recordings at a resolution of 22,050 samples per 
second. Recorded at this setting, one minute of digital audio recording will take up 2.6 megabytes on your 
hard drive.

There is a tradeoff between sound quality and file size. Depending on your computer's processor and 
hard disk drive, you may find that you cannot successfully record two long digital audio tracks at high 
resolutions, or that sound breaks up on playback. These problems are caused by the limitations of your 
computer system.

Here are some steps you can take to help:

When you record digital tracks, be prepared for very large file sizes. Make sure your disk drive has 
enough room.

Choose lower Sample Rate settings for recording where possible.

Close all other software programs to make the maximum computer power available for recording.
Remember that recorded silence uses memory so, whenever possible, cut silences or use Digital 
Orchestrator Plus' Noise Gate to edit them out.

Deselect stereo playback in the Digital Audio portion of the Options menu.

Defragment your hard disk. This will optimize overall system performance.

If you have multiple hard disks, set your temp directory (in Digital Audio Options) and save your files to 
the fastest one.

Increase the size of the record and playback buffers in the Digital Audio Options dialog. This will increase 
the amount of memory available to start playback and recording, and can improve overall performance. 
Increase these buffers only as much as necessary. Too much buffering wastes memory and degrades 
performance.

If your system BIOS supports multiple hard disk sector read/write, you may want to disable this feature as 
it can interfere with playback on certain sound cards.



Decreasing the number of tracks in a file results in smaller file size and lowers demand on your system. 
Try merging a number of digital tracks onto a single track.

 Merging Tracks

If you've tried all of these measures and you're still unhappy with performance, consider upgrading your 
system.

 See Also: Predicting The Size of Digital Audio Files 



To Operate Transforms
Transform functions allow you to select a portion of your song file and, in a single operation, change 
certain parameters for all of the selected notes. In general, you use a transform when you want to make a 
permanent change to your file, however, Digital Orchestrator Plus' Undo feature allows you to reverse the 
changes you've made and try other settings. 

There are two types of transforms available: MIDI and Digital Audio. Most transforms require you to 
specify the particular part of the file you want to change. A few transforms, by their nature, can only 
operate on an entire file or track.

NOTE: Transforms generally act only on MIDI notes, leaving non-note MIDI messages (patch changes, 
controller messages, etc.) unchanged. This sometimes creates situations where the notes and the 
controller data no longer match up. You can use the MIDI transforms (described later in this section) to 
restore the correct relationships.

To operate transforms:

From any window that is convenient, select the MIDI notes, MIDI measures or digital audio data that you 
wish to change.

From the Transforms menu, select the desired transform. (Some will not be available, depending on the 
type of data you have selected.)

If a dialog box appears, enter or adjust parameters as needed, then click OK. The effects of various 
transform options are described below.

Listen to the file to check the results. If necessary, use the Undo command to restore the file and run the 
transform again, with adjusted settings.

NOTE: Be sure you are satisfied with the results of any transform before you continue editing. The Undo 
command affects only your most recent edit or transform.



Making A Test Recording
It’s important to make a test recording using the software that came with your sound card or the Windows 
Sound Recorder. This will ensure that your basic hardware is working correctly.

If you’re using your sound card’s software, refer to the instructions provided. If you’re using the Windows 
Sound Recorder applet, follow these steps.

To Make a Test Recording:

1. Open Sound Recorder from the Windows Accessories group.

2. Plug a microphone into the microphone input of your sound card, click on the record button, say a 
few words, then click the stop button. 

3. Make sure that the speaker output of your sound card is connected to an amplification device or 
headphones and play back the recorded file in Sound Recorder. Be sure not to have the 
headphones on your ears during the initial test because sound card volume settings vary and you 
could accidentally damage your ears. 

4. Play back your recording and make sure that the sound is not distorted or clipped. You may want to 
make several recordings, adjusting the record level each time to find the correct settings.

Your PC’s Mixer
Most sound cards come with a mixer application that allows you to set the volumes for .MID and .WAV 
playback and recording. Setting mike levels correctly is critical in creating recordings on the PC because 
the overall volume of the sound card, as well as the recording input levels, are set in the mixer 
application.

Once you’ve confirmed that your hardware is working correctly, you’re ready to record Digital Audio.



Predicting The Size of Digital Audio Files

The formula below will help you predict the approximate amount of disk storage space a Digital Audio file 
will require. You must know four things about the file you want to create:

B—Bits
The length of a single sample—Digital Orchestrator
Plus ’ digital files are always 16-bit 

C—Number of Channels
1 for mono, 2 for stereo

T—Time
The length of recording, in seconds

R—Sample Rate in Hertz (samples per second)
Digital Orchestrator Plus defaults to 22,050

To Predict Digital Audio File Size:

The following equation will predict Digital Audio file size.

(B/8) x C x T x R = File size, in bytes

For example, consider an 8-bit stereo recording, 14 seconds long, made at a sample rate of 11.025 kHz. 
In this example, you must multiply 11.025 Kilohertz by 1,000 to arrive at 11,025 Hertz.

Place the following values into the formula:

B = 16 (bits)
C = 1 (Mono)
T = 14 (seconds)
R = 22,050 (samples per second)

Solve the equation:

(16/8) x 1 x 14 x 22,050 = 617,400 bytes

To convert this answer from bytes to kilobytes, divide the result by 1024.

617,400 ÷ 1024 = 602.929, or about 603K

This answer is still an approximation. A file header must be added to the file, which adds bytes, and, of 
course, you have to multiply by the number of tracks you wish to record.

Quick Reference Charts for Disk Space Consumption

The charts on the following page show approximate file sizes (in megabytes) generated when recording 
16-bit Digital Audio different sample rates.

Note that for No. of Tracks:

· 1 track = 1 mono track

· 2 tracks = 1 stereo track



· 3 tracks = 1 mono track and 1 stereo track

· 4 tracks = 2 stereo tracks

File Size at 11.025 kHz Sample Rate
# of Tracks Song Length in Minutes

1 min 2 min 3 min 4 min 5 min

1  1.3MB 2.5 3.8 5.1 6.3

2 2.5 5.1 7.6 10.1 12.7

3 3.8 7.6 11.4 15.2 19.0

4 5.1 10.1 15.2 20.2 25.3

File Size at 22.05 kHz Sample Rate
# of Tracks Song Length in Minutes

1 min 2 min 3 min 4 min 5 min

1  2.5MB 5.1 7.6 10.1 12.7

2 5.1 10.1 15.2 20.2 25.3

3 7.6 15.2 22.8 30.3 37.9

4 10.1 20.2 30.3 40.4 50.5

File Size at 44.1 kHz Sample Rate
# of Tracks Song Length in Minutes

1 min 2 min 3 min 4 min 5 min

1 5.1 MB 10.1 15.2 20.2 25.3

2 10.1 20.2 30.3 40.4 50.5

3 15.2 30.3 45.5 60.6 75.7

4 20.2 40.4 60.6 80.8 101.0



SysEx Edit Dialog Box
In general, most MIDI users will not want to modify SysEx messages since these messages are written in 
Hex, do not follow any fixed format and are usually specific to a particular synthesizer for which you must 
know codes and commands. Nevertheless, for the advanced user, an editing function is included.

Click on the bank you want to edit. It may be an empty bank, in which case you can enter your own data. 

Press the “edit” button. A box will pop up showing the SysEx data in hex format and this data can be 
edited directly in the box.

Remember: editing system exclusive data is not for the faint of heart! furthermore, a thorough explanation 
is well beyond the scope of this help file.

When you press “OK,” the data you entered will be scanned for obvious errors. Remember that SysEx 
data must begin with a particular identifying number and the synthesizer will respond only 
to SysEx data that bears the correct identification.

Note that as long as the beginning and ending numbers are correct, Digital Orchestrator Plus will pass the 
raw data in the dialog box directly to your synth without parsing or otherwise verifying it.



SysEx Receive Dialog Box

To Receive SysEx Data

Click on a row in the SysEx window to put the cursor on the bank you wish to load into.

Press the receive button. The Receive SysEx Data dialog box will appear:

For manual loading, select the “You start dump on instrument” setting in the Macro selection box. For 
automatic loading, choose one of the macros in the list. You will not need to change the Input and Output 
port selections in this dialog box unless you have a very complicated MIDI setup. If so, please refer to 
your MIDI hardware manuals for the correct settings.

Press OK. If you are using the manual load setting, the Receiving Data dialog box will appear, otherwise 
the macro will execute and your MIDI device will automatically upload the data to Digital Orchestrator 
Plus. Macros for all MIDI devices could not be included so you may have to use manual loading or write 
your own. Unfortunately, constructing these macros is beyond the scope of this help file.

If you are using manual mode, you can now begin SysEx transfer from the front panel of your MIDI 
device. The procedure for doing this will vary widely with different devices, so refer to the appropriate 
hardware manual for information.

As data is received, the count of bytes received will increase. The Receiving Data dialog box. updates the 
number of bytes received as the transfer progresses. When the transfer is complete, the number display 
will stop increasing, and your MIDI device will probably give you a visual indication that it has finished 
transmitting as well.

Click on the done button in the dialog box to accept the received data.



Chase Notes
This option allows you to configure the editing area so that notes which start to the left of the display will 
extend into the editing area if necessary. Normally, the editing area does not display these notes.



Rounded Notes
When this option is enabled, notes will be displayed with rounded corners. Rounded corners make it 
easier to see the meeting point between two adjacent notes. Square corners make it easier to see 
precisely where a note begins and ends.



The Recording Process: Tips & Techniques

Although there is no right or wrong way to record a piece of music, most professional producers would 
agree that there is a common format for creating a pop song. A pop recording is usually includes drum, 
bass, rhythm, lead vocal, background vocal and lead instrument parts If you are new to recording, this 
section can help you understand the steps commonly used to create a song from these parts. For those 
with more experience, tips are provided for getting the most out of your desktop recording system.

Planning the recording:

Before you begin recording, it's best to determine which format, digital audio or MIDI, you will use for each 
of the tracks you plan to record. Some instruments lend themselves to MIDI recording; for others, 
recording to digital tracks is more suitable. Keyboard synthesizer parts, for example, will almost always be 
recorded as MIDI tracks. 

With the advent of wavetable synthesizers and samplers, drums, horns, bass and other instruments now 
sound very realistic when played back in MIDI format. Other instruments, such as guitar and saxophone, 
are not accurately reproduced by a synthesizer and are best recorded as live instruments to digital tracks. 
Vocals, of course, must be recorded as digital tracks.

Digital Orchestrator provides more than 1000 MIDI tracks on which to record your synthesizer parts. You 
can record as many tracks as your synthesizer has voices to play them back. You may, however, only be 
able to record and play back a maximum of 2 to 8 digital tracks depending on the capabilities of your 
computer system. 

You can overcome your hardware limitations somewhat by setting the sample rates to a lower value. This 
will increase the number of tracks you can work with but you'll pay a cost in sound quality. Recordings 
made at low sample rates may not reproduce high frequencies well. The lower the sample rate, the more 
high end loss. 

If you don't need more tracks, setting the sample rate to a higher number will produce better quality 
recordings. It is recommended that you make some test recordings before beginning an important project 
to determine the number of tracks your computer can record at a given sample rate. Once you know the 
capabilities of your machine, you can finish planning how your song will be recorded. Other tips for 
“saving” digital tracks are discussed later in this section.

TIP: You have probably heard the phrase “save early, save often.” It's always a good idea to save multiple 
revisions of your song under different file names, especially before merging digital tracks.

Drum Part

Most often, the recording process begins with the drum part. Laying down a drum track early in the 
recording process provides you and the other musicians with a groove to play over. It's a reference to the 
time of a piece that's much more inspiring than a metronome. 

There are a number of ways to lay down a drum part: You can play the part in from a MIDI controller such 
as a keyboard or MIDI drum pad controller or you can insert the drum notes manually in Digital 
Orchestrator Plus' Piano Roll window, using the copy and paste commands to lengthen the part. You can 
create an interesting drum part very quickly by adding, deleting and moving notes at different bars. 

If you prefer, you can use one or more of the drum track templates provided with Digital Orchestrator 
Plus. Use the Audition button in the File Open dialog to choose the template you want. Load it, then copy 
and paste the bars to create the full drum part.

By assigning the same drum channel (usually channel 10 or 16) to more than one track, you can create 



multitrack drum recordings. This allows you to layer the drum parts using different recording techniques 
for each track. You could, for example, load a drum template to provide the basic groove, then record a 
conga part from your keyboard on another track. For additional texture you could add a quarter-note 
cowbell part by inserting four quarter-notes on a separate track in Piano Roll view and looping that track. 

Bass Part

Now that you have laid down the drum part, you'll need some bass to help hold down the groove and give 
the song structure. As you did in setting up the drum part, you can insert notes from the Piano Roll 
window or record them from your keyboard to create the bass part.

Since most pop songs repeat phrases, it's usually a good idea to record a phrase once and then lengthen 
the part by copying and pasting it in Digital Orchestrator Plus' Track/View screen. This will help speed up 
the creative process and insure that you don't get bogged down in the recording process. 

TIP: Once you have completed the arrangement of your song, you can go back and re-record the part to 
give it a “played live” feel.

Rhythm Guitar Part

After completing the drum and bass parts, most musicians will lay down a rhythm guitar part as the next 
step in recording. This can be a simple acoustic guitar “strumming” part or a multitrack heavy distortion 
electric guitar part. Like the bass part, you may want to take advantage of Digital Orchestrator Plus' copy 
and paste features to quickly assemble recordings or phrases. If you need to add different parts, such as 
an ending or a bridge section, don't forget that you can record them on different tracks and merge the 
tracks later. 

TIP: Multiple digital tracks can be organized so that they use the same amount of system playback 
resources as a single track. As long as the tracks aren't playing at the same time, the demands on your 
system will be the same as if you recorded everything to a single track. For example, you might consider 
putting the rhythm verse parts of your song on one track and the chorus parts on another. 

Very often producers will “double track” rhythm parts (record the same material on two different tracks) 
giving the recording a full, lush sound. Since one of the attributes of digital recording is the ability to 
merge tracks without acquiring noise, a good production technique is to double track the rhythm parts by 
recording them on two separate tracks and then merge them. This gives you the richness of two tracks 
but uses the playback resources of only one. 

TIP: Use Digital Orchestrator Plus' Digital Compressor to compress tracks following recording. This 
should be done with most digital recordings that use a microphone as a source. Because compression 
increases the level of the soft parts and decreases the peaks, this technique will create a smoother 
signal.

Synthesizer and Keyboard Parts

The term “keyboard part” is ambiguous. For our purposes, it means any musical embellishment which 
would typically be played from the keyboard including: a piano rhythm part, brass stabs, string lines, 
orchestra hits etc. Like the rhythm guitar parts, keyboard parts often sound better doubled up.

TIP: Try recording a piano part, then copying the part to another track. Assign the second track to a 
different channel and assign it a different piano patch. Lastly, use the pan control to pan one track hard 
left, and the other hard right. 

Doubling up parts creates a full and rich sound. Experiment with transposing the second of two parts an 
octave up or down, or try using the Humanize Time transform to randomize the second part. This 
technique doubles the number of voices your synthesizer uses, which can cause notes to “choke out” in 



the more densely played sections of a track.

Lead Vocal Part

Okay, you've put together the basic tracks of a song. It's now time to add the melody in the form of a vocal 
part. Hopefully, you have written some inspiring lyrics to sing over your musical creation. Creating a 
melodic vocal part with just the right phrasing is a challenging task. 

One of the problems when trying to track a good vocal part is that singers “tense up” when they are being 
recorded. They think “they have to get it right the first time” so they're stressed and the vocal part sounds 
it.

TIP: To help avoid the “freeze up” syndrome, try recording multiple takes of the same part. This 
encourages the singer to try different phrasings, and allows him or her to relax. To do this, simply record a 
take then mute it and go on to another track. Once you have the take that you want, delete the bad takes, 
save the file and move on.

When experimenting with different parts, you may want to save different versions of the song file. This will 
allow you to go back to one of the earlier takes should you decide it's the one you want. 
To accomplish this follow these steps:

First, load the old version.

Delete all tracks except the one you want.

Save the resulting file under a new name.

Load the original file and merge in the desired track.

A good way to create a vocal melody is to record it one phrase at a time. Each phrase should be on a 
different track or set of tracks. This will insure that you don't accidentally record over a good part. Once 
the vocal part is completed, you can merge the different tracks to create a composite vocal track.

Very often even the best singers will sing out of tune in certain parts. For short “sour” parts, you should go 
back and re-record those sections on another track, then carefully replace them by cutting the out-of-tune 
section and inserting the new one. 

For those of us who are out of tune most of the time, a good solution is to double track the lead vocal:

First, record the entire vocal part from beginning to end twice.

Use Digital Orchestrator Plus' Volume Scale control to lower the volume of one of the tracks by 
approximately 50%.

Play back the two tracks together. You should notice that the part sounds much more in tune.

Adjust the relative volumes of the tracks with the Scale function to get the balance you want then merge 
the tracks.

Compress the final vocal part with the Digital Compressor transform. 

Finally, use the Digital Delay transform to add echo or reverb to the track. You will be surprised at how 
much better the track will sound after you have applied these transforms.

Background Vocals



Background vocal parts can be anything from a simple, one track harmony part to a lush multivoice choir. 
Since Digital Orchestrator Plus allows you to layer vocal parts easily by recording on different tracks, it is 
very simple to create your own choir: 

Simply record a harmony part. If this the chorus section of your song, record just one chorus, not every 
chorus in the entire song.

Record the same part on a different track then record it a third time on a third track.

Merge the three tracks by dragging them on top of each other.

Repeat this process for each harmony part.

Lastly, merge the three parts together to create one track with all the background vocal parts on it. If you 
have enough computer power for additional tracks, you may want to merge tracks to create two “sets” of 
harmony parts, then pan them hard right and left to create a true “stereo chorus”. 

Once you have completed the chorus background vocal, you can simply copy and paste it to the different 
chorus locations in the song.

Lead Instruments: Guitar, Sax, etc.

Most pop songs include a bridge or break where a solo instrument plays a melody. Typically, this is a 
screaming guitar or a wailing sax. This part should be recorded in the same way as a vocal part. Try 
developing the part one phrase at a time on different tracks. Make multiple takes. Try different ideas. 
When you've recorded enough material, use the copy and paste commands to assemble the part. 

TIP: Use the Digital Delay transforms to put echo, chorus, reverb and other effects on the lead track. This 
is a good place to experiment with different special effects that can add character to your song.

Mix-down

By now you should have all the production elements at hand. It's time to make a final product: a mix-
down. This is actually quite simple: 

First, you'll need to connect the line output of your sound board to a tape recorder (cassette, DAT, etc.). 

Set the volumes, pan, etc. in Digital Orchestrator Plus to get the desired mix for your song.

Set the tape deck to record/pause mode and play back the song.

Set the record levels on the tape deck. See your tape deck documentation if you need more information 
on how to do this. Once you have achieved a good level, you're ready to record.

Finally, record the song: release the pause on the tape deck and play the song from the beginning.



Creating A Digital Delay Effect
To create a digital delay effect:
Select the range in the file that you want to be affected by the change.

Choose a delay effect from one of the Presets.

Press the Audition button. If the effect is not satisfactory, adjust the settings or try a different preset.

When you are satisfied with the effect, click OK to save it.

To add and save an effect as a digital delay preset:
Once all the parameters you want to save have been set, click the green check mark to the right of the 
Preset selection box. The Save Setting dialog box will appear.

Type a name for your settings in this dialog box.

Click OK. Your settings will be saved and the new name will be added to the list of presets in the Digital 
Delay dialog box.

To remove a digital delay preset:
Select a preset from the list in the Presets selection box. Click the arrow to the right of this box to drop 
down the list of preset effects, then click on the preset you want to delete.

Click the red “X” mark to the right of the preset. The preset is deleted.



To Convert A Sample Rate
Converting the sample rate of a digital audio file is a global operation. All of the digital audio tracks in your 
file will be affected.

Choose Convert Sample Rate from the Transforms menu. The Convert Sample Rate dialog box appears. 
The current sample rate of the file appears in a drop down list box.

Choose another sample rate setting from this box, then click OK. Digital Orchestrator Plus will convert the 
file to the new sample rate.



Merging Digital Audio Tracks
To merge digital audio tracks:

Decide which two tracks you wish to merge.

Highlight one of the tracks and drag it onto the other.

If you don't like the current mix, undo the merge and try again. 

Note:
The amplitude of the merged tracks will increase, which may cause clipping. If this occurs, undo the 
merge, scale the volume of the two tracks down by 50% and merge again.



Tempo Transforms

Fit Time
This transform scales tempos such that the selected passage will take “x” amount of time. For example, if 
you have a 50-second piece of music which you need to fit into a 60-second segment, this transform will 
adjust the tempo—in this case slow it down—so that the piece now lasts 60-seconds.

Tap Tempo
Occasionally, it is desirable to record a piece of music without following a metronome. An example of this 
would be a solo piano sonata. Removing the constraints of a metronome’s steady tempo allows the 
performer to be more musically expressive.

If a song is recorded in free-time (without a metronome), the bars of music performed will not be aligned 
with the bars and beats in Digital Orchestrator Plus. The performance may also contain variations in the 
tempo. The Tap Tempo transform aligns the bars of music recorded in free-time to the bars in Digital 
Orchestrator Plus by adding tempo change controller messages to the song.

To accomplish this transform, you must first record a tempo reference track. This is a separate MIDI track 
of quarter notes that the Tap Tempo transform will use as a reference to line up the bars. 

To create this tempo reference track, enable a new MIDI track to record. Then play quarter notes on any 
note of your keyboard (or MIDI controller) as you listen to the free form performance. Note that the first 
note of the Reference Track MUST be exactly on the first beat boundary (clicks=0) in the selected region. 
You should record this reference track for the entire length of the song.

Once you have your reference track, run the Tap Tempo transform selecting the track of quarter notes as 
the reference track. This will adjust the tempos so that it appears that you recorded to a strict tempo, 
while still retaining the original performance tempo changes. 

Accelerando
This transform allows you to change tempos in either direction (faster or slower) over a given period of 
time within the selected range. Parameters are starting and ending tempos, curvature, and minimum 
clicks between. Curvature may range from -10 to +10. 

Curvature describes the type of change. A value of zero is linear change, which means you get a steady 
rate of change. Positive ten yields more change more quickly, the later in the range you are. A negative 
value yields more change in the beginning and less change later in the range. 



 Spin Buttons 
When changing the values of numbers which have spin buttons, you can use the spin buttons alone or in 
conjunction with the Shift and Ctrl keys.

· Using the mouse, click on the up or down spin button to change the value in either of these boxes. 

· Pressing the Shift key while clicking the up spin button will increase the value by a larger amount. 
Pressing the Shift key while clicking the down spin button will decrease the value by a larger 
amount.

· Pressing the Shift key while pressing the multiply (*) key on the numeric keypad will increase the 
value by a larger amount. Pressing the Shift key while pressing the divide (/) key on the numeric 
keypad will decrease the value by a larger amount.

· Pressing the Ctrl key while clicking the up spin button will set the value to the maximum. Pressing 
the Ctrl key while clicking the down spin button will set the value to the minimum.

· Pressing the Ctrl key while pressing the Plus (+) key on the numeric keypad will set the value to the 
maximum. Pressing the Ctrl key while pressing the minus (-) key on the numeric keypad will set the 
value to the minimum. 



Sync Settings
When using sync, one device must be designated as the “master” while all other devices are designated 
as “slaves.” 

The Sync Settings… command opens the dialog box in which the sync settings are made.

There are several different sync formats. These are represented by the following acronyms:

· MTC   (MIDI Time Code)  —is a series of MIDI messages which informs the slave(s) of what time it is. 
These messages are sent 24 times per quarter note.

· SPP   (Song Position Pointer)  —is a MIDI message which tells the slave(s) where in the song the 
master is, so that the master and slave continue to be aligned at the same place in the song. SPP 
uses MIDI clocks to keep time. These messages, too, are sent 24 times per quarter note.

· SMPTE (which stands for Society of Motion Picture and Television Engineers)—represents an 
audio signal containing a time code in the format Hours: Minutes: Seconds: Frames: Subframes (in 
hundredths or bits).

NOTE:
Digital Orchestrator Plus does NOT read the SMPTE audio signal directly. Rather, it reads MTC (MIDI 
Time Code), a data stream that must be translated from SMPTE tone by a special piece of hardware such 
as Voyetra’s V-24s multi-port MIDI/SMPTE interface. 

Clock Source
There are three radio buttons in this section of the dialog box:

· Internal—specifies that the computer will use its own internal clock for playback.

· MIDI/SPP— uses MIDI clocks to determine the current time. Drum machines, workstations, and 
hardware sequencers most commonly send and sync to Song Position Pointer (SPP). 

· MIDI Time Code—specifies that the computer will sync to MIDI Time Code either directly over a 
MIDI port or MIDI Time Code translated by an external SMPTE-to-MIDI converter.

NOTE:
Clock messages are not sent THRU by Digital Orchestrator Plus or many hardware sequencers. 
Consequently, chaining several devices together may not work.

The last option in this section of the dialog sets Input Port. This designates the port on which Song 
Position Pointer or MIDI Time Code will be received. If you are using a software-based Time Code 
converter, it also will be necessary to set the correct input port in the MIDI Port Setup dialog box, also 
accessible from the Options Menu.

NOTE:
If you are using Voyetra’s V-24s, then one of Digital Orchestrator Plus' MIDI input ports must be set to the 
V-24s driver’s SMPTE input. On the V-24s connector box, the SMPTE In RCA jack is the SMPTE Input 
port. 

Sync Output
This section, too, has three radio buttons from which to choose.

None—designates that no sync will be sent out during playback.

MIDI/SPP—designates that Song Position pointer and MIDI clocks will be sent out to whatever Output 
port has been selected.



MIDI Time Code—designates that MTC will be sent out to whichever Output port has been selected.

If Sync Output has been enabled, Output Port lets you specify to which port the sync information should 
be sent.

SMPTE Frame Rate
SMPTE Frame Rate sets how many frames per second Digital Orchestrator Plus should expect to sync 
to. There are five settings here, and these represent the following information:

24 fps—is used in film only.

25 fps—is used in European TV and video.

29.97 fps—is easier to work with than 30 Drop; however, it will drift from the wall clock by a small amount. 
It is generally used for color video work (other than network features) in the United States.

30 Drop —is used in network television and color video work when SMPTE time must match the wall 
clock.

30 Non Drop—is used for black-and-white television and general music.

Digital Orchestrator Plus will automatically detect whatever frame rate comes in, but it is a good idea to 
set this option correctly anyway. 

There is one difference here worth noting—29.97 coming in will look like 30 Non Drop, so Digital 
Orchestrator Plus will assume that if the user has set 29.97 and sees 30 Non Drop coming in, that 29.97 
is really what is being worked with.

NOTE:
Unlike Voyetra’s Sequencer Plus Gold, you cannot generate SMPTE directly from Digital Orchestrator 
Plus. If you have a SMPTE generator in your computer, you must access its driver through the Control 
Panel, select the frame rate, and generate SMPTE from there.

SMPTE Sub Frame Display
This option enables you to choose whether or not time display will show units smaller than a frame in the 
Current Time and Big Time windows. 

Off—turns this option off.

Hundredths—designates hundredths of a frame.

Bits—is equal to 80ths of a frame.

If your high-end video-editing software uses bits, this is the setting you most likely will use. On the other 
hand, if your multitrack tape deck synchronizer wants to use hundredths of frames, then this setting is the 
one to choose. When in question, refer to the documentation manuals for these devices.

Time Display
These choices are relatively self-explanatory.

SMPTE Display Off—turns off SMPTE display.

Absolute Time—is displayed in Hours: Minutes: Seconds Plus SMPTE offset.

Relative Time—is displayed in Hours: Minutes: Seconds since the beginning of the song.

Show Hours—changes the format in the Current Time and Big Time windows. When this option is 
selected hours will be displayed and when deselected they will not.

SMPTE Options



Tape Offset—sets how long after your first SMPTE time you want your song to begin. SMPTE/MTC offset 
time is displayed in Hours: Minute: Seconds: Frames: Sub Frames. (For additional information on Sub 
Frames, see “SMPTE Sub Frame Display” above.)

Auto Stop Delay (ms)—sets how many milliseconds before sequence will stop if Time Code is 
interrupted.

Big Time Window
The Big Time Window is a dedicated display window of variable size which shows either current SMPTE 
time or current song time, depending upon time display setting. 

The Big Time window can be accessed from Digital Orchestrator Plus' Window menu.

NOTE:
For additional information on Synchronization—with step-by-step, real-life examples of how to implement 
this feature—refer to “Synchronization Procedures.”



Sync Procedures
To Enable SMPTE 
Synchronizing With an External Tape Deck 
Synchronizing With Another MTC Device 
Synchronizing Using Song Position Pointer 



To Enable SMPTE
1. On the Options menu, choose MIDI Port Setup.

2. Set one of your MIDI Input ports for Sync In. 

If you have Voyetra’s V-24s interface, “Voyetra V-24s SMPTE” will be one of the options. 

If you do not have this interface, choose whichever port your SMPTE to MTC converter sends MTC 
on.

3. Go to the Options menu and choose Sync Settings.

Under Clock Source in the Sync dialog box, set your Input port to match the port number you chose in the 
MIDI Port Setup window. Then choose MIDI Time Code (or SPP if applicable) as your source. This will 
allow Digital Orchestrator Plus to receive and sync to an external source.



Synchronizing With an External Tape Deck
A common application of the Digital Orchestrator Plus sync feature is to synchronize or “lock up” Digital 
Orchestrator Plus with a tape deck. This could either be a video deck, where Digital Orchestrator Plus can 
be used to add voice, sound effects and background music to the video, or a multitrack tape recorder. 

In this scenario, Digital Orchestrator Plus is the slave and the tape deck is the master. One track of the 
tape deck will be “striped” with SMPTE time code. A SMPTE to MIDI converter such as Voyetra’s V-24s 
interface will read the SMPTE time code and transmit MTC to Digital Orchestrator Plus. Once the devices 
are synchronized, playback of Digital Orchestrator Plus will be controlled by the tape deck’s transport.

To Synchronize Digital Orchestrator Plus with a Tape Deck:

1. Record SMPTE time code to one track of the tape deck. Your SMPTE read/write hardware will have 
instructions on this procedure.

2. Once you have successfully striped your tape with SMPTE, make certain that Digital Orchestrator 
Plus’ SMPTE functions are enabled. (See “To Enable SMPTE.”)

3. Make sure your multitrack tape deck’s audio output is connected to the SMPTE in of your SMPTE-
to-MIDI converter.

4. When you start the tape, you should see Digital Orchestrator Plus’ Current Time counter start to 
move. When it reaches the offset time you set, Digital Orchestrator Plus should start to play. Digital 
Orchestrator Plus' transport will not be operational. 

SMPTE/MTC Offset
This function serves two purposes, depending on whether you are reading or writing SMPTE. 

When reading (syncing to) SMPTE/MTC, the offset determines what SMPTE time will trigger the 
sequence. Therefore, if you set the offset time in the Sync Settings dialog box to 15 seconds 
(00:00:15:00:00), the song will begin when it receives that SMPTE time. 

When writing (generating SMPTE/MTC, the offset determines the first SMPTE time that is generated. So 
if you stripe the tape with an offset of 10 seconds (00:00:10:00:00), the stripe will start with that SMPTE 
time.

You will always want to set the song to start later than the first SMPTE time on your tape. This gives the 
sequencer time to process the synchronization data. Thus, if stripe the tape at 10 seconds 
(00:00:10:00:00) and set the start time (tape offset in the sync window) to 15 seconds (00:00:15:00:00), 
then your sequencer will start five seconds after the beginning of the time code on your tape.

 NOTE:
To sync to a tape deck, it is necessary to have a SMPTE generator/converter (such as Voyetra’s V-24s 
and a multitrack tape deck on which you can record one track at a time without erasing the track 
previously recorded. 



Synchronizing with Another MTC Device
There are occasions when you may need Digital Orchestrator Plus to be a slave to an external MTC 
device such as an external hard disk recorder or another computer running a sequencer or hard disk 
recorder.

MTC Sync with Digital Orchestrator Plus as the Slave:

1. In the Sync Settings dialog box (from the Options menu), set Clock Source to MTC.

2. Set the master (drum machine, keyboard sequencer) to send MTC. (You will need to refer to the 
device’s documentation manual for information on how to do this.)

3. Connect the masters MIDI out to your PC MIDI interface’s MIDI in.

4. Press play on the external device and Digital Orchestrator Plus should begin playing in sync.



Synchronizing Using Song Position Pointer 

Another common sync application is to synchronize an external hardware sequencer such as a drum 
machine with Digital Orchestrator Plus. This is done using a different type of sync called Song Position 
Pointer (SPP). In this case Digital Orchestrator Plus is the master and the external sequencer is the slave.

SPP Sync with Digital Orchestrator Plus as the Master:

1. In the Sync Settings dialog box (from the Options menu), set Sync Output to MIDI/SPP.

2. Set the slave (drum machine, keyboard sequencer) to sync to SPP. (You will need to refer to the 
device’s documentation manual for information on how to do this.)

3. Connect the slaves MIDI in to your PC MIDI interface’s MIDI out.

4. Press play on Digital Orchestrator Plus' transport. Digital Orchestrator Plus will send a start 
message to the external device and all should be in sync.

SPP Sync with Digital Orchestrator Plus as the Slave:

1. In the Sync Settings dialog box (from the Options menu), set Clock Source to MIDI/SPP.

2. Set the master (drum machine, keyboard sequencer) to send SPP. (You will need to refer to the 
device’s documentation manual for information on how to do this.)

3. Connect the masters MIDI out to your PC MIDI interface’s MIDI in.

4. Press play on the external device and Digital Orchestrator Plus should begin playing in sync.



MIDI Time Code (MTC) 
MTC is a series of MIDI messages which informs the slave(s) of the current time. These messages are 
sent 24 times per quarter note.



Song Position Pointer (SPP)
SPP is a MIDI message which tells the slave(s) where in the song the master is located, so the master 
and slave(s) remain aligned at the same location. SPP uses MIDI clocks to keep time. These messages 
are sent 24 times per quarter note. 



SMPTE
SMPTE is an acronym for the Society of Motion Picture and Television Engineers, the organization 

that established this format for synchronization. 

SMPTE refers to an audio signal containing a time code in the format: Hours: Minutes: Seconds: 
Frames: Subframes (in hundredths or bits). 

There are several different SMPTE frame rate options:

24 fps—is used in film only.

25 fps—is used in European TV and video.

29.97 fps—is easier to work with than 30 Drop; however, it will drift from the wall clock by a small 
amount. It is generally used for color video work (other than network features) in the United 
States.

30 Drop—is used in network television and color video work when SMPTE time must match the 
wall clock.

30 Non Drop—is used for black-and-white television and general music.

NOTE:
Digital Orchestrator Plus does not read SMPTE audio signal directly. Rather it reads MTC (MIDI Time 
Code), a data stream that must be translated from SMPTE tone by a special piece of hardware such as 
Voyetra’s V-multi-port MIDI/SMPTE interface. In addition, Digital Orchestrator Plus does not output 
SMPTE, but it does output MTC.



General MIDI Patch Set

The General MIDI Patch Set was designed to ensure compatibility between files by defining a common 
set of instrument names and MIDI numbers. This means, for example, that if you set a track to Patch #4, 
“Honky-tonk Piano,” it should sound pretty much the same when played on any other General MIDI 
synthesizer or sound card. 

These instrument sounds correspond to the numbers in the Patch column of Digital Orchestrator Plus' 
Track/View screen.

PIANO
1 Acoustic Grand Piano 
2 Bright Acoustic Piano 
3 Electric Grand Piano 
4 Honky-tonk Piano 
5 Rhodes Piano 
6 Chorused Piano 
7 Harpsichord 
8 Clavinet Chromatic

ENSEMBLE 
49 String Ensemble 1 
50 String Ensemble 2 
51 SynthStrings 1 
52 SynthStrings 2 
53 Choir Aahs 
54 Voice Oohs 
55 Synth voice 
56    Orchestra Hit

SYNTH EFFECTS 
97 FX 1 (rain) 
98 FX 2 (soundtrack) 
99 FX 3 (crystal) 
100 FX 4 (atmosphere) 
101 FX 5 (brightness) 
102 FX 6 (goblins) 
103 FX 7 (echoes) 
104 FX 8 (sci-fi)

PERCUSSION 
9 Celesta 
10 Glockenspiel 
11 Music box 
12 Vibraphone 
13 Marimba 
14 Xylophone 
15 Tubular Bells 
16 Dulcimer

BRASS 
57 Trumpet 
58 Trombone 
59 Tuba 
60 Muted Trumpet 
61 French Horn 
62 Brass Section 
63 Synth Brass 1 
64    Synth Brass 2

ETHNIC 
105 Sitar 
106 Banjo 
107 Shamisen 
108 Koto 
109 Kalimba 
110 Bagpipe 
111 Fiddle 
112 Shanai

ORGAN 
17 Hammond Organ 
18 Percussive Organ 
19 Rock Organ 
20 Church Organ 
21 Reed Organ 
22 Accordion 
23 Harmonica 
24 Tango Accordion

REED 
65 Soprano Sax 
66 Alto Sax 
67 Tenor Sax 
68 Baritone Sax 
69 Oboe 
70 English Horn 
71 Bassoon 
72    Clarinet

PERCUSSIVE 
113 Tinkle Bell 
114 Agogo 
115 Steel Drums 
116 Woodblock 
117 Taiko Drum 
118 Melodic Tom 
119 Synth Drum 
120 Reverse Cymbal

GUITAR 
25 Acoustic Guitar (nylon) 
26 Acoustic Guitar (steel) 
27 Electric Guitar (jazz) 
28 Electric Guitar (clean) 
29 Electric Guitar (muted) 
30 Overdriven Guitar 
31 Distortion Guitar 
32 Guitar Harmonics

PIPE 
73 Piccolo 
74 Flute 
75 Recorder 
76 Pan Flute 
77 Bottle Blow 
78 Shakuhachi 
79 Whistle 
80    Ocarina

SOUND EFFECTS 
121 Guitar Fret Noise 
122 Breath Noise 
123 Seashore 
124 Bird Tweet 
125 Telephone 
126 Helicopter 
127 Applause 
128 Gunshot

BASS 
33 Acoustic Bass 
34 Electric Bass (finger) 
35 Electric Bass (pick) 
36 Fretless Bass 
37 Slap Bass 1 
38 Slap Bass 2 
39 Synth Bass 1 
40    Synth Bass 2

SYNTH LEAD 
81 Lead 1 (square) 
82 Lead 2 (sawtooth) 
83 Lead 3 (calliope lead) 
84 Lead 4 (chiff lead) 
85 Lead 5 (charang) 
86 Lead 6 (voice) 
87 Lead 7 (fifths) 
88    Lead 8 (bass + lead)

STRINGS 
41 Violin 
42 Viola 
43 Cello 
44 Contrabass 

SYNTH PAD 
89 Pad 1 (new age) 
90 Pad 2 (warm) 
91 Pad 3 (polysynth) 
92 Pad 4 (choir) 



45 Tremolo Strings 
46 Pizzicato Strings 
47 Orchestral Harp 
48 Timpani

93 Pad 5 (bowed) 
94 Pad 6 (metallic) 
95 Pad 7 (halo) 
96    Pad 8 (sweep)

 
General MIDI Drum Note Map

Like the General MIDI Patch Set, the General MIDI Drum Note Map ensures that the drums you 
designate in your MIDI file will sound the same when played back on other General MIDI sound cards or 
synthesizers.

The drum sounds correspond to the piano keys on the vertical keyboard in the Piano Roll screen. If you 
have a General MIDI (GM) instrument and set the track to Channel 10, these drum sounds will play when 
you insert notes in the Piano Roll screen. 

In the table below, the left-most columns indicate the MIDI numbers, the middle columns represent the 
keys in the Piano Roll window or on your MIDI instrument, and the right columns display the 
corresponding drum sounds.

35 B2 Acoustic Bass Drum 
36 C3 Bass Drum 1 
37 C#3 Side Stick 
38 D3 Acoustic Snare 
39 D#3 Hand Clap 
40 E3 Electric Snare 
41 F3 Low Floor Tom 
42 F#3 Closed Hi-Hat 
43 G3 Hi Floor Tom 
44 G#3 Pedal Hi-Hat 
45 A3 Low Tom 
46 A#3 Open Hi Hat
47 B3 Low-Mid Tom 
48 C4 High-Mid Tom 
49 C#4 Crash Cymbal 1 
50 D4 High Tom 
51 D#4 Ride Cymbal 1 
52 E4 Chinese Cymbal 
53 F4 Ride Bell 
54 F#4 Tambourine 
55 G4 Splash Cymbal 
56 G#4 Cowbell 
57 A4 Crash Cymbal 2 
58 A#4 Vibraslap
59 B4 Ride Cymbal 2 
60 C5 High Bongo 
61 C#5 Low Bongo 
62 D5 Mute High Conga 
63 D#5 Open High Conga 
64 E5 Low Conga 
65 F5 High Timbale
66 F#5 Low Timbale 
67 G5 High Agogo 
68 G#5 Low Agogo 
69 A5 Cabasa 



70 A#5 Maracas
71 B5 Short Whistle 
72 C6 Long Whistle 
73 C#6 Short Guiro 
74 D6 Long Guiro 
75 D#6 Claves 
76 E6 High Wood Block 
77 F6 Low Wood Block 
78 F#6 Mute Cuica 
79 G6 Open Cuica 
80 G#6 Mute Triangle 
81 A6 Open Triangle

General MIDI Controller Types

General MIDI Controller Types are specified with numbers from 0-127 and control various instrument 
parameters such as pitch bend, effects depth, and volume. 

# NAME POSSIBLE VALUES
1 MOD WHEEL 0 - 127
2 BREATH 0 - 127
4 FOOT PEDAL 0 - 127
5 PORTAMENTO TIME 0 - 127
6 DATA SLIDER 0 - 127
7 MAIN VOLUME 0 - 127
8 CONTINUOUS RELEASE 0 - 127

10 PAN 0 - 127
11 EXPRESSION CONTROL 0 - 127
64 SUSTAIN 0 = off/127 = on
65 PORTAMENTO SWITCH 0 = off /127 = on
66 SUSTENUTO SWITCH 0 = off /127 = on
67 SOFT SWITCH 0 = off /127 = on
68 2ND RELEASE SWITCH 0 = off /127 = on
84 PORTAMENTO 0 - 127
91 EFFECTS 1 DEPTH 0 - 127 (Normally Reverb)
92 EFFECTS 2 DEPTH 0 - 127
93 EFFECTS 3 DEPTH 0 - 127 (Normally Chorus)
94 EFFECTS 4 DEPTH 0 - 127
95 EFFECTS 3 DEPTH 0 - 127
96 DATA PLUS 0 = off/127 = on
97 DATA MINUS 0 = off/127 = on

121 RESET ALL CONTROLLERS normally 0
123 ALL NOTES OFF normally 0
124 OMNI MODE OFF normally 0
125 OMNI MODE ON normally 0
126 MONO MODE ON 0/all voices to mono
127 POLY MODE ON normally 0



Fill MIDI
Fill: This transform will fill in, or add, controller, channel aftertouch, key aftertouch, and pitch bend MIDI 
events. (Your hardware may or may not support these controller events. Refer to your hardware manual 
for further information.) 

Input parameters are starting and ending values, curvature, and minimum clicks between. Curvature may 
range from -10 to +10. 

Curvature describes the type of change. A value of zero is linear change, which means you get a steady 
rate of change. Positive ten yields more change more quickly, the later in the range you are. This value is 
the most commonly used for all events except pitch. A negative value yields more change in the 
beginning and less change the later in the range you are. This value is particularly effective on pitch 
change data.



Fit Time
This transform scales tempos such that the selected passage will take “x” amount of time. For example, if 
you have a 50-second piece of music which you need to fit into a 60-second segment, this transform will 
adjust the tempo—in this case slow it down—so that the piece now lasts 60-seconds



Accelerando
This transform allows you to change tempos in either direction (faster or slower) over a given period of 
time within the selected range. Parameters are starting and ending tempos, curvature, and minimum 
clicks between. Curvature may range from -10 to +10. 

Curvature describes the type of change. A value of zero is linear change, which means you get a steady 
rate of change. Positive ten yields more change more quickly, the later in the range you are. A negative 
value yields more change in the beginning and less change later in the range. 



Tap Tempo
Occasionally, it is desirable to record a piece of music without following a metronome. An example of this 
would be a solo piano sonata. Removing the constraints of a metronome’s steady tempo allows the 
performer to be more musically expressive.

If a song is recorded in free-time (without a metronome), the bars of music performed will not be aligned 
with the bars and beats in Digital Orchestrator Plus. The performance may also contain variations in the 
tempo. The Tap Tempo transform aligns the bars music recorded in free-time to the bars in Digital 
Orchestrator Plus by adding tempo change controller messages to the song.

In to accomplish this transform, you must first record a tempo reference track. This is a separate MIDI 
track of quarter notes that the Tap Tempo transform will use as a reference to line up the bars. 

To create this tempo reference track, enable a new MIDI track to record. Then play quarter notes on any 
note of your keyboard (or MIDI controller) as you listen to the free form performance. Note that the first 
note of the Reference Track MUST be exactly on the first beat boundary (clicks=0) in the selected region. 
You should record this reference track for the entire length of the song.

Once you have your reference track, run the Tap Tempo transform selecting the track of quarter notes as 
the reference track. This will adjust the tempos so that it appears that you recorded to a strict tempo, 
while still retaining the original performance tempo changes. 



Scale Time
The Scale Time box has a slider with values in percentages and a box to select whether you also want to 
scale durations.

For example, if you have four quarter notes in a measure and you scale start time down 50% without 
scaling the durations of the notes, your four quarter notes will remain as quarter notes; however, they will 
take up 50% less space. The result will be four overlapping quarter notes on the first four eighth notes of 
the measure. If you had also scaled duration down 50%, the result would have been four eighth notes.

If you were to scale the four quarter notes up 200% without scaling the durations of the notes, you will 
have two measures with quarter notes on every other beat. If you scale the duration, you will have two 
measures of half notes.



SysEx Bank Name
The name of the current SysEx bank.



Wave Sync
One of the most powerful features of Digital Orchestrator Plus is its capability to synchronize MIDI with 
digital audio. For MIDI and digital audio to synchronize accurately, Digital Orchestrator Plus contains a 
feature called Wave Sync. This allows the MIDI and digital audio to “lock up” with each other so that they 
are in perfect sync. In order for this to work properly, Digital Orchestrator Plus needs to know the exact 
sample rate of the sound card it is being used with. 

Note: If your are using Digital Orchestrator Plus to slave to SMPTE or MTC, the Wave Sync feature will 
not work.

The default sample rate that Digital Orchestrator Plus recognizes is 22050Hz (22.05kHz). Not every 
sound card manufactured has that exact sample rate. If, for instance, the sample rate on your card is 
22060Hz (22.06kHz), over time the MIDI and digital audio would become out of sync. This is due to the 
fact that Digital Orchestrator Plus is setup for the default sample rate of 22050Hz (22.05kHz), and it 
calculates the synchronization based upon that figure. This can easily be remedied by editing the DOP.INI 
file. But first, you need to find out what the sample rate is. This is easily accomplished using the Wave 
Sync feature in SoundCheck.

To use the Wave Sync feature. 
1. Open SoundCheck.

2. Click on the Summary button.

3. Click on the Wave Sync button.

4. The Wave Sync dialog box will appear.

5. Choose the Wave Out Device. (This is how sound will be played out of your sound card. Usually 
you will see the name of the sound card contained within this box.)

6. Select the Sample Rate you desire to test.

7. Click on the Start button.

When you are done, also check the Wave In Device by selecting “None” for Wave Out and selecting the 
sound card for Wave In.

You will notice numbers calculating.

· The Elapsed Time is a measure of how much time has passed, in milliseconds, since you 
clicked on the Start button. 

· The Actual Sample Rate is the true sample rate of the sound card. 
· The Deviation is the difference between the actual sample rate and the default of 22050 (or 

whatever default sample rate had been selected).

Deviation will continue to process for about ten seconds and then the deviation number will appear. This 
time is needed to calculate the value of the deviation. Soon, the numbers will start to stabilize. The 
deviation number will tell you if you will be able to use Wave Sync in Digital Orchestrator Plus. 

If the Deviation number is:
Between 0 and 10 — Excellent for using Wave Sync

Between 11 and 50 — Good 
Between 50 and 500 — Fair (it may be a bit unstable)

Over 500 — Do not use the Wave Sync option

To get the most accurate reading, allow the Wave Sync to run for several minutes. 

Please be aware that many sound cards have a very low Wave Out deviation and a high Wave In 
deviation. In cases such as these, you should experiment to determine if using the Wave Sync function in 



Digital Orchestrator Plus is appropriate or not.

If, for instance, the actual sample rate is 22060, you would want to place the 22060 in the DOP.INI file. 

To do this open the DOP.INI file and look for [DigitalAudio]. Under that heading you would add 
“22050=22060.” Once it is added it would appear as:

[DigitalAudio]
22050=22060

You should also check for the sample rates of 11025 (11.025kHz) and 44100(44.1kHz) to make sure that 
they are accurate as well.



File Formats

ORC
This is the only format which saves both MIDI and Digital Audio data in the same file.

If you plan to use your file only with your own system or applications that support .ORC files—such as 
Voyetra’s MIDI Orchestrator—save your song in Voyetra’s proprietary .ORC format. This format preserves 
all of the file’s settings independently, just as you see them on the screen.

MID 
MIDI format does not save Digital Audio data. For compatibility with most other PC MIDI applications, use 
the standard .MID format. When you save a file in this format, settings for Tempo, Tempo Offset and 
Transpose are combined and the resulting new values are saved. Muted and un-soloed tracks are 
deleted.

RMI 
Files in this format include a header with identifying information which certain MIDI devices may require. 
In other respects, .RMI files are identical to standard MIDI files.

SNG 
This is the song file format used by the Sequencer Plus series. Digital Orchestrator Plus can read 
the .SNG file formats, but it cannot save in that format.

JAM
This song file format is produced by Voyetra’s Jammin’ Keys application. This file format can contain both 
MIDI and digital audio. Digital Orchestrator Plus can read this format, but it cannot save in this format. 

STR
This file format is produced by Reveal’s Music Star system. Digital Orchestrator Plus can read this file 
format, but it cannot save in this format. 

JDT 
This song file format was once produced by Voyetra’s Jammin’ Keys application. While Jammin’ Keys no 
longer saves in this format, it may be useful for customers who own an older version of Discovering 
Music. This file format can contain both MIDI and digital audio. Digital Orchestrator Plus can read this file 
format, but it cannot save in this format. 



Diatonically Invert Pitch
Diatonically Invert works the same way as the Invert Pitch dialog, but maintains the key during the 
change.



Offset Start Time
Shifts the start times of all notes backward or forward in time. This transform lets you selectively change 
non-note MIDI data as well.

When the Offset Start time dialog box appears, click on the buttons to choose which types of events you 
want to change: Pitch Bend, Channel Aftertouch, Key Aftertouch, Patch Changes, Notes and any data set 
by the Controllers. You can choose a single controller or all controller messages at once from the drop-
down list. Choose Earlier or Later, and select an interval in bars:beats:clicks.

By default, all of the event types are selected when you first run Digital Orchestrator Plus. Once you 
deselect an event type, your changes will be retained until you change them again.



Port Select
Clicking on this button allows you to change the port which you are currently viewing.



Big Time Window
The Big Time Window can only be opened from the Window menu—there is no Quick View button for this 
feature. The Big Time window is a dedicated display which shows either the current SMPTE time or the 
current song time, depending upon the time display setting designated in the Sync Settings dialog box on 
the Options menu. The Big Time Window is resizable. 

To open the Big Time Window

· Click on the Window menu

· Click on View, then Big Time Window



Mixdown Audio

The Mixdown Audio feature blends all unmuted digital audio tracks into a two-track stereo or single mono 
track mix. This frees processing resources and allows you to record more digital audio tracks. 

When you select Mixdown Audio, a dialog box offers these options:

Stereo/Mono Allows you to choose stereo output (produces two 
new tracks, one panned hard right, the other hard left) 
or mono output (produces one new track).

Normalize Output Scales the tracks before combining them to eliminate 
distortion. It is usually a good idea to use this feature, 
though it increases the time required to perform a 
mixdown.

Preview Allows you to hear a short preview of your mixdown 
before processing the entire song.

Preview Length Sets the length of the preview.

To use the Mixdown Audio feature
1 Set the volume and panning for each of the digital audio tracks. The settings you select are reflected 

in the mixdown.
2 From the Transforms menu, click Mixdown Audio. A dialog box appears.
3 Select either Stereo or Mono from the dialog box. Stereo produces two tracks; Mono produces a 

single track.
4 Select Normalize Output if you want to have the tracks’ volume scaled to the highest possible level 

without clipping (distortion). When tracks are mixed down, the combination of the merged tracks may 
cause distortion. When Normalize Output is selected the tracks are scaled before they are combined. 
This helps to reduce any distortion. Note that when Normalize Output is selected processing time is 
increased.

5 Click Preview if you wish to hear a preview of your mixdown. You can change the length of the 
preview with the spin buttons. 

6 Click OK when you are satisfied with the mixdown.

To further illustrate Mixdown Audio
The panning and volume settings of the digital audio tracks are reflected in the mixdown.
For example:

· If you make a stereo mixdown from six digital audio tracks: 
Three vocal tracks panned hard to the left. 
Three piano tracks panned to the right.

· The result will be two stereo tracks:
The left track contains the combined vocal tracks. 
The right track contains the combined piano tracks.

· If the panning is not set all the way to the left or right, that, too, will be reflected in the final 
mixdown. 

· The relative volumes are also combined in the mixdown.
Notes

· Mixdown Audio lets you combine several digital audio tracks into one or two tracks, to help free 
up processor power to record more tracks. 

· Mixdown Audio only works with digital audio tracks. 
· Muted digital audio tracks are not included in the mixdown.



· When the mixdown is performed, the original tracks are automatically muted. You may want to 
keep the original tracks for future mixdowns. (Digital Orchestrator Plus’ performance is not 
affected by muted tracks.)

· Before making a final mixdown, you’ll probably want to use the Preview button to get an overall 
idea of what the mixdown will sound like. If any changes are then needed, you can make them 
before you start the mixdown.

 




